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I. Introduction
I.1. Installing the Software

To install the software 'The Next Tool' for Windows® 95, open the file 'SETUP.EXE' in the directory in 
which the various files of the program are. SETUP will guide you through the installation process by 
means of a wizard. Depending on the way in which you received the software (on floppy disk, in a 
directory on a CD-ROM or in a self-extracting archive) there are the following possibilities to execute 
'SETUP.EXE':

- Installing by using the start menu... Insert the floppy disk or the CD-ROM on which the T.N.T. files are
in the corresponding drive and choose 'Run' from the Windows® start menu. Afterwards you can enter the
path of the file 'SETUP.EXE' in the 'Open' edit control of the 'Run' dialog box. For instance, if the file were 
on a floppy disk in drive a, you would enter:

A:\SETUP.EXE

Then press the 'OK' button in the 'Run' dialog box. (Note: If the file is in a directory on a CD-ROM, enter 
the corresponding path.)

- Installing out of a self-extracting archive... If you received T.N.T. in the form of the self-extracting 
archive 'TNTWIN95.EXE' (for instance, by downloading the file with your modem), proceed as described 
above to open the self-extracting archive by means of the 'Run' option of the Windows® start menu. For 
instance, if the archive is in the 'DOWNLOAD' directory on drive 'C:' is, enter

C:\DOWNLOAD\TNTWIN95.EXE

and press the 'OK' button in the 'Run' dialog box. Then a dialog box named 'The Next Tool - Self-
Extracting Archive' appears in which you can enter the target directory for the extraction of the files. As 
soon as all files are extracted you can run 'SETUP.EXE' directly.



I. Introduction
I.2. Starting T.N.T. and Passing Parameters

If you installed the software 'The Next Tool' by means of the installation wizard 'SETUP.EXE', icons to run 
the software were created at several locations (on the desktop or in the start menu) according to the 
options you chose during the setup process.
Note: If you chose 'Standard Install', a menu option to run 'The Next Tool' was created directly in the start 
menu as well as a new submenu called 'The Next Tool' in the 'Programs' submenu of the start menu. The 
submenu also contains options to open the online manual, the setup and the remove wizard and to print 
the manual. If you chose 'User-Defined Install', you had the chance to choose on your own, whether or 
not to create an icon for T.N.T. on the desktop and/or the menu options in the start menu.

If you did not use 'SETUP.EXE' to install 'The Next Tool', you can also run the software directly from any 
directory. To do so, choose 'Run' from the Windows® start menu and enter the path of the file 
'TNTWIN.EXE' in the 'Open' edit control in the 'Run' dialog box. For instance, if 'TNTWIN.EXE' is in the 
directory 'TOOLS\TNTWIN' on drive 'D:' enter

D:\TOOLS\TNTWIN\TNTWIN.EXE

and press the 'OK' button in the 'Run' dialog box. (Note: To be able to use all features of T.N.T., you have 
to install the software by means of 'SETUP.EXE'. During the installation process, the file types that are 
supported by T.N.T. are registered and other necessary information is also entered in the Windows® 
registry.)

If you run 'The Next Tool' by using the 'Run' option of the start menu or the MS-DOS® prompt or create 
new shortcuts to open the program, you can pass the following parameters that are evaluated when the 
program starts:

Note: In the following passages, it is assumed that the files of T.N.T. are in the directory 'C:\Program Files\
TNTWin'. To try out the examples described below, choose 'Run' from the start menu and enter the path 
of the program file followed by the desired parameter(s) in the 'Open' edit control of the 'Run' dialog box:

C:\Program Files\TNTWin\TNTWIN.EXE [Parameter1] [Parameter2]

1.) Starting 'The Next Tool' With the Default Configuration

If you add the parameter '/NOINI' when starting T.N.T., no configuration file will be loaded and the internal 
configuration will be used.

C:\Program Files\TNTWin\TNTWIN.EXE /NOINI

2.) Running 'The Next Tool' With a Certain Configuration File

If you add the parameter '/INI' together with the path of a file when starting T.N.T., the file will be used as 
the configuration file for 'The Next Tool'. (Note: Normally the configuration files 'TNTWIN.INI' and 
'TNTWIN.ICS' are loaded from the directory in which the T.N.T. program file itself is located.)

C:\Program Files\TNTWin\TNTWIN.EXE /INI D:\Backup\Old.ini

The files 'Old.ini' and 'Old.ics' in the directory 'D:\Backup' are used to load the configuration. (Note: You 
always have to enter only the path of the INI file. The icon file automatically has the same name with the 
extension '.ics'.)



3.) Displaying a Directory 

If you add the parameter '/SHOW' together with the path of a directory or an archive when starting T.N.T., 
a tree/folder display is opened, showing the contents of the directory or the archive. (Note: If T.N.T. is 
already running, there will not be a new instance of the program. The program that is already running is 
activated and the tree/folder display is opened.)

C:\Program Files\TNTWin\TNTWIN.EXE /SHOW C:\Data\Documents.zip:

A tree/folder display is opened, showing the contents of ZIP archive 'Documents.zip'.

4.) Opening a File Viewer

If you add the parameter '/VIEW' together with the path of a file when starting T.N.T., a file viewer is 
opened, showing the contents of the file. (Note: If T.N.T. is already running, there will not be a new 
instance of the program. The program that is already running is activated and the file viewer is opened.)

C:\Program Files\TNTWin\TNTWIN.EXE /VIEW C:\Data\Info.dat

A file viewer is opened, showing the contents of the file 'Info.dat'.

5.) Opening a Text Editor

If you add the parameter '/EDIT' together with the path of a file when starting T.N.T., a text editor is 
opened with the file. (Note: If T.N.T. is already running, there will not be a new instance of the program. 
The program that is already running is activated and the text editor is opened.)

C:\Program Files\TNTWin\TNTWIN.EXE /EDIT C:\AUTOEXEC.BAT

A text editor is opened with the contents of 'AUTOEXEC.BAT'.
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I.3. Registering the Software and Purchasing a User License

The software 'The Next Tool' for Windows® 95 is shareware. That means you can try out the software for 
45 days free of charge. If you want to use the software after the 45 day evaluation period, you have to 
purchase a registered user license. If you purchase the license, you will get a personal registration code 
to register the software and the right to use the software permanently.
If you use a version of the software that is not registered, a shareware reminder will appear about 10 days
after the software was installed. After 45 days the reminder screen will temporarily block the use of the 
program and you can remove the reminder screen without quitting the program only after an increasing 
period of time. (Note: For detailed information about the license agreement that is the basis for the use of 
the software, refer to the 'Register' page of the 'Info about T.N.T.' property sheet or to the file 
'LICENSE.TXT'.)

You can obtain a registered user license for 'The Next Tool' and your personal registration code for 49 
US$. For further information about how to order refer to our order wizard 'ORDER.EXE'. To run the order 
wizard, simply press the 'Order' button in the 'Info about T.N.T.' dialog box. To open the 'Info about T.N.T.' 
dialog box, press the button or the icon of 'The Next Tool' in the taskbar with the right mouse button and 
choose 'Info about T.N.T.' from the main menu.

If you have access to CompuServe®, you can also register by GO 'SWREG' with RegNo. 8298. In case of
further questions or comments, please contact:

In case of further questions or comments contact:

Mail:

Joerg Schliesser
Software Development
Rotenwaldstr. 41 A
Stuttgart, 70197
Germany

Fax:

+49 - 711 - 65 99 556

E-mail:

support@schliesser.de

FIDO:

Christian Hagenah@2:2487/3002.3

To enter your user name and the registration code, click the button or the icon of 'The Next Tool' in the 
taskbar and choose 'Info about T.N.T.' from the main menu. Activate the 'Register' page of the property 
sheet and enter your user name in the 'Registered for' edit control and the corresponding code in the 
'Code' edit control. Close the property sheet by pressing the 'OK' button. (Note: You have to enter the 
user name and the code in exactly the same way you received them. If the name and the code do not 
match, the code is not recognized to be valid. If the name and the code were entered correctly, 'Thank 
you for registering' will appear in the 'Code' edit control the next time you run 'The Next Tool'.)
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I.4. Uninstalling the Software

If you want to remove 'The Next Tool' for Windows® 95 completely, please do not just delete the files in 
the program's directory. To remove the program completely (that means the references and links in the 
Windows® registry are to be removed too), you have to execute the remove wizard 'REMOVE.EXE' in the
program's directory.

1.) Uninstalling Via the Windows® Control Panel

(Preliminary remark: Uninstalling via the control panel is possible only if 'The Next Tool' was installed by 
using the setup wizard 'SETUP.EXE'.) First choose 'Control Panel' from the 'Settings' submenu of the start
menu. Then use the 'Add/Remove Programs' icon to open the dialog box for adding and removing 
programs and activate the 'Install/Uninstall' page of the property sheet.

In the lower part of the dialog box you will find a list of all programs that are registered for automatic 
uninstalling. Select the entry 'The Next Tool for Windows' by using the left mouse button and press the 
'Add/Remove' button. (Note: If there is no entry for 'The Next Tool for Windows', the program could not be 
registered for automatic uninstalling during the installation process. In this case, proceed as described 
below and execute 'REMOVE.EXE' by choosing 'Run' from the start menu.)

2.) Uninstalling By Running REMOVE.EXE Directly

Choose 'Run' from the Windows® start menu and enter the path of the file 'REMOVE.EXE' in the 'Open' 
edit control of the 'Run' dialog box. For instance, if 'The Next Tool' were installed in the directory 'Program 
Files' on drive 'C:' you would have to enter:

C:\Program Files\TNTWin\REMOVE.EXE

To start the program, press the 'OK' button.
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I.5. Updates and Support

You can get information about new releases of the software 'The Next Tool' online at the following 
locations (information is subject to alteration):

- WWW...

http://www.schliesser.de

- NEXUS BBS...

+49 - 511 - 95 088 97 (28800 Baud and ISDN)
Login: tnt95eng
Password: guest

- FIDO Request...

2:2437/38 (28800 Baud and ISDN)
Magic: TNT95ENG

In case of questions or comments, please contact:

Mail:
Joerg Schliesser
Software Development
Rotenwaldstr. 41 A
Stuttgart, 70197 
Germany

Fax:
+49 - 711 - 65 99 556

E-mail:
support@schliesser.de

FIDO:
Christian Hagenah@2:2487/3002.3
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I.6. Creating and Printing a Manual

When installing 'The Next Tool', a version of the program 'HLP2RTF' that was licensed for the use with 
T.N.T. is also installed. You can use HLP2RTF to create a manual in the form of a text file from the online 
documentation that can be printed afterwards. To create the manual, click the button or the icon of 'The 
Next Tool' in the taskbar with the right mouse button and choose 'Create Manual' from the 'Commands' 
submenu of the main menu.

The manual will be saved with the filename 'TNTWIN.RTF' in the program directory of T.N.T. and can be 
printed by using the Windows® WordPad or any other word processor that is able to load files with the 
RTF format.

Notes:

- Please note that the manual (including all bitmaps) requires about 7 MB hard disk space.

- The table of contents and the index with automatically generated page numbers are only available if you
use a word processor that offers these features.
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I.7. Tips of the Day for a Quick Start

Even if you are already experienced in applying and using software under Windows®, please note the 
following hints in order to use 'The Next Tool' most efficiently:

- Tip of the Day 01: How to control T.N.T. in general
- Tip of the Day 02: The T.N.T. command line
- Tip of the Day 03: Creating and using archives
- Tip of the Day 04: Using T.N.T. like a 'commander' compatible file manager
- Tip of the Day 05: Using long filenames in archives
- Tip of the Day 06: Drag-and-Drop with virtual desktops
- Tip of the Day 07: Using schemes to configure the view of display windows
- Tip of the Day 08: Using the recycle bin
- Tip of the Day 09: Optimizing the size of a window
- Tip of the Day 10: Handling tree structures
- Tip of the Day 11: User-defined menus and commands
- Tip of the Day 12: How to disable loading T.N.T. together with Windows®
- Tip of the Day 13: The menus of the status bars in display windows
- Tip of the Day 14: Drag-and-Drop with the status bars of display windows
- Tip of the Day 15: Using search patterns with wildcards
- Tip of the Day 16: Disabling the tip of the day



The Next Tool... not installed?

Cannot find the installation information...

When starting this program, no information concerning the installation of the application has been found in
the Windows® registry. That means that the software 'The Next Tool' was not installed by using the setup 
wizard 'SETUP.EXE' or that an error occurred during the installation process.

You can also run T.N.T. directly from any directory without installing the program. However, in this case 
some features are not available for the file types that are supported by T.N.T. It is recommended to install 
the software properly.

Disclaimer of Warranty and Liability

There is no warranty for the correctness of the software and its suitability for a certain purpose and the 
authors shall not be liable for any damages, direct or consequential, that arise from the free use of the 
software or the use of the software without installing it.



Tip of the Day 01

How to control T.N.T. in general...

You can control 'The Next Tool' almost completely by using the mouse. To trigger all the various functions 
and command, you essentially only need the following three actions:

- Selecting... Click and drag by using the left mouse button.

- Opening context menus or pop-up menus... Single-click with the right mouse button.

- Drag-and-Drop... Click and drag by using the right mouse button.

Note concerning drag-and-drop: While dragging an item with the right mouse button, you can bring a 
window to the front (back) by clicking it with the left mouse button if it is currently in the back (front).



Tip of the Day 02

The T.N.T. command line...

By using the command line of T.N.T. you can execute any type of application, both DOS and Windows® 
programs, quickly and directly. With comfortable functions to navigate the directory hierarchy and a 
command history, the command line offers a real alternative to the dos prompt if you have to run certain 
commands from time to time. (For a detailed description refer to the online help. Simply press 'F1' in the 
command line.)

You can open the T.N.T. command line from any application by using the global keyboard shortcut 
'Control + Alt + F9'. (Note: If you generally want to use the 'Windows' key instead of 'Control + Alt', 
activate the corresponding check box on the 'Commands' page of the 'Settings' property sheet in 'The 
Next Tool')



Tip of the Day 03

Creating and using archives...

'The Next Tool' offers fully integrated support (that means no external programs are needed) for the 
following types of archives:

ZIP archives - RAR archives - LHA archives - ARJ archives - TAR archives (uncompressed tape archives)
- GNU-ZIP archives (GZ archives and Z archives) - TGZ archives (TAR archives that are compressed in 
the GNU-ZIP format)

To create a new archive or use an already existing one, simply enter the path of the archive file with a 
colon ':' at the end for a copy task (or for any other file command). For instance, to compress (extract) 
some files to (from) an ARJ archive, enter the following target (source) directory for the copy task:

D:\TEST.ARJ:



Tip of the Day 04

Using T.N.T. like a 'commander' compatible file manager...

You can also use 'The Next Tool' like a classical 'commander' compatible file manager with the usual 
keyboard shortcuts and two folder displays that lie side by side.

To do so, click the button or the icon of 'The Next Tool' in the taskbar with the right mouse button and 
choose 'Commander Compatible' from the 'Configuration\Window Mode' submenu of the main menu.



Tip of the Day 05

Using lone filenames in archives...

With T.N.T. you can also use lone filenames within archives. However, please note that other programs 
possibly cannot read archives of that kind (e.g. older 'normal' DOS archive programs).

'The Next Tool' offers fully integrated support (that means no external programs are needed) for the 
following types of archives:

ZIP archives - RAR archives - LHA archives - ARJ archives - TAR archives (uncompressed tape archives)
- GNU-ZIP archives (GZ archives and Z archives) - TGZ archives (TAR archives that are compressed in 
the GNU-ZIP format)



Tip of the Day 06

Drag-and-Drop with virtual desktops...

To move a window from the current desktop to another one, drag the icon (sphere, pyramid, cube or 
cylinder) of the corresponding desktop from the taskbar by using the right mouse button and drop it onto 
the desired window.

To transfer an item of any type (e.g. a file or a directory) via drag-and-drop from the current desktop to 
another one, drag the item above the icon of the desktop in the taskbar and keep the mouse pointer over 
the icon for a moment. Then the corresponding desktop is activated and you can drop the item onto the 
desired target.



Tip of the Day 07

Using schemes to configure the view of display windows...

The way files and directories are shown in the folder pane of a display window can be configured for 
certain applications:

1.) You can choose which pieces of information (symbol, name, extension, size, attributes, dates) are 
shown for each entry (each file and directory) and you can set up the display sequence.

2.) You can determine the criteria according to which the entries are sorted.

3.) Files that match a certain file pattern can be excluded from displaying.

You will find all predefined schemes in the 'View' menu of the window. To create new schemes, choose 
'Display' and 'File Pattern' respectively from the menu.



Tip of the Day 08

Using the recycle bin...

After the installation of 'The Next Tool', the 'Use the recycle bin' feature is activated by default. That 
means you can restore files that were deleted with T.N.T. via the Windows® recycle bin if the recycle bin 
is enabled for the corresponding drive under Windows® itself. However, the recycle bin slows deleting 
down. Therefore, if you want to delete files directly and permanently with T.N.T., uncheck the 'Use the 
recycle bin' check box on the 'Commands' page of the 'Settings' property sheet.

Warning! Undoing deletions with the recycle bin is possible on 'real' drives only. Files that were deleted in 
archives or disk images cannot be restored via the recycle bin.



Tip of the Day 09

Optimizing the size of a window...

If you choose 'Maximize' from the system menu of a T.N.T. window or press the corresponding button in 
the title bar of the window (the second one from the right) or double-click its title bar, the window is not 
resized to full screen size (as it is normally under Windows®). It is only enlarged so far that all data that 
can be displayed in the window is visible.

(Note: To restore the original size of the window, click the maximize button again.)



Tip of the Day 10

Handling tree structures...

In 'The Next Tool', tree structures serve to show the directory hierarchy of a data carrier in a display 
window or the hierarchy of the user-defined menu in the 'Menus' dialog box.
Besides the actions that are available for tree structures in Windows® anyway (e.g. selecting an item with
the left mouse button), you can completely expand a branch of a tree structure in T.N.T. by clicking the 
branch with the left mouse button and dragging the mouse downwards. All subordinated branches are 
then expanded at the same time. To completely fold up a branch, drag the mouse upwards.

Note: A branch of a tree structure is called 'expanded' if its contents, i.e. the entries that are subordinated 
directly to the branch, are visible.



Tip of the Day 11

User-defined menus and commands...

Within 'The Next Tool', you can edit a number of menus and equip them with new or redefined commands
to adjust the program to you personal needs.

Menus that can be edited are, for instance, the context menus that are opened by clicking a file with the 
right mouse button or the main menu that is opened by clicking the button or the icon of 'The Next Tool' in 
the taskbar with the right mouse button. You can edit commands to run external programs as well as 
specially adjusted command templates of the internal file commands.

To edit the menus and the commands, click the button or the icon of 'The Next Tool' in the taskbar with the
right mouse button and choose 'Menus' from the 'Configuration' submenu of the main menu.



Tip of the Day 12

Do not load T.N.T. together with Windows® any more...

If you chose 'Standard Install' when installing 'The Next Tool', the program is always started automatically 
together with Windows®.

If T.N.T. is not to be started automatically because you want to run the program on your own if and when 
the need arises, click the button or the icon of 'The Next Tool' in the taskbar with the right mouse button 
and choose 'Settings' from the 'Configuration' submenu of the main menu. Uncheck the 'Load T.N.T. with 
Windows' check box on the 'General' page of the 'Settings' property sheet.



Tip of the Day 13

The menus of the status bars in display windows...

By clicking a status bar in a display window with the right mouse button, you open a context menu with 
the following options:

- You can use 'Select All', 'Select Nothing', 'Invert Selection' and 'File Pattern' to select certain entries (files
and directories) in the window.

- By means of 'Copy', 'Print' and 'Edit' you can create, print or edit a list of entries (files and directories). 
Click the upper status bar to get a list of all entries or the lower one for a list of the selected entries.

Note: By double-clicking one of the status bars with the left mouse button, you can select all entries in the 
window. By double-clicking a status bar with the right mouse button, you can deselect all entries.



Tip of the Day 14

Drag-and-Drop with the status bars of display windows...

- Drag... If you drag the upper status bar of a display window by using the left mouse button, you get a list
of all entries (files and directories) in the window, which you can drop onto any target in the form of a text 
item. Drag the lower status bar to get a list of the selected entries.

and

- Drop... If you drop a number of filenames onto one of the status bars of a display window, the 'File 
Pattern' dialog box appears for the selection or deselection of entries. The dragged filenames are inserted
automatically and can be used to select or deselect the corresponding entries.



Tip of the Day 15

Using search patterns with wildcards...

When searching for certain strings in the file viewer or when executing a 'File Find and Find in Files' 
command, you can enter search patterns that contain wildcards which replace one or a number of 
characters.

To enter a wildcard that replaces exactly X arbitrary characters ('?X'), keep the 'Control' key pressed and 
press one of the function keys 'F1' up to 'F9'. According to the function key, a wildcard for exactly the 
corresponding number of characters (from 1 to 9) is inserted.

To enter a wildcard that replaces from 0 to X arbitrary characters ('*X'), keep the 'Shift' key pressed and 
press one of the function keys 'F1' up to 'F9'. According to the function key, a wildcard for the 
corresponding number of characters (from 0 to 1, 0 to 2, 0 to 3 and so on) is inserted.



Tip of the Day 16

Disable the tip of the day...

To disable the tip of the day that is displayed when T.N.T. starts, click the button or the icon of 'The Next 
Tool' in the taskbar and choose 'Settings' from the 'Configuration' submenu of the main menu. Check the 
'Disable the tip of the day' check box on the 'General' page of the settings property sheet.



II. Display Windows

For showing the contents of drives and data carriers (fixed discs, floppy discs, and compact discs) as well
as of archives and disk images the following five types of 'display windows' are available:

1.) Tree/Folder Displays

A tree/folder display consists of two panes (a tree pane on the left and a folder pane on the right) and 
simultaneously displays a hierarchy of directories and the contents of a current directory. The directory / 
subdirectory hierarchy, beginning with the root directory of the window, is shown in the tree pane in the 
form of a tree structure. The contents (files and subdirectories) of the tree's current directory are shown in 
the folder pane in the form of a list of entries.

For instance: A tree/folder display with the root directory 'C:\' shows the directory hierarchy of the 'C:' drive
on the left and the contents of any directory or archive on 'C:' on the right. In this case the contents of the 
ZIP archive 'OldFiles.zip' is being shown.

Note: Splitting the window into the tree pane and the folder pane

Between the two panes there is a split bar that can be used to change the partition of the window into the 
tree pane and the folder pane. If the mouse pointer is above the bar, it is presented in the shape of a 
horizontal double-pointer. In order to change the partition of the window, press the left mouse button while
the pointer is presented this way and move the mouse (with the mouse button still pressed) to the left or 
right. Release the mouse button to keep the new partition. (Note: If the minimal size of a pane is reached 
while moving the bar, the bar can not be moved any further.)



2.) Multi-Folder Displays

Multi-folder displays simultaneously display all files within a directory hierarchy. All files in the window's 
root directory itself or in one of its subdirectories are listed.

For instance: A multi-folder display with the root directory 'C:\' shows all files in the 'C:\' directory or in any 
one of its subdirectories. In this case all files on the 'C:' drive are shown.

3.) Folder Displays

A folder display shows the contents of a single directory in the form of a list of entries (files and 
subdirectories).



For instance: A folder display of 'C:\WINDOWS\Start Menu\Programs\Accessories'.

4.) Tree Displays

A tree display shows a directory hierarchy starting with the window's root directory. The directory / 
subdirectory hierarchy is displayed in the form of a tree structure.



For instance: A tree display of the 'C:' drive shows the drive's directory hierarchy.

5.) Search-Result Displays

Search-result displays show those files that were found during a file find and find in files command. At the 
same time the primary search criterion, which led to the opening of the window, is shown in the window's 
title bar, next to the root directory, in pointed brackets '<>'.



For instance: The 'C:\WINDOWS' directory has been searched for the expression 'registry' (find in files). 
Then the search-result display shows all files containing 'registry' and 'C\WINDOWS <registry>' is 
displayed in the window's title bar.

Note: If there was no search for the occurrence of an expression but for files of a certain type (that means
for files matching a certain filename pattern = file find), the corresponding 'filename pattern' is shown in 
the window's title bar. For Instance: If the 'C:\WINDOWS' directory has been searched for TXT files, 'C:\
WINDOWS <*.TXT>' is displayed.)

Note: Search-result displays differ from all the other 'display windows' in that they cannot be opened 
explicitly, but exclusively by a file find and find in files command. Therefore search-result displays being 
open when quitting T.N.T. are also not saved together with the configuration of the program, unlike the 
other 'display windows'.

You will find detailed information on the various aspects of using 'display windows' in the following 
chapters:

II.1. The Folder Pane
a) Selecting Entries in Display Windows
b) The Status Bars of a Display Window
c) Drag-and-Drop: Status Bars of Display Windows

II.2. The Tree Pane
II.3. Navigating on Drives and Directories
II.4. Configuring the View of a Display Window

a) Configuring the View by Means of the Button Bar of the Folder Pane
b) Configuring the Display Scheme





II. Display Windows
II.1. The Folder Pane

The folder pane is the part of a display window that is used to show a number of files and directories in 
the form of a list. For each entry the following pieces of information can be displayed:

- A symbol to identify the file type.
- The filename or the directory name.
- The filename extension that defines the file type.
- The file size (for archives and compressed drives together with the compression rate, if applicable).
- The file attributes.
- Date and time of creation, last access and last modification.
- The directory path of the entry (available only for multi-folder and search-result displays).

Folder panes are used in the following windows:

- In tree/folder displays and folder displays to show the contents of the window's current directory.

- In multi-folder displays to show all files within the directory hierarchy, beginning with the root directory of 
the window.

- In search-result displays to show those files that were found during a file find and find in files command.
 

Within the folder pane the following operations are available to start commands, to work on files and 
directories and to select those files and directories to be worked upon by a command. 

- Selecting Files and Directories... To select (or deselect) a single file or directory, click the 
corresponding entry with the left mouse button. To select (or deselect) a number of entries in succession, 
click the first entry with the left mouse button. Keep the button pressed and drag the mouse upwards or 
downwards.
To select (or deselect) a certain set of entries, choose the corresponding option ('Select All', 'Select None',



'Invert Selection' or File Pattern) from the 'Edit' menu. (See also: Selecting Entries in Display Windows. 
When using the keyboard see: Keyboard Shortcuts: Selecting Entries from a List)

- Executing Commands by Means of the Context Menus... Click on a file or directory with the right 
mouse button to open the corresponding file context menu or the directory context menu respectively. 
Choose an option from the context menu to apply the corresponding command to the entry. To apply a 
command to a number of selected entries, open the context menu by clicking on any one of the selected 
entries. (When using the keyboard see: Keyboard Shortcuts: Execution of File Commands.)

Note: You can adjust the file context menus as well as the directory context menu to your personal needs.
New commands can be added and new menus can be created for certain file types or groups of files. For 
a detailed description see: User-Defined Menus.)

- Opening or Executing Files and Folders... By double clicking on an entry with the left mouse button, 
the corresponding file or directory is opened straight away. One of the following actions is executed 
depending on the type of the entry:

- Executables are run straight away.

- In the case of a directory or an archive the contents are displayed in the current display window. 

- Files associated with a certain application are opened with the application.

- In any other case an 'Open with...' command is executed and the application to open the file can be 
chosen.

- Displaying Files and Folders... By double-clicking an entry with the right mouse button the contents of 
the file or directory are displayed immediately. One of the following actions is executed depending on the 
type of the entry:

- In the case of a directory or an archive the contents are displayed in a new display window.

- If a quick view is installed for the corresponding file type, the file is displayed by means of the Windows®
quick view technology.

- In any other case T.N.T.'s internal file viewer is opened.

- Drag-and-Drop of Files and Directories... In T.N.T. drag-and-drop of files and directories is always 
done with the right mouse button. In order to drag an entry (a file or directory) from a display window, click
the entry with the right mouse button and keep the button pressed. (Note: To drag a number of selected 
entries, click on any of the selected entries.) Then move the mouse pointer over the target. Release the 
mouse button to drop the entries. The action that is initiated by dropping the entries depends on the 
target. For a list of possible targets see Drag-and-drop: Files and Directories.)

- Configuring the View of the Window... The way files and directories are displayed can be configured 
in detail for certain situations. You can choose which pieces of information (symbol, name, extension...) 
are to be displayed, how the entries are to be sorted, whether files that do not match a certain file pattern 
are to be excluded, whether archives and disk images are to be handled like directories or like files, and 
so on.
The configuration of the view can be done by means of the button bar on top of the folder pane as well as 
by means of the 'View' menu, which contains options to create and use view schemes and file pattern 



schemes. For a detailed description of all features see Configuring the View of a Display Window.

Note: Click the button bar with the left mouse button to re-sort the entries. Click the bar with the right 
mouse button to turn individual pieces of information on or off.



II.1. The Folder Pane
a) Selecting Entries in Display Windows

A number of entries (files and directories) can be selected in the folder pane of a display window and then
be passed to a file command (copy, delete...) as a parameter. The corresponding command will then work
only on the selected files and directories. Note: Selected entries are underlain with the color that is used 
for selected items (default: light blue).

The following operations are available for selecting entries. (Note: When using the keyboard see 
Keyboard Shortcuts: Selecting Entries from a List)

- Selecting / deselecting single entries... Click an entry with the left mouse button to invert its state. 
Click an unselected entry to select it and a selected one to deselect it.

- Selecting / deselecting entries continuously... To select (or deselect) several entries in succession 
click the first entry with the left mouse button and keep the button pressed. Drag the mouse upwards or 
downwards. Then all entries that are crossed with the mouse pointer take on the state of the first entry.
If you have dragged the mouse pointer too far, your can restore the original state of the entries by 
dragging the mouse pointer into the opposite direction, in other words: back to the entry you started with. 
If the mouse pointer is moved across the upper or lower border of the folder pane, the list of entries is 
scrolled in the corresponding direction.

- Selecting all entries... To select all entries, choose 'Select All' from the 'Edit' menu or double-click the 
status bar of the display window with the left mouse button.

- Deselecting all entries... To deselect all entries, choose 'Select None' from the 'Edit' menu or double-
click the status bar of the display window with the right mouse button.

- Inverting the state of all entries... To invert the state of all entries choose 'Invert Selection' from the 
'Edit' menu.

- Selecting or deselecting entries according to a file pattern... Choose the corresponding 'file pattern' 
from the 'Edit' menu to select those files that match a predefined pattern. To create a new 'file pattern' and
to select or deselect all files that match it, select 'File Pattern' from the 'Edit' menu.



a) Selecting Entries in Display Windows
- Keyboard Shortcuts: Selecting Entries from a List

Entries (e.g. files and directories in the folder pane of a display window) can be selected and deselected 
by means of the following keyboard shortcuts:

- Plus '+'... Selects the current entry and moves the cursor to the next one.

- Minus '-'... Deselects the current entry and moves the cursor to the next one.

- Asterisk '*'...
- Shift + Cursor down...
- Insert... Inverts the state of the current entry and moves the cursor to the next one.

- Shift + Asterisk '*'... 
- Shift + Cursor down...
- Shift + Insert... Inverts the state of the current entry and moves the cursor to the previous one.

- Shift + Home... Inverts the state of all entries from the current position of the cursor to the first entry of 
the list.

- Shift + End... Inverts the state of all entries from the current position of the cursor to the last entry of the
list.

- Control + Asterisk '*' (numeric keypad)... Inverts the state of all entries.

- Control + Plus '+' (numeric keypad) ... Selects all entries.

- Control + Minus '-' (numeric keypad)... Deselects all entries.

The following keyboard shortcuts are only available in the folder pane of a display window only, but not for
other kinds of lists:

- Alt + Plus '+' (numeric keypad)... Opens the 'Collection of Patterns' dialog box to choose a single 
filename pattern. All entries that match the pattern are selected.

- Alt + Minus '-' (numeric keypad)... Opens the 'Collection of Patterns' dialog box to choose a single 
filename pattern. All entries that match the pattern are deselected.

- Alt + Asterisk '*' (numeric keypad)... Opens the File Pattern dialog box to create or choose a 'file 
pattern'. All entries that match the pattern can be selected or deselected.



II.1. The Folder Pane
b) The Status Bars of a Display Window

On the lower margin of each display window (except for tree windows) there are two status bars. In these 
bars statistical information is displayed about the entries that are displayed in the window and they can be
used to execute various operations:

1.) Pieces of Information Displayed in the Status Bars

In the upper status bar of the display window the number of files and directories as well as the total size of
all files is shown. In the lower status bar the same data is displayed for the selected entries.
If the window contains compressed files, the percentage of saving is also displayed, related to the total of 
all compressed files in the upper status bar and related to the number of selected files in the lower status 
bar. (Note: Compressed files can be files in archives and perhaps files on compressed drives, depending 
on the state of the Determine compression rate for archives only check box, which can be set on the 
'Directories' page of the 'Settings' property sheet.)

Note: In multi-folder displays and search-result displays the number of directories in the upper status bar 
always represents the total of all directories within the current directory hierarchy, starting with the root 
directory of the window. The number of directories in the lower status bar is not of significance.

2.) Executing Commands by Means of the Status Bars

- Selecting and deselecting entries... Double-click the status bars with the left mouse button to select all
entries in the folder pane of the window. Double-click the bars with the right button to deselect all entries.

Click the status bars with the right mouse button to open a context menu that contains the following 
options for the selection of entries:

- 'Select All'... to select all entries.
- 'Select Nothing'... to deselect all entries.
- 'Invert Selection'... to invert the status of all entries.
- File Pattern... to select or deselect entries according to a 'file pattern'.

- Exporting entries... To copy a list of entries from the folder pane of the window to the clipboard or to 
edit or print the list of entries, choose the corresponding option ('Copy', 'Edit', 'Print') from the context 
menu that is opened by clicking one of the status bars with the right mouse button.
 
Notes:

- If clicking the upper status bar opens the context menu, you get a list of all entries. To create a list of the 
selected entries only, click the lower status bar.

- Once copied to the clipboard, entries (files and directories) can be inserted in any application as a text 
as well as a file copy on the desktop.



- Locating files and directories... In order to quickly find a certain file or directory, which may be 
somewhere within the current directory hierarchy, and to switch to the corresponding directory, choose 
'Locate' from the context menu that is opened by clicking the status bars with the right mouse button. 
Enter the file or directory name or at least a fragment of the name, in the 'Locate' dialog box. For a 
detailed description see Locating Files and Directories. (Note: 'Locate' is not available for search-result 
displays.)

- Drag-and-drop of status bars... Both status bars can be used for drag-and-drop as a source as well as
a target. See also: Drag-and-Drop: Status Bars of Display Windows.



II.1. The Folder Pane
c) Drag-and-Drop: Status Bars of Display Windows

It is possible to drag a list of the entries in the folder pane from the status bars of the display window drop 
it onto the items named below. If the upper status bar is dragged, a list of all entries is created. The lower 
status bar results in a list of the selected entries only.

To drag a list of entries from a status bar, move the mouse pointer above the bar, click the right mouse 
button and keep the button pressed. Then move the mouse pointer over the target and release the mouse
button to drop the list.

A list of entries can be dropped onto the following items:

- Onto 'Print' commands within the control window's command bar or the Command Templates 
window... A command for printing files and texts is executed.

- Onto 'Editor' commands within the control window's command bar or the Command Templates 
window... A new editor is opened with the list of entries.

- Onto editor windows (on the text display area)... The list of entries is inserted at the current position 
of the mouse pointer.

- Onto any other program or application that accepts text items via drag-and-drop... The list of 
entries is passed to the application.

- The 'Filename' page of a File Pattern property sheet (on the list of including or excluding 
filename patterns)... The filenames are added to the corresponding list of patterns. Directories are 
ignored.

- The Filename Patterns pane of the 'Menus' dialog box... The filenames are added to the list of 
'filename patterns' that define the current file group. Directories are ignored. (See also: User-Defined 
Menus.)

- Status bars of a display window... The File Pattern property sheet is opened for the selection or 
deselection of entries. The filenames are added to the list of including filename patterns. (See also: 
Selecting Entries in Display Windows.)



II. Display Windows
II.2. The Tree Pane

The tree pane is the part of a display window that is used to show a directory hierarchy. Beginning with 
the root directory of the window, the directory / sub-directory hierarchy is displayed in the form of a tree 
structure. (Note: The entries (branches) of the tree can represent 'normal' directories as well as archives 
and disk images.)

Tree panes are used in the following windows:

- In tree windows and tree/folder windows to show the directory hierarchy, beginning with the root 
directory of the window.

- When creating shortcuts, for the selection of the target directory.

1.) Expanding and Folding Up the Branches

Expanding and folding up the branches of the tree is done with the left mouse button. Click the current 
branch to invert its state. Clicking a branch, keep the button pressed and drag the mouse downwards to 
expand a branch completely. For a detailed description of all the available operations as well as for the 
corresponding keyboard shortcuts refer to Expanding and folding up the branches of tree structures.

2.) Using the Directory Context Menu for the Execution of Commands

You can open a directory's context menu by clicking the corresponding branch of the tree with the right 
mouse button. Choose an option from the context menu, to apply the corresponding command to the 
directory. (When using the keyboard see: Keyboard Shortcuts: Executing Commands.)

Note: You can adjust the directory context menu to your personal needs and add new commands. For a 



detailed description see: User-Defined Menus.

3.) Opening a New Display Window

- By double-clicking a branch of the tree with the left mouse button you open a context menu that contains
the following options: 'Tree/Folder Display', 'Multi-Folder Display', 'Folder Display' and 'Tree Display'. 
Choose one of the options to open a display window of the corresponding type that has the clicked 
directory as its root.

- Double-click a branch of the tree with the right mouse button to open a new display window of the 
current type that has the clicked directory as its root.

4.) The Drive Context Menu

Click the free drive space display on the upper margin of the tree pane with the right mouse button to 
open the context menu of the drive of the window's current directory. (Note: If the current directory is a 
'normal' directory, the drive context menu of the corresponding hard disk or network drive is opened. If the
current directory is within an archive or a disk image, the context menu of the corresponding virtual drive 
is opened.)
Via the drive context menu you have access to the favorite and the recently used directories of the drive 
as well as to various drive dependent commands (e.g. 'Format' and 'Diskcopy' in the case of a floppy disk 
drive.) For a detailed description see Favorite Directories.

5.) Updating the Display

Click the free drive space display on the upper margin of the tree pane with the left mouse button to 
cause all information about the current directory hierarchy to be dismissed and re-read. For instance: You 
should update the window if a notification occurs which says 'The entries in the displayed directory are no
longer up to date.' A possible reason for this message could be the exchange of the data carrier itself or 
the modification of the contents of the data carrier by another program in case a drive is not automatically 
updated by the operating system.

6.) Drag-and-Drop of Directories

In T.N.T., drag-and-drop of directories is always done with the right mouse button. In order to drag a 
directory from the tree pane, click the entry with the right mouse button and keep the button pressed. 
Then move the mouse pointer over the target. Release the mouse button to drop the directory. The action
initiated by dropping the directory depends on the target. For a list of possible targets see Drag-and-drop: 
Files and Directories



II.2. The Tree Pane
- Expanding and Folding Up the Branches of Tree Structures

Tree structures are used in the following situations:

- In the tree pane of a display window to show a directory hierarchy.

- In the 'Menus' dialog box to show the menu / submenu hierarchy of the user defined menus.

Concerning the terminology: A branch (folder or entry) of the tree is 'expanded' if the subordinate or 
contained entries are visible. It is folded up if the subordinate entries are hidden. A branch is completely 
expanded if all subordinate branches are completely expanded.

When using the mouse:

- Expanding a branch... Clicking it with the left mouse button can expand a branch that is folded up. 
Then the subordinate entries are shown. Expanded branches are displayed with the normal text color 
(default: black) and the symbol of an open folder.

- Folding up a branch... By clicking an expanded branch with the left mouse button, (first) the cursor of 
the tree structure is set to the corresponding branch and the branch becomes the current entry of the tree.
By clicking the current entry (again), the corresponding branch is folded up. Its contents are then hidden. 
Branches that are folded up are displayed with the color that is used for stressed items    (default: 
carmine) and the symbol of a closed folder.

- Completely expanding a branch... To completely expand a branch of the tree structure, click the 
corresponding entry with the left mouse button, keep the button pressed and drag the mouse downwards.

- Completely folding up a branch... To completely fold up a branch of the tree structure, click the 
corresponding entry with the left mouse button, keep the button pressed and drag the mouse upwards.

Note: Completely expanding or folding up a branch only is possible if the T.N.T. like handling of the left 
mouse button is enabled. If you check the 'Left mouse button Explorer compatible' check box on the 
'General' page of the 'Settings' property sheet, the handling of tree structures is done according to the 
Explorer standard. (See also: Explorer Compatibility of the Left Mouse Button.)

When using the keyboard:

By means of the following keyboard shortcuts you can expand and fold up the current branch of a tree 
structure (that means the branch on which the cursor is):

- Enter / Return... Inverts the state (expanded / folded up) of the branch.

- Asterisk '*'... Completely expands the branch.

- Plus '+' ... Expands the branch.

- Minus '-'... Folds up the branch.





II. Display Windows
II.3. Navigating on Drives and Directories

You can navigate on drives and directories with the display windows by using the following operations:

1.) The Drive Register

- Changing the drive... By clicking a page of the drive register with the left mouse button or by means of 
the keyboard shortcut 'Alt + <drive letter> you switch to the corresponding drive. (Note: Normally, the root 
directory of the new drive is shown after changing the drive. If you always want the most recently used 
directory to be displayed again, check the 'Show the most recently used directory' check box on the 
'Drives' page of the 'Settings' property sheet.)

- Choosing a favorite or recently used directory... By clicking a page of the drive register with the right 
mouse button the corresponding drive context menu is opened. Altogether, the menu contains up to 10 
favorites and recently used directories of the drive, which can be chosen to be displayed directly. (See 
also Favorite Directories.)

Notes:

- The entire drive register or the display of a page for each single drive can be deactivated on the 'Drives' 
page of the 'Settings' property sheet.

- If some pages of the drive register are not visible because they were deactivated or because of 
the size of the window, a '...' page is added to the register to enable access to the 'other' drives.

- If the mouse pointer is positioned above a page of the drive register for one moment, a tooltip appears, 
showing the free space and the label of the drive. In the case of a SUBST drive, the path of the directory 
the drive was derived from is shown.

2.) The 'Ancestors' Menu

There is an 'Ancestors' menu in each display window by means of which you can change the current drive
and/or the current directory. The first part of the menu contains all the directories the window's current 
directory depends on, starting with the root directory of the current drive. (Note: If the current directory is 
within an archive or a disk image, the ancestors of this virtual drive (that means the ancestors of the file 
the archive depends on) are also shown in the 'Ancestors' menu.) Select an option from the menu to 
switch to the corresponding directory.

For instance: A display window that has the current directory

'C:\WINDOWS\SYSTEM\VIEWERS'

has an 'Ancestors' menu with the following options:



'C:'
'WINDOWS'
'SYSTEM'

The current drive can be changed by means of the list that forms the second part of the menu, which 
contains all drives. (Note: Normally, the root directory of the new drive is displayed after changing the 
drive. If you always want the most recently used directory to be displayed again, check the 'Show the 
most recently used directory' check box on the 'Drives' page of the 'Settings' property sheet.)

3.) Switching to the Parent Directory

To switch to the current directory's parent directory, choose '..' from the menu bar. When using the 
keyboard press 'Backspace' or 'Alt + '.' (Note: This option is only available for folder displays and 
tree/folder displays.)

4.) Locating Files and Directories

To quickly find a certain file or directory, which may be somewhere within the current directory hierarchy, 
and to switch to the corresponding directory, choose 'Locate' from the 'Edit' menu and enter the file or 
directory name, or at least a fragment of the name, in the 'Locate' dialog box. For a detailed description 
see Locating Files and Directories. (Note: 'Locate' is not available for search-result displays.)

5.) Changing the Type of the Display Window

You can change the type of a display window by means of the 'Type' menu, which contains the following 
options: 'Tree/Folder Display', 'Multi-Folder Display', 'Folder Display' and 'Tree Display'. Note: If you 
change the type of a 'display window', the current directory remains the same. For instance: If a folder 
display that has the current directory 'C:\WINDOWS' is changed to a tree display, the new window shows 
the directory hierarchy, starting with the directory 'C:\WINDOWS'.



II. Display Windows
II.4. Configuring the View of a Display Window

The way files and directories are shown in the folder pane of a display window as well as the set of files to
be displayed can be configured for certain applications.

- You can choose which pieces of information (symbol, name, extension, size (and if applicable, 
compression rate), attributes, date and time of creation, last modification and last access) are to be 
shown for each entry (each file and directory) and you can set up their display sequence.

- You can determine the criteria according to which the entries are sorted, whether archives and disk 
images are handled like directories or like files and whether directories are to be displayed first, last, 
sorted with the files or are to be omitted.

- Files that have properties (name, extension, size...) that match a certain file pattern can be excluded 
from displaying.

The configuration of the view can take place by means of the button bar of the folder pane

as well as by means of the 'View' menu.

Normally, the button bar can be used intuitively: Single-click a segment with the left mouse button to 
change the primary criterion for sorting. Single-click a segment with the right mouse button to open the 
context menu to choose the pieces of information that are to be shown.



Thus, the button bar is very suitable when a different representation of the displayed data is needed 
quickly. For instance, if you want to change the way the entries are sorted or activate (or deactivate) the 
display of single pieces of information. (Note: For a detailed description of the button bar see: Configuring 
the View By Means of the Button Bar of the Folder Pane.)

If certain differentiated views on single directories or certain sets of files are needed more often, you can 
create predefined schemes for the configuration of the view and reuse them over and over again. All the 
schemes already available can be found in the 'View' menu below the keywords 'Display' and File Pattern.

1.) Configuring the Display Scheme

The generic term 'display scheme' includes the two aspects of the configuration of the view that were 
mentioned first at the beginning of this chapter. These are a) the selection and the display sequence of 
the pieces of information and b) the order in which the entries are sorted.
All predefined display schemes are shown in the 'View' menu below the keyword 'Display'. The scheme 
currently in use is checked. For instance, there are the options 'Sorted by name' and 'Sorted by 
extension'. Simply choose one of the options to use the corresponding scheme.
Choose 'Display' from the 'View' menu to open the property sheet in which the order of sorting and the 
display sequence can be set up in detail. By means of this dialog box you can also save, load or delete a 
scheme. For a detailed description of the 'Display' property sheet see Configuring the Display Scheme.

2.) Using a File Pattern

You can restrict the number of files that are displayed in a display window by a file pattern. For instance, it
can be determined that only files of a certain type or files having a certain size or a certain combination of 
attributes are shown.
All predefined file patterns are listed in the 'View' menu below the keyword 'File Pattern'. The 'file pattern' 
that is currently in use is checked. For instance, there are the following options: 'All Files', 'Archives' or 
'Executables'. Simply choose one of the options to use the corresponding 'file pattern'.
To create a new file pattern in order to restrict the files that are shown, choose 'File Pattern' from the 
'View' menu. Then the property sheet in which you can set up the various components of the 'file pattern' 
(the filename patterns, the time ranges, the pattern of attributes and the range of sizes) appears. By 
means of this dialog box you can also save, load or delete a scheme. For a detailed description of the 
'File Pattern' property sheet see the corresponding chapter.

3.) Using the Current Layout of a Window as Default

If you have configured all aspects of the view to your desires and the appearance of the current window is
to be used as the default for future windows, choose 'Current Layout as Default' from the 'View' menu. All 
display windows having the same type as the current window that will be opened in the future will then 
have the properties of the current window. This affects the size of the window as well as the configuration 
of the display scheme and the file pattern possibly in use at the moment.

Notes:

- A separate default layout can be defined for each type of display window (tree/folder displays, multi-
folder displays, folder displays, tree displays and search-result displays).

- If a new default layout was chosen for a display window, a notification appears when quitting T.N.T. and 
you can choose whether or not the configuration of the program is to be saved. Save the configuration if 
you want the new layout to be available when running T.N.T. the next time.



4.) Using Layout Schemes

The layout of a display window includes all parameters and options that concern the appearance of the 
window. Especially the size of the window, the configuration of the display scheme and possibly a file 
pattern currently in use to limit the shown entries. A configuration of the layout that was created once can 
be saved as a scheme and be reused in any situation.
You will find all available layout schemes in the 'Type' menu below the keyword 'Layout'. To use a 
predefined scheme, simply choose the corresponding option from the menu. To save the current layout of 
a window as a scheme, choose 'Layout' from the 'Type' menu and enter the name of the scheme to be 
saved in the dialog box. If you want to delete a layout scheme, choose 'Layout' from the 'Type' menu as 
well. Click the desired layout with the right mouse button and choose 'Delete' from the context menu.

5.) Updateing the Display

By choosing 'Update' from the 'View' Menu you can cause all information about the current directory to be
dismissed and re-read. For instance: You should update the window if a notification occurs which says 
'The entries in the displayed directory are no longer up to date.' A possible reason for this message could 
be the exchange of the data carrier itself or a modification of the contents of the data carrier by another 
program, in case a drive is not automatically updated by the operating system.



II.4. Configuring the View of a Display Window
a) Configuring the View by Means of the Button Bar of the Folder Pane

By means of the button bar on the upper margin of the folder pane of a display window, the following 
aspects of the view can be adjusted directly:

- Changing the width of the 'Name' and the 'Extension' columns... Move the mouse pointer over the 
space between the corresponding segment ('Name' or 'Extension') and following one. The mouse pointer 
is then presented with the shape of a horizontal double-pointer. Press the left mouse button while the 
pointer is presented this way and keep the button pressed. Move the mouse to the left or to the right to 
reduce or widen the column.

- Changing the primary criterion for sorting or inverting the direction of sorting... Click a segment of
the button bar to declare the corresponding piece of information to be the primary criterion for the sorting 
of the entries. If the corresponding column already is the primary criterion, the direction (upwards or 
downwards) of the sorting process is inverted,

- Activating and deactivating single pieces of information... Click a segment of the button bar with the
right mouse button to open the context menu. The menu contains the names of all pieces of information 
available for displaying. Choose one of the options: 'Symbol', 'Name', 'Extension', 'Attributes' 'Date' and 
'Time' of 'Creation', 'Last Modification' and 'Last Access' or 'Compression Rate' to activate (or deactivate) 
the display of the corresponding piece of information.

- Handling of directories and archives... Click a segment of the button bar with the right mouse button 
to open the context menu. The menu contains two submenus, named 'Directories' and 'Archives'. By 
means of these submenus, you can determine whether directories are to be displayed first, last, sorted 
with the files or are to be omitted and whether archives are to be handled like directories or files.

- Not separating the filename extension... You can disable that filenames and filename extensions are 
shown in separate columns. To display the complete filename (including the filename extension) in the 
'Name' column, check the 'No Separated Extension' option in the context menu that you can open by 
clicking the button bar with the right mouse button.

 - Restricting the displayed entries to a single file type...

Click the icon segment of the button bar with the right mouse button to open the 'Collection of Patterns' 
dialog box. There you are able to choose or enter a filename pattern so only those files are displayed that 
match the pattern.
 



II.4. Configuring the View of a Display Window
b) Configuring the Display Scheme

The way information about files and directories is shown in the folder pane of a display window can be 
configured for certain applications.

- You can choose which pieces of information (symbol, name, extension, size (and if applicable, 
compression rate), attributes, date and time of creation, last modification and last access) are to be 
shown for each entry (each file and directory) and you can set up their display sequence.

- You can determine the criteria according to which the entries are sorted, whether archives and disk 
images are handled like directories or files and whether directories are to be displayed first, last, sorted 
with the files or are to be omitted.

The configuration of the display scheme is done by means of the 'Display' property sheet that is opened 
by choosing the option of the same name from the 'View' menu of a display window.

1.) Using Display Schemes

Once a configuration of the view has been created, it can be saved as a scheme and be reused in any 
situation. The title of the scheme currently in use is shown in the 'Scheme' combo box on the upper 
margin of the 'Display' property sheet.

In order to use a predefined scheme, click the combo box with the left mouse button. The list of the 
available schemes is then unfolded and the desired scheme can be selected. To save the current 
configuration of the view as a scheme, press the 'Save as' button and name the scheme. To delete the 
current scheme, press the 'Delete' button.

2.) Selecting the Pieces of Information to be Displayed and Setting Up the Display Sequence

On the 'Display Sequence' page of the 'View' property sheet, you can select which pieces of information 
are to be displayed for each entry (file and directory) and set up their display sequence.



The following pieces of information can be selected:

1. Symbol (for the identification of the file type)
2. Name (for files: extension excluded, for directories: extension included)
3. Extension (of the filename defining the file type)
4. Size (of the file, for directories <DIR> is displayed)
5. Attributes (of the file and of the directory respectively)
6. Date of the last modification (of the file and of the directory respectively)
7. Time of the last modification (of the file and of the directory respectively)
8. Date of the creation (of the file and of the directory respectively)
9. Time of the creation (of the file and of the directory respectively)
10. Date of the last access (to the file and to the directory respectively)
11. Time of the last access (to the file and to the directory respectively)

Additionally, in multi-folder displays and search-result displays:

12. Path (of the file)

To activate or deactivate the display of a piece of information, check the corresponding check box. To 
change the display sequence, click a button and choose the piece of information from the context menu 
that is to be shown on the corresponding position.

3.) Displaying the Compression Rate of Compressed Files



The compression rate of a file within an archive or on a compressed drive can be displayed in addition to 
the size of the uncompressed file if the corresponding information is made available by the driver 
software. Check the 'Display compression rate' check box to activate the displaying of the compression 
rate.

Notes:

- If displaying the compression rate is enabled, the percentage of the saving is shown. Thus the 
percentage has to be interpreted as follows:

E.g. it is displayed: INFO.TXT 10253 (48%)

That means the size of the uncompressed file 'INFO.TXT' is 10253 bytes. By compressing the file, 48% of
its size were saved.

- If you use drives that were compressed by DriveSpace or a similar tool and there are a lot of files within 
a single directory, there may be a significant delay when displaying the directory in case the displaying of 
the compression rate is enabled. To avoid the delay, check the Determine compression rate for archives 
only check box on the 'Directories' page of the 'Settings' property sheet.

4.) Grouping the Digits of the File Size

If you want the file size to be displayed with grouped digits (that means '900,000' is shown instead of 
'900000') check the 'Group Digits' check box.

5.) Not separating the filename extension

You can disable that filenames and filename extensions are shown in separate columns. To display the 
complete filename (including the filename extension) in the 'Name' column, check the 'No Separated 
Extension' check box.

6.) Setting the Order and the Direction of the Sorting Process

On the 'Sorting Process' page of the 'View' property sheet, you can choose

- according to which criteria the entries in the folder pane of a display window are to be sorted.

- whether directories are to be shown in front of, behind, sorted with the files or whether they are to be 
omitted.

- whether archives are to be handled like directories or like files.



The following criteria are available for all display windows:

1. Extension (of the filename defining the file type)
2. Name (for files: extension excluded, for directories: extension included)
3. Size (of the file)
4. Date and time of the last modification (of the file and of the directory respectively)
5. Date and time of the creation (of the file and of the directory respectively)
6. Date and time of the last access (to the file and to the directory respectively)
7. Attributes (of the file and of the directory respectively)

Additionally, in multi-folder displays and search-result displays:

8. Path (of the file)

To change the priority of the criteria used for sorting, click a button and choose that criterion from the 
context menu that is to be set on the corresponding position. To adjust the direction of the sorting process
there is a check box next to each criterion. To switch the direction, check the corresponding check box. 
Normally the entries are sorted (and displayed) in ascending order. That means:

a-somefile < b-somefile 'a-somefile' is displayed before 'b-somefile'
10000 < 10001 '10000' is displayed before '10001'
1/1/95 < 1/2/95 '1/1/95' is displayed before '1/2/95'



7.) Handling of Directories

In the folder pane of a display window, directories can be displayed differently: first, last, sorted with the 
files or left out. To set the desired method, press the 'Directories' button and choose the desired options: 
'First', 'Last', 'Sorted' or 'Omitted' from the context menu.

8.) Handling of Archives

In the folder pane of a display window the entries of archives can be handled like directories or like files. 
To set the desired method press the 'Archives' button and choose the desired option: 'like Archives' or 'like
Files' from the context menu.



III. File-Management

'The Next Tool' offers a number of features for file handling or file-management. These are commands to 
copy, delete and work on files and directories etc.

III.1. Copying and Moving Files and Directories
III.2. Deleting Files and Directories
III.3. Renaming Files and Directories
III.4. Modifying the Attributes of Files and Directories
III.5. Modifying the Date and the Time of Files
III.6. Comparing Files and Directories
III.7. Printing Files and Texts
III.8. The Multi-File Viewer
III.9. Creating Shortcuts

Regardless of the kind of command you want to start, you can proceed as follows to apply a file command
to a certain number of files or directories:

- If you want to work on a single file or a single directory, click the corresponding entry in a display window
with the right mouse button and choose the desired command from the context menu.

- If you want to work on a number of files or directories, select the desired entries by using the left mouse 
button (See also: Selecting Entries in Display Windows), click one of the selected entries with the right 
mouse button and choose the desired command from the context menu.

Thereupon, a dialog box appears in which you can set all options and parameters for the command. In 
the first edit control, named 'Source', you will find the path of the selected files or directories that are to be
worked on. A small icon, to the right of the edit control, describes the type of the source more closely.

1.) You have chosen a file

2.) You have chosen a number of selected entries in the named directory

3.) You have chosen a directory

To modify the source file(s) subsequently, enter the new path in the 'Source' edit control or click the icon 
to the right of the edit control with the left mouse button to browse for a file or a directory (See also: 
Browsing Through the Directory Hierarchy) or click the icon with the right mouse button to locate a certain
file or directory (See also: Locating Files and Directories.)

Note: If you are experienced in using the Windows® 95 Explorer or another file-manager, you will already 
know the basic functionality of the various file commands. Nevertheless, please note the instructions to 



the various features, which are offered by T.N.T. alternatively or in addition, as well as the description of 
the file commands themselves.

Some features that are available for a number of file commands are:

- Subsequent Specification of the Source Path for a File Command
- Edit Control Icons
- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Security Checks and Confirmations
- Numbering the Disk Images
- Drag-and-Drop: Files and Directories



III. File-Management
- Subsequent Specification of the Source Path for a File Command

As the contents of a directory may be visible in several display windows at the same time, different views 
on the same directory are possible by means of different window configurations. Thus, the set of source 
files for a file command possibly cannot be automatically determined unambiguously.
In most situations, the origin window of the source files can be determined via the entry and the context 
menu that was used to start the file command. However, this is not possible if you enter the source path 
by using the keyboard and several windows that show the contents of the directory are open and/or there 
are selected entries in one of the windows. In this case, a dialog box appears in which you can specify the
origin of the source files unambiguously, as soon as you start the execution of the command.
This dialog box shows a list of all possible origins of the directory. Therefore, the list always contains the 
directory itself as well as all windows that show the current contents of the directory. You can select the 
entry that in fact represents the desired source by clicking it with the left mouse button.

For example:

There are two folder displays, a multi-folder display and a tree/folder display that show the contents of the
directory 'C:\TEMP'. In each window, only certain file types are shown and some entries are selected. If 
you start a delete command and enter 'C:\TEMP' in the 'Source' edit control by using the keyboard, the 
'Source' dialog box appears, showing the following list. (Note: The numbers that are shown right to the 
window descriptions also appear in the title bar of the corresponding windows and may vary with the 
order in which the windows have been opened.)

The directory C:\TEMP
Selected entries in the tree/folder display [1]
Selected entries in the folder display [2]
Selected entries in the folder display [3]
Selected entries in the multi-folder display [4]

Now, you can choose from which window the source files are to be taken or cancel the whole process. If 
you choose the name of the directory, the directory itself and its whole contents are deleted. If you choose
an entry that represents a display window, only those files are deleted that are selected in the 
corresponding window.

Warning! As soon as you specify a window to be the source for the file command, the entries that are 
currently selected are used. Up to this moment, you can still select or deselect further entries.



III. File-Management
- Edit Control Icons

Whenever you have the chance to enter the name of a file or a directory in T.N.T., there is an icon to the 
right of the edit control. By clicking the icon with the left mouse button you can browse for a file or a 
directory (See also: Browsing Through the Directory Hierarchy). By clicking the icon with the right mouse 
button, you can locate a certain file or a directory on the basis of a fragment of its name. (See also: 
Locating Files and Directories.) Depending on the context in which the edit control is used, you can also 
gather the following type of information from the icon:

1.) In the case of edit controls in which you can name individual files or directories as well as a number of 
selected entries of a display window, the icon is variable and describes the state of the current contents of
the edit control.

A single file is shown if it is unambiguous that a single file is named.

A number of files are shown if a number of selected entries have been passed out of a display window.

A folder is shown if a single file is named or if it is not possible to determine the type of the item that is 
described by the path at the moment. (This applies, for instance, if the path is entered by using the 
keyboard.)

2.) In the case of edit controls in which the input of a certain file type is expected, the icon describes the 
type of the file. 

For instance, in the dialog box in which you can set the options for creating multi-volume ZIP archives, an 
archive file that has the ZIP format is expected as the source and as the target.

When setting the options to run an external program, an executable file is expected in the 'Program' edit 
control.



3.) In the case of edit controls in which you can enter a filename pattern (e.g. the rename pattern to 
rename files and directories) the icon shows whether you can name only one pattern or a number of 
patterns.

By clicking the icon with the left mouse button you can open the collection of patterns to choose the 
filename pattern(s).



III. File-Management
- Ignore Subdirectories

If the 'Ignore subdirectories' feature is enabled for a file command, only those files are worked on that are 
immediately in (one of) the source directory (directories). Subdirectories are ignored. Depending on how 
the source has been specified, the following situations must be distinguished:

- If you start a file command via an unselected entry or enter the source path by using the keyboard, all 
files in the source directory will be worked on. The subdirectories of the source directory will be ignored.

- If you start a file command via a selected entry, all the selected files and the selected directories, 
together with the entries within them, will be worked on. The subdirectories of the selected directories will 
be ignored.

For example:

Supposing the following directory hierarchy:

C: (DIR)
BATCH (DIR)

BACKUP.BAT (FILE)
TNT.BAT (FILE)

DOS (DIR)
DRIVER (DIR)

VGA800.SYS (FILE)
PEN.COM (FILE)

EDIT.COM (FILE)
FORMAT.COM (FILE)

AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

1.) Working on a single directory

If 'C:' is entered in the 'Source' edit control by using the keyboard and 'Ignore subdirectories' is enabled, 
only the following files will be worked on:

AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

The subdirectories 'BATCH' and 'DOS' will be completely ignored.

2.) Working on selected entries

The following entries of 'C:' are selected in the folder pane of a display window:

BATCH (DIR)
DOS (DIR)
AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

If a file command is started via the context menu of a selected entry and 'Ignore subdirectories' is 
enabled, the following files will be worked on:

BATCH (DIR)



TNT.BAT (FILE)
BACKUP.BAT (FILE)

DOS (DIR)
EDIT.COM (FILE)
FORMAT.COM (FILE)

AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

The subdirectory 'DRIVER' within the directory 'DOS' will be ignored.



III. File-Management
- Use the Contents Instead of the Directory

If the 'Use the contents instead of the directory' feature is enabled for a file command, the source 
directories themselves are excluded from being worked on. Only the contents of the directories are 
treated. For instance, if you enter 'C:\TEMP' as the source directory for a copy task, normally first a 
subdirectory 'TEMP' is created in the target directory and then the contents of the directory are copied to 
the new directory. If you enter 'C:\TEMP' for a copy task, the whole contents of the directory are deleted 
and the directory itself is removed. To exclude the immediate source directory, enable 'Use the contents 
instead of the directory'.
Note: The root directory of a drive is excluded from being treated by a file command anyway. For 
instance, if you enter 'C:' as source for a copy task, the contents of the drive are copied to the target 
directory. If you name 'C:' to be deleted, the contents of the drive are removed. Deleting the drive itself 
would not be possible anyway.

Note: If you combine 'Use the Contents Instead of the Directory' with the Ignore subdirectories feature, 
'Ignore subdirectories' is applied to the subdirectories of the source directory not to the source directory 
itself.

For example:

Supposing the following directory hierarchy:

C: (DIR)
DOS (DIR)

DRIVER (DIR)
VGA800.SYS (FILE)

FORMAT.COM (FILE)

1.) 'Use the Contents Instead of the Directory' is disabled

Let 'C:\DOS' be the source directory for a copy task and 'D:\TEMP' the target directory. Consequently the 
following directory hierarchy is created on drive 'D:':

D: (DIR)
TEMP (DIR)

DOS (DIR)
DRIVER (DIR)

VGA800.SYS (FILE)
FORMAT.COM (FILE)

If 'C:\DOS' is used as the source directory for a delete task, the contents of the directory are deleted and 
the directory itself is removed.

2.) 'Use the Contents Instead of the Directory' is enabled

If the directories are used for a copy task, as described above, the following directory hierarchy is created:

D: (DIR)
TEMP (DIR)

DRIVER (DIR)
VGA800.SYS (FILE)

FORMAT.COM (FILE)



If 'C:\DOS' is used as the source directory for a delete task, only the contents of the directory are deleted 
and the directory itself is not removed.

Note: The 'Use the Contents Instead of the Directory' feature only has an effect with the following file 
commands if Ignore subdirectories is also enabled: File find and find in files, Modifying the date and the 
time of files, Comparing files and directories, Printing files and texts, The multi-file viewer.
As these commands can only be applied to files anyway, the contents of the source directory are 
automatically used instead of the directory itself. However, if 'Use the Contents Instead of the Directory' is 
enabled together with Ignore subdirectories, 'Ignore subdirectories' is applied to the subdirectories of the 
source directory.



III. File-Management
- Apply the File Pattern

If you enable the 'Apply the file pattern' feature for a file command, the File Pattern property sheet 
appears and you can set up the components of the 'file pattern' that is to be used to restrict the number of
files that are handled by the command. For instance, if 'Apply the file pattern' is enabled for a copy task, 
only those files are copied that match the pattern. In the case of a delete command, only matching files 
are deleted.

For example:

Supposing the following directory hierarchy:

C: (DIR)
DOS (DIR)

BATCH (DIR)
TNT.BAT (FILE)

DOCUMENTS (DIR)
INVOICE.DOC (FILE)
REMINDER.TXT (FILE)

DRIVER (DIR)
VGA800.SYS (FILE)
PEN.COM (FILE)

EDIT.COM (FILE)
EMM386.EXE (FILE)
HIMEM.SYS (FILE)
QBASIC.EXE (FILE)

The 'Apply the file pattern' feature is enabled and the following data has been entered in the file pattern 
property sheet:

Filename patterns for executable files:

Including patterns
*.BAT
*.BTM
*.CMD
*.COM
*.EXE
*.LNK
*.PIF
Excluding patterns
<none>

Time range:

<none>

Pattern of attributes:

Readonly: ?Hidden: ? System: ? Archive: ?
Link attributes with AND

Range of sizes:



<none>

1.) Applying the File Pattern to a Copy Task

Let 'C:\DOS' be the source directory for a copy task and 'D:\TEMP' the target directory. Consequently the 
following directory hierarchy is created on drive 'D:' if 'Apply the file pattern' is enabled for the file pattern 
described above:

D: (DIR)
TEMP (DIR)

DOS (DIR)
BATCH (DIR)

TNT.BAT (FILE)
DOCUMENTS (DIR)
DRIVER (DIR)

PEN.COM (FILE)
EDIT.COM (FILE)
EMM386.EXE (FILE)
QBASIC.EXE (FILE)

Note: If the file pattern excludes all files of a subdirectory, the directory is created nevertheless. For the 
example described above, this applies to the 'DOCUMENTS' directory. 'File patterns' never affect 
directories, just files. An empty source directory would also be copied or created by the copy task without 
applying the 'file pattern'. 

2.) Applying the File Pattern to a Delete Task

If 'C:\DOS' is used as the source directory for a delete task and 'Apply the file pattern' is enabled for the 
file pattern described above, the following directory hierarchy is created on drive 'C:':

C: (DIR)
DOS (DIR)

DOCUMENTS (DIR)
INVOICE.DOC (FILE)
REMINDER.TXT (FILE)

DRIVER (DIR)
VGA800.SYS (FILE)

HIMEM.SYS (FILE)

Note: If all files in a subdirectory are removed because of the file pattern, the corresponding directory is 
remove as well. For the example described above, this applies to the 'BATCH' directory. 'File patterns' 
never affect directories, just files. An empty source directory would also be removed by the delete task 
without applying the 'file pattern'. 



III. File-Management
- Security Checks and Confirmations

When copying and moving files and directories as well as when deleting files and directories you can 
enable the following security checks and confirmations.

1.) Security Checks for Copy Tasks

- Confirm before overwriting... A notification appears before a file that already exists in the target 
directory is overwritten.

- Confirm for every file... A notification appears for every file that is to be copied.

2.) Security Checks for Delete Tasks

- Confirm for every file... A notification appears for every file that is to be deleted.

- Confirm for RHS attributes... A notification appears if one of the attributes R (read-only), H (hidden) or 
S (system) is set.

- Confirm for directories... A notification appears for each subdirectory and you can choose whether to 
delete the contents of the directory or not. A soon as the contents of a directory are removed, another 
notification appears and you can choose whether or not to remove the directory itself.

Note: Besides, you can enter limits for files and directories in the Confirmation Before Deleting section on 
the 'Commands' page of the 'Settings' property sheet. If these limits are exceeded by the set of files and 
directories that have been selected for a delete task, an further notification appears before the task 
executes.

3.) If a Security Check Occurs

If one of the situations that can cause a security check occurs, a notification appears which provides 
some information about the file or the directory in question and you can choose one of the following 
actions:

- Yes... The actual file (or the directory) is worked on and the task continues.

- No... The actual file (or the directory) is omitted and the task continues.

- Always (available when copying only)... The actual file is overwritten. The copy task continues and 
there will be no more notifications before overwriting files. Further files will be overwritten automatically.

- Never (available when copying only)...The actual file is not overwritten. The copy task continues and 
there will be no more notifications of identical files. Identical files will not be overwritten on principle.

- All... All files are worked on. The task continues and there will be no more notifications of the same type.

- Cancel... The task is aborted.





- Numbering the Disk Images

If you enable the 'Number the disk images' feature for one of the file commands mentioned below and 
enter a disk image as the source or the target directory, the filename of the disk image is numbered 
automatically if more than one disk image is needed.

The 'Number the disk images' feature is available for the following commands:

- Copying and moving files and directories
- Copying Floppy Disks
- Disk Images (When writing disk images as well as when creating them)
- Creating Multi-Volume ZIP Archives
- Restoring Multi-Volume ZIP Archives



III. File-Management
- Drag-and-Drop: Files and Directories

You can use the following file and directory items as sources for drag-and-drop:

1.) Entries (files and directories) in the tree pane or in the folder pane of display windows.

2.) Filenames or directory names in the title bar of display windows, text editor windows or file viewer 
windows.

3.) File or folder items from other applications or from the Windows® desktop.

To drag a file or directory item out of a T.N.T. window, move the mouse pointer over the filename or the 
directory name. Press the right mouse button and keep the button pressed. Move the mouse pointer over 
the target item and release the mouse button to drop the file or the directory. To drag a number of files or 
directories out of a display window, drag one of the selected entries.

You can drop files and directories onto the following items:

- Onto a file or a directory in a display window... A dialog box appears in which you can set the options
and parameters for copying and moving files and directories. The dragged file or directory is preset as the
source for the copy task. The target is determined according to the following rules:

1.) If you drop the file or the directory onto a directory, the directory is used.

2.) If you drop the file or the directory onto an archive file that has a default archive file extension ('.ZIP', 
'.RAR', '.LHA', '.LZH', '.LZS', '.ARJ', '.TAR', '.GZ', '.TGZ', '.VCP' or '.TNT'), the archive is used as the target 
for the compression of the source file(s). (See also 'Archives'.)

3.) If you drop the file or the directory onto a file that does not have one of the extensions named above or
in the area below the last entry in the folder section, the current directory of the window is used.

4.) If you drop the file or the directory onto a file in a multi-folder display or in a search-result display, the 
directory of the file is used. If you drop the file or the directory below the last entry, the root directory of the
window is used.

- Onto the non-client area (title bar, menu bar, status bar or border) of a display window... 
Depending on the type of the item you drop, the following situations are distinguished:

1.) You drop a directory: The contents of the directory are shown in the target window.

2.) You drop a file: The file is considered to be an archive file and the contents of the archive are shown in
the target window. (See also: 'Archives'.)

3.) You drop a selected entry from a display window on one of the status bars of the target window: The 
File Pattern dialog box appears and the dragged files are added to the list of including patterns. 
Directories are ignored. You can use the dialog box to select or deselect entries.

- Onto drive icons (in the taskbar or in the drive bar of the control window) or on the drive register 
of a display window... A dialog box appears in which you can set the options and parameters for copying
and moving files and directories. The dragged file or directory is preset as the source and the drive is 
used as the target for the copy task.

- Onto an edit control... The path of the file or the directory is transferred to the edit control.



- Onto any other program or application that accepts file or directory items via drag-and-drop... 
The file or directory name is passed to the application.

- Onto the Windows® desktop... A context menu appears containing options to move, copy or create a 
shortcut.

- Onto a command template in the 'Command Templates' dialog box... The dialog box appears in 
which you can set the options for the corresponding command and the path of the file or the directory is 
preset as the source for the command.

- Onto a command icon in the taskbar or in the command bar of the control window... The 
command is executed or the dialog box for setting the options of the command appears and the name of 
the file or the directory is passed to the command as a parameter.

- Onto the 'Commands' pane of the 'Menus' dialog box or onto a folder or behind the last icon in 
the command bar of the control window... If you drop a directory or an archive file, you can create a 
new command for displaying the contents of the directory or the archive. If you drop a normal file, you can
create a command for opening or executing the file. (See also: Importing Commands.)

- Onto the client area of a text editor window... The name of the file or the directory is inserted at the 
current position of the mouse pointer. If you drop a selected entry out of a display window, a list of the 
selected entries is inserted.

- Onto the non-client area (title bar, menu bar, status bar or border) of a text editor window (files 
only)... The file is loaded in the text editor.

- Onto a file viewer window (files only)... The file is displayed in the file viewer.

- Onto a list of filename patterns on the 'Filenames' page of the File Pattern property sheet... If you 
drop a single file, the filename is inserted in the list of patterns. If you drop a selected entry out of a 
display window, all the selected entries in the window are inserted in the list. Directories are ignored.
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III.1. Copying and moving files and directories

You can initiate a command to copy or move files and directories by drag-and-drop as well as via the 
context menu of the entries that are to be copied. To copy a single file or a directory, click the 
corresponding entry in a display window with the right mouse button and choose 'Copy to' from the 
context menu or drag the entry by using the right mouse button and drop it onto the target directory.
To copy a number of files or directories, select the desired entries by using the left mouse button. Click 
one of the selected entries with the right mouse button and choose 'Copy to' from the context menu or 
drag one of the selected entries by using the right mouse button and drop it onto the target directory.
If you start the copy command by using the 'Copy to' option, a browse dialog box appears and you can 
choose the target directory. (See also: Browsing through the Directory Hierarchy.) In the case of drag-
and-drop, the drop target specifies the target directory and the dialog box for setting the options and 
parameters for the copy task appears immediately.

The following features and parameters are available for copying and moving:

- Entering More than One Source for a Copy Task
- Rename Patterns
- File Attributes and Patterns of Attributes
- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Reconstruct a Part of the Source Path
- All Files to One Directory
- Security Checks and Confirmations
- Numbering the Disk Images
- Do Not Overwrite Newer Files



- Omit files that cannot be opened

Note: Within 'The Next Tool', compressing files and directories is also done by means of a copy 
command. If you enter the path of an archive file or a disk image as the target directory, the source files 
and directories are packed into the corresponding archive. Archive files that do not exist already (as well 
as any necessary subdirectories) are created automatically. (See also: Compressing Files and 
Directories.)
The same is valid for the extraction of archives. If you enter the path of an archive file or a disk image with
a colon ':' at the end as the source path, the contents of the archive are automatically extracted to the 
target directory automatically. (See also: Extracting Files from Archives.)

To start the copy process, press the 'Copy' and the 'Move' button on the lower margin of the dialog box 
respectively. While the copy task executes, the path of the current source and target files as well as the 
progress of the process are shown in the task window.

By means of the 'Pause/Continue' and the 'Cancel' buttons, you can interrupt/continue and cancel the 
process, respectively. While the copy task executes, the following situations, which require some action, 
may occur:

- Insufficient Space on the Target Data Carrier
- Changing the Target Directory or the Data Carrier
- Error Notifications During a Copy Task
- Security Checks and Confirmations
- Removing Incomplete Target Files

Notes:

1.) Moving when Compressing

Warning! Please note that if you move files into an archive and an error occurs while writing the archive 
file (e.g. because of a faulty data carrier) all source files that have been handled up to this moment may 
be lost if it is impossible to close the archive correctly.
When moving files, the source file is removed as soon as the target file has been written. However, if you 
move files into an archive, an error that occurs later on, when the archive file itself is actually written, may 
cause the loss of files that have been compressed earlier.
If you want to move files into an archive, it is safer to copy or (to be precise) compress the files first and 
remove the source files explicitly by using a delete command when the archive has been written 
completely and all drive access has been finished.

2.) Removing Directories when Moving

When moving files and directories, please note: If you start a copy task by pressing the 'Move' button, the 
source files are moved to the target directory. Source directories are removed if all contained files are 



moved. The exception is that directories are not removed if the source files have been selected in a multi-
folder display.



- Insufficient Space on the Target Data Carrier

If it is possible to determine with complete certainty that there is insufficient space on the target data 
carrier when copying and moving files and directories, a notification appears before the task executes. 
Then you can choose whether or not to start the process nevertheless. If you start the process, another 
notification appears as soon as the data carrier is full and you can change the target directory or the data 
carrier. (See also: Changing the Target Directory or the Data Carrier.)

Note: To copy a large number of files to several floppy disks, just select all the files and start the copy 
task. When the corresponding notification appears, change the data carrier. It is not necessary to portion 
the files.



- Changing the Target Directory or the Data Carrier

When copying and moving files and directories, you can change the target directory or the data carrier if 
an error occurs or when the capacity of the actual data carrier is exceeded. If the 'New Target' dialog box 
appears you can enter a new path in the 'Target path' edit control if desired, or change the data carrier of 
the target drive. To continue the copy task, press the 'OK' button. To abort the process, press the 'Cancel' 
button. 

 



- Error Notifications During a Copy Task

If an error occurs while copying and moving files and directories, first a notification appears that describes
the error. Warning! Don't remove the data carrier now if copying to floppy disks. If you change the data 
carrier, an incomplete target file cannot be removed.
Afterwards, another notification appears and you can retry to copy the actual file, change the target 
directory or data carrier or abort the whole process. (See also: Changing the Target Directory or the Data 
Carrier.)



- Removing Incomplete Target Files

If a copy task is aborted because of an error or because you press the 'Cancel' button, the current target 
file is automatically removed if it is incomplete and the Copy: Delete Faulty Target Files check box on the 
'Commands' page of the 'Settings' property sheet is checked. If 'Delete faulty target files' is disabled, a 
notification appears and you can choose whether or not to remove the file.



III.1. Copying and moving files and directories
- Entering More than One Source for a Copy Task

When copying and moving files and directories (in contrast to other file commands) you can enter more 
than one source. If you do so, the sources are worked on one after the other. The sources have to be 
separated by a pipe symbol '|'. Multi-sources are automatically used in the following situations:

- If you drag more than one item from the Windows® desktop and use them as a source:

For instance: C:\Windows\Desktop\File1.lnk | C:\Windows\Desktops\File2.lnk

- If you select a number of archives in a display window and use them to start a copy task, you can 
choose whether the archive files themselves are to be copied as ordinary files or their contents are to be 
extracted. If several archives are to be extracted, all the archive files, each one with a colon ':' at the end 
of the filename, must be entered in the 'Source' edit control.

For instance: D:\DATA\ARCHIV1.ZIP: | D:\DATA\ARCHIV2.ZIP:

Note: You can disable the notification that asks whether you want to copy or extract the archives on the 
'Commands' page of the 'Settings' property sheet.



III.1. Copying and moving files and directories
- Rename Patterns

When renaming files and directories  as well as when copying and moving files and directories you can 
enter a rename pattern. If all files are to be renamed automatically, enter a filename pattern which 
describes the new filename(s) in the 'Rename pattern' edit control.

Note: Please notice that several filenames may be transformed to the same name by the rename pattern. 
As filenames have to be unique within a directory, therefore the task possibly cannot be performed 
completely. In this case, a notification appears and the process is aborted.

For example:

1.) Rename Pattern '*.OLD'

Source files

TNT.COM
INSTALL.COM
OVL.EXE

Files resulting from the command

TNT.OLD
INSTALL.OLD
OVL.OLD

Note: If there was also a file named 'TNT.INI' in the source directory, in the case of a copy task, a 
notification would appear saying that 'TNT.COM' and 'TNT.INI' cannot both be copied to 'TNT.OLD' and 
the whole task would be rejected. In the case of a rename task, you would be asked to enter a new 
filename or a new rename pattern as soon as the corresponding file is on the agenda.

2.) Rename Pattern 'ABC*.??T'

'ABC' replaces the first three characters of each filename. The rest of the filename remains the same. The
first two characters of the file extension are kept and a 'T' replaces the last character. If the extension is 
less than three characters, the corresponding number of spaces is inserted in front of the 'T'.

Source files

README
README.1
README.12
INSTALL.COM
TNT.IMG
TNT.INI

Files resulting from the command

ABCDME.        T
ABCDME.1    T
ABCDME.12T
ABCTALL.COT
ABC.IMT



ABC.INT



III.1. Copying and moving files and directories
- Reconstruct a Part of the Source Path

If you enable the 'Reconstruct a part of the source path' feature when copying and moving files and 
directories you can create any part of the source path in the target directory. When starting the task, the 
'Part of the Path' dialog box appears, showing all the subdirectories that form the source path. By clicking 
an entry of the list with the left mouse button, you can choose the part of the path that is to be 
reconstructed in the target directory.

For example:

Supposing the following directory hierarchy:

C: (DIR)
TEMP (DIR)

SYSTEM (DIR)
BATCH (DIR)

DATA (DIR)
INVOICE.DOC (FILE)
TEST.TXT (FILE)

BACKUP.BAT (FILE)
TNT.BAT (FILE)

Let 'C:\TEMP\SYSTEM\BATCH' be the source directory for a copy task and 'D:\BACKUP' the target. 
Consequently the 'Part of the Path' dialog box appears with the following list of entries if 'Reconstruct a 
part of the source path' is enabled:

\TEMP
 \SYSTEM
    \BATCH
      \

1.) Choosing an Entry Above the Source Directory

If you choose '\SYSTEM', first a subdirectory 'SYSTEM' is created in the target directory 'D:\BACKUP'. 
Then another subdirectory 'BATCH' is created in the 'SYSTEM' directory. Finally, the files and directories 
are copied to this directory. The following directory hierarchy results:

D: (DIR)
BACKUP (DIR)

SYSTEM (DIR)
BATCH (DIR)

DATA (DIR)
INVOICE.DOC (FILE)
TEST.TXT (FILE)

BACKUP.BAT (FILE)
TNT.BAT (FILE)

2.) Choosing the Contents of the Source Directory

If you choose the last entry of the list, which is always only a backslash '\', the contents of the source 
directory are directly copied to the target directory. The result is the same as if the Use the contents 
instead of the directory feature would have been enabled for the copy task. The resulting directory 
hierarchy for the data described above would be:



D: (DIR)
BACKUP (DIR)

DATA (DIR)
INVOICE.DOC (FILE)
TEST.TXT (FILE)

BACKUP.BAT (FILE)
TNT.BAT (FILE)

Note: If 'Reconstruct a part of the source path' is enabled, the Use the Contents Instead of the Directory 
feature is implied when moving files. In this case, the source directory is not removed anyway.



III.1. Copying and moving files and directories
- All Files to One Directory

If you enable the 'All files to one directory' feature when copying and moving files and directories, the files 
from all (sub) directories are gathered and copied directly to the target directory. No subdirectories will be 
created.

For example:

Supposing the following directory hierarchy:

C: (DIR)
DOS (DIR)

BATCH (DIR)
TNT.BAT (FILE)
BACKUP.BAT (FILE)

DRIVER (DIR)
VGA800.SYS (FILE)
PEN.COM (FILE)

EDIT.COM (FILE)
QBASIC.EXE (FILE)

Let 'C:\DOS' be the source for a copy task and 'D:\TEMP' the target directory. Consequently the following 
directory hierarchy is created on drive 'D:' if 'All files to one directory' is enabled:

D: (DIR)
TEMP (DIR)

BACKUP.BAT (FILE)
EDIT.COM (FILE)
PEN.COM (FILE)
QBASIC.EXE (FILE)
TNT.BAT (FILE)
VGA800.SYS (FILE)

Note: If several files that have the same filename would be copied to the same directory as a result of the 
'All files to one directory' feature, the task is rejected and a corresponding notification appears.



- Do Not Overwrite Newer Files

If you enable the 'Do not overwrite newer files' feature when copying and moving files and directories, 
files that already exist in the target directory are not overwritten if they have a date of last modification that
is more recent than the corresponding date of the source file. 

Note: If there are two files that have the same date of last modification but a different file size, a 
notification appears and you can choose whether to overwrite the file or not. If the two files also have the 
same size, the target file is not overwritten anyway.



- Omit files that cannot be opened

If you enable the 'Omit files that cannot be opened' feature whenn copying and moving files and 
directories, no error message is shown in case a source file cannot be opened. The file is omitted 
automatically.

Note: Other error messages that don't arise from an open error of a source file are still shown.
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III.2. Deleting Files and Directories

To delete a file or a directory, click the corresponding entry in a display window with the right mouse 
button and choose 'Delete' from the context menu. To delete a number of files and directories, select the 
desired entries by using the left mouse button, click one of the selected entries with the right mouse 
button and choose 'Delete' from the context menu. Then a dialog box appears in which you can set the 
options and parameters for the delete task.

The following features and parameters are available for deleting:

- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Security Checks and Confirmations
- Deleting: Use Recycle Bin

To start the task, press the 'Delete' button. While the task is being executed, the path of the current file 
and the progress of the process are shown in the corresponding task window.

By means of the 'Pause/Continue' and the 'Cancel' buttons you can pause and continue or abort the 
process.
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III.3. Renaming Files and Directories

To rename a file or a directory, click the corresponding entry in a display window with the right mouse 
button and choose 'Rename' from the context menu. To rename a number of files and directories, select 
the desired entries by using the left mouse button, click one of the selected entries with the right mouse 
button and choose 'Rename' from the context menu. Then a dialog box appears in which you can set the 
options and parameters for the rename task.

The following features and parameters are available for renaming:

- Rename Patterns
- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Include Files within Directories
- Create Short 8.3 DOS Filenames
- Automatic Treatment of All Entries

To start the task, press the 'Rename' button. While the task is being executed, the path of the current file 
and the progress of the process are displayed in the corresponding task window.

If automatic treatment of all entries is not enabled the files and directories are processed one after the 
other and you can enter a new name or a (new) rename pattern for each entry. (Note: If a pattern is 
currently in use, the new name for the current entry, which results from the pattern, is displayed in the 
'New Name' edit control.) By means of the 'Rename' and the 'All' button you can rename the current entry 
or all remaining entries respectively. To skip the current entry, press the 'Skip' button, or press 'Cancel' to 
abort the whole task.





III.3. Renaming Files and Directories
- Include Files within Directories

If you enable the 'Include files within directories' feature for a file command, files within directories are 
worked on instead of the directories themselves. The feature is available for renaming files and directories
as well as for modifying the attributes of files and directories.

For example:

Supposing the following directory hierarchy:

C: (DIR)
BATCH (DIR)

BACKUP.BAT (FILE)
TNT.BAT (FILE)

DOS (DIR)
EDIT.COM (FILE)
FORMAT.COM (FILE)

AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

1.) 'Include files within directories' is disabled

If you enter 'C:' as the source directory for modifying the attributes of files and directories and disable 
'Include files within directories', the attributes of the following entries are modified:

BATCH (DIR)
DOS (DIR)
AUTOEXEC.BAT (FILE)
COMMAND.COM (FILE)

2.) 'Include files within directories' is enabled

If you enter 'C:' as the source directory for modifying the attributes of files and directories and enable, 
'Include files within directories', the attributes of the following entries are modified:

BACKUP.BAT (FILE in 'BATCH')
TNT.BAT (FILE in 'BATCH')
EDIT.COM (FILE in 'DOS')
FORMAT.COM (FILE in 'DOS')
AUTOEXEC.BAT (FILE in 'C:')
COMMAND.COM (FILE in 'C:')



- Create Short 8.3 DOS Filenames

If you check the 'Create short 8.3 DOS filenames' check box when renaming files and directories, new 
filenames that match the filename conventions of the previous DOS versions are automatically created 
from the original names of the source files and directories. That means that all characters are converted 
to upper case, the filename consists of up to 8 characters and the extension of up to 3 characters. (Note: 
You don't have to enable this feature to create numbered short names with a tilde '~'. These short names 
are created and determined by the operating system automatically, if necessary. The 'Create short 8.3 
DOS filenames' feature transfers the real filename to the 8.3 format.)



- Automatic Treatment of All Entries

If you enable the 'Automatic treatment of all entries' feature for a file command, all entries (files and 
directories) are processed according to the data (e.g. a rename pattern or a pattern of attributes) that is 
entered before the process is started. If you disable the feature, you can enter new data or parameters for
each entry. The feature is available for the following commands:

- Renaming Files and Directories
- Modifying the Attributes of Files and Directories
- Modifying the Date and the Time of Files
- Printing Files and Texts
- Creating Shortcuts
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III.4. Modifying the Attributes of Files and Directories

To modify the attributes of a file or a directory, click the corresponding entry in a display window with the 
right mouse button and choose 'Attributes' from the 'Further Commands' submenu of the context menu. 
To modify the attributes of a number of files or directories, select the desired entries by using the left 
mouse button, click one of the selected entries with the right mouse button and choose 'Attributes' from 
the 'Further Commands' submenu of the context menu. Then a dialog box appears in which you can set 
the options and parameters for the task.

The following options are available for modifying the attributes:

- File Attributes and Patterns of Attributes
- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Include Files within Directories
- Automatic Treatment of All Entries

To start the task, press the 'Modify' button. While the task is being executed, the path and the attributes of
the current entry as well as the progress of the process are displayed in the task window.

If automatic treatment of all entries is not enabled the files and directories are processed one after the 
other and you can enter a (new) pattern of attributes for each entry. By means of the 'Modify' and the 'All' 
button you can modify the attributes of the current entry or of all remaining entries respectively. To skip 
the current entry, press the 'Skip' button, or press 'Cancel' to abort the whole task.
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III.5. Modifying the Date and the Time of Files

To modify the date and the time of the last modification, the creation or the last access of a file, click the 
corresponding entry in a display window with the right mouse button and choose 'Date and Time' from the
'Further Commands' submenu of the context menu. To modify the date and the time of a number of files, 
select the desired entries by using the left mouse button, click one of the selected entries with the right 
mouse button and choose 'Date and Time' from the 'Further Commands' submenu of the context menu. 
Then a dialog box appears in which you can set the options and parameters for the task.

Note: Modifying the date of directories is not possible under MS-DOS® and Windows®. If you enter a 
directory as the source for modifying the date and the time, the files within the directory are processed 
automatically.

The following options are available for modifying the date and the time:

- File Dates and Time Ranges
- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Automatic Treatment of All Entries

To start the task, press the 'Modify' button. While the task is being executed, the path and the date 
information of the current file as well as the progress of the process are displayed in the task window.



If automatic treatment of all entries is not enabled, the files are processed one after the other and you can
enter new date information for each entry. By means of the 'Modify' and the 'All' button you can modify the
dates of the current file or of all remaining files respectively. To skip the current file, press the 'Skip' button,
or press 'Cancel' to abort the whole task.
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III.6. Comparing Files and Directories

By means of a compare command you can deal with the following tasks, depending on the source and 
target files or directories respectively:

- Comparing two files... If you name a file as the source and as the target for the task, both files are 
compared according to the desired criteria.

- Searching for identical files... If you name a file as the source and a directory as the target for the 
task, the directory (including all its subdirectories) is searched for files that are identical to the source file 
according to the desired criteria. (Note: It is not required that the two files have the same filename 
anyway.)

- Comparing two directories... If you name a directory as the source and as the target, the files and the 
subdirectories within the directories are compared. First, all files must have the same name. Second, the 
files are compared according to the desired criteria. All subdirectories are handled recursively in exactly 
the same way.

To select a file or a directory as the source for a compare task, click the corresponding entry in a display 
window with the right mouse button and choose 'Compare' from the 'Further Commands' submenu of the 
context menu. To select a number of files and directories for a compare task, select the desired entries by
using the left mouse button, click one of the selected entries with the right mouse button and choose 
'Compare' from the 'Further Commands' submenu of the context menu. Then a dialog box appears by 
means of which you can browse for the target directory. (See also: Browsing Through the Directory 
Hierarchy.) After that, the dialog box appears in which you set the options and parameters for the 
compare task.

The following options are available for compare tasks in general:

- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern

To determine the identity of two files, you can specify which of the following criteria are to be taken into 



account:

- Same contents of the files
- Same date of last modification
- Same date of creation
- Same date of last access
- Same file attributes

To start the task, press the compare button. While the task is being executed, the names of the files that 
are currently compared as well as their properties are displayed in the task window.

By means of the 'Pause/Continue' and the 'Cancel' buttons you can pause and continue or cancel the 
task. As soon as a difference between two files is determined, the names and the properties of the files 
are displayed and the task is paused. (Of course, when searching for identical files, identical files are 
displayed.) By pressing the 'Viewer' button you can open two file viewer windows to display the contents 
of the files. If a file is missing in one directory while two directories are compared, an appropriate 
message is displayed. To continue the compare process with the next two files, press the 'Continue' 
button.
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III.7. Printing Files and Texts

By means of a print command you can print text files as well as texts and selected areas from a text editor
window, a file viewer window or a display window. To open the dialog box to set the options and 
parameters for a print task, proceed as follows:

- In the text editor... To print the whole text, choose 'Print' from the 'File' menu. To print the selected part 
of the text, choose 'Print' from the 'Edit' menu.

- In the file viewer... To print the display of the whole file, choose 'Print' from the 'File' menu. To print the 
selected part of the display of the file, choose 'Print' from the 'Edit' menu.

- In a display window... To print a list of the entries in the folder pane of the 'display window', choose 
'Print' from the 'Edit' menu. If some entries are selected in the folder pane, a list of the selected entries is 
printed, otherwise a list of all entries.

- In a display window... To print a list of the entries in the folder pane of a tree/folder display, choose 
'Print' from the 'Folder Pane' submenu of the 'Edit' menu. To print the contents of a folder display, multi-
folder display or search-result display, choose 'Print' from the 'Edit' menu. If some entries are selected in 
the folder pane, a list of the selected entries is printed, otherwise a list of all entries.
To print the representation of the directory hierarchy that is shown in the tree pane of a tree/folder display,
choose 'Print' from the 'Tree Pane' submenu of the 'Edit' menu. To print the directory hierarchy that is 
shown in a tree display, choose 'Print' from the 'Edit' menu.

- Printing files... To print a single file, click the corresponding entry in a display window with the right 
mouse button and choose 'Print' from the 'Further Commands' submenu of the context menu. To print a 
number of files, select the desired entries by using the left mouse button, click one of the selected entries 
with the right mouse button and choose 'Print' from the 'Further Commands' submenu of the context 
menu. 



When printing files, the following options are available. (When printing a text from the editor or the file 
viewer, the corresponding part of the dialog box is omitted.)

- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern
- Automatic Treatment of All Entries

The parameters for the print task can be set by means of the following controls:

- Lines/Page
- Gap/Page
- Spaces/Tab Stop
- Timeout in Sec.
- Port LPT1, LPT2, LPT3 or print manager
- Form Feed
- Insert Gap
- Paper Requests

To start the print task, press the 'Print' button. If a text is to be printed, the printing process begins 
immediately. When printing files, the path of the current file and the progress of the process are displayed 
in the task window.
If automatic Treatment of All Entries is not enabled, the files are processed one after the other. By 
pressing the 'Print' button you can start the print process for the next file. If you press the 'All' button, all 
remaining files are printed continuously, interrupted only by requests for new paper, if necessary. Press 
the 'Skip' button to skip the current file, or press 'Cancel' to abort the whole process.





- Lines/Page

When printing files and texts, you can set how many lines are printed per page before the gap (See 
Gap/Page.) is inserted and a form feed is executed by means of the 'Lines/Page' scroll bar.



- Gap/Page

When printing files and texts, you can set how many line feeds are executed at the end of a page if insert 
gap is enabled by means of the 'Gap/Space' scroll bar. 



- Spaces/Tab Stop

When printing files and texts, you set the distance between the tab stop positions by means of the 
'Spaces/Tab Stop' scroll bar. If the text that is printed contains tab characters, spaces are inserted up to 
the next tab stop position for each tab character.



- Timeout in Sec.

When printing files and texts you can choose the number of seconds that have to pass before a timeout 
notification appears if the printer does not react anymore, by means of the 'Timeout in Sec.' scroll bar.

Note: The timeout setting is ignored when printing via the print manager. If you print though one of the 
ports, LPT1, LPT2 or LPT3, directly, notice not to set the timeout too low. The printer also may not be 
accessible for a certain period of time because the printer buffer is full. In this case a notification is not 
wanted as the print process can be continued as soon as there is enough space in the buffer.



- Port LPT1, LPT2, LPT3 or print manager

When printing files and texts, you can use the four check boxes, 'LPT1', 'LPT2', 'LPT3' and 'Print 
manager', to choose whether you want to print via the Windows® print manager or directly through one of
the printer ports. (Note: If there is no reason to print through a printer port directly, you should use the 
print manager.)



- Form Feed

When printing files and texts, check the 'Form Feed' check box if a form feed is to be executed at the end 
of each page. (Note: You can set the size of a page by means of the Lines/Page and the Gap/Page scroll 
bars.)



- Insert Gap

If 'insert gap' is enabled when printing files and texts, a gap is inserted at the end of each page. You can 
set the number of line feeds that are inserted by using the 'Gap/Page' scroll bar.



- Paper Requests

When printing files and texts you can choose whether or not a request for a new sheet of paper is to be 
displayed for each page, by using the 'Yes' and the 'No' check boxes.
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III.8. The Multi-File Viewer

To open a multi-file viewer (i.e. you are able to switch dynamically between a number of displayed files) 
select the desired entries in a display window by using the left mouse button, click one of the selected 
entries with the right mouse button and choose 'Viewer' from the context menu. Then a dialog box 
appears in which you can set the options for the selection of the files that are to be displayed. 

The following options are available for the start of the multi-file viewer:

- Ignore Subdirectories
- Use the Contents Instead of the Directory
- Apply the File Pattern

To open the multi-file viewer, press the 'Viewer' button. (See also: The File Viewer and Switching the Files
when Using the Multi-File Viewer.)
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III.9. Creating Shortcuts

A shortcut is a reference to a file or a directory that can be used like the original item itself when 
executing, opening or viewing. For instance, if there is a shortcut of a text document on the desktop, you 
can open and work on the document by double-clicking the shortcut. If a shortcut of an application is 
created in the start menu, you can execute the corresponding program, which may be in any directory, by 
choosing the shortcut.

Note: If you look at the icons on the desktop, shortcuts and 'real' documents or applications are 
distinguished by a small black arrow in the lower left-hand corner of the icon. On the file level, files that 
are shortcuts to other items can be identified by the extensions '.lnk' and '.pif'.

To create a shortcut to a single file, click the corresponding entry in a display window with the right mouse
button and choose 'Create Shortcut(s)' from the 'Further Commands' submenu of the context menu. To 
create shortcuts to a number of files and directories, select the desired entries in a 'display window' by 
using the left mouse button, click one of the selected entries with the right mouse button and choose 
'Shortcut(s)' from the 'Create' submenu of the context menu. Then a dialog box appears in which you can 
set the options and parameters for the creation of shortcuts.
To create a shortcut in a certain directory, click the desired directory in a display window with the right 
mouse button and choose 'Shortcut(s)' from the 'Create' submenu of the context menu. Then a dialog box
appears by means of which you can browse for the item you want to create the shortcut for. (See also: 
Browsing Through the Directory Hierarchy.) After that, the dialog box appears in which you set the options
and parameters for the creation of shortcuts.

The upper part of the dialog box contains a tree structure that shows the menu hierarchy of the start 
menu or the directory hierarchy of the desktop or of any other target directory you choose. By means of 
the 'Ancestors' menu, you can change the root directory of the tree.
Essentially, the tree structure in the 'Shortcuts' dialog box corresponds to the tree pane of a display 
window, as far as the handling and the functionality is concerned. However, the current entry of the tree 
(that is the branch, where the cursor is located) is automatically transferred to the 'Target directory' edit 
control for the creation of the shortcuts.
In the 'Parameter' edit control you can enter an arbitrary string that you want to be attached to the path of 



the shortcut. For instance, when creating shortcuts for executable files, you can enter parameters that are
to be passed to the programs. 

To begin with the creation of the shortcuts, press the 'Create' button. While the task is being executed, the
path of the current source item (the file or the directory) as well as a suggestion for the name of the 
current shortcut are shown in the task window.

If automatic treatment of all entries is not enabled, the shortcuts are created one after the other and you 
can modify the name of the current shortcut in the 'Name' edit control and enter an arbitrary string in the 
'Parameter' edit control that is attached to the path of the shortcut. For instance, when creating a shortcut 
for an executable file, you can enter a parameter that is to be passed to the program. 
Press the 'Create' button to create a shortcut with the current parameters. Press the 'All' button to create 
all the remaining shortcuts with the predefined parameters. To skip a shortcut, press the 'Skip' button, or 
press 'Cancel' to abort the whole process.



IV. Disk Management

IV.1. Formatting Floppy Disks
IV.2. Copying Floppy Disks
IV.3. Disk Images



IV. Disk Management
IV.1. Formatting Floppy Disks

To format a floppy disk, click the corresponding drive icon in the taskbar or in the control window with the 
right mouse button and choose 'Format' from the 'Commands' submenu of the context menu.

1.) Options and Parameters

- The Label... In the 'Label' edit control, you can enter a label of 11 characters for the floppy disk that is to
be formatted.

- Choosing a drive... Check the 'Drive A:' or the 'Drive B:' check box to select the corresponding drive.

- Choosing the capacity of the disk... Check one of the 'Capacity' check boxes to set the format of the 
floppy disk that is to be formatted. The following formats are available:

3.5 inch floppy disks with

720 KB, 1440 KB or 1680 KB (DMF format)

5.25 inch floppy disks with

360 KB, 1200 KB or 1440 KB

- Quick format... Check the 'Quick format' check box if only the FAT (File Allocation Table) and the root 
directory of the floppy disk are to be erased and the disk is not to be formatted completely. It is sufficient 
to erase the FAT in order to clear a disk if the disk was formatted completely once in the past.

- Verifying... If you want the disk to be verified after writing, check the 'Verify' check box.

2.) Please Note the Following Hints

- If 'Less Notifications' is enabled in the settings, the format process begins immediately, as soon as you 
press the 'Format' button at the lower left border of the dialog box. At this moment all data on the floppy 
disk in the selected drive is lost.



- If a floppy disk cannot be formatted completely because of a faulty data carrier, the format process is 
cancelled. Faulty sectors will not be excluded or be marked particularly. Consequently the disk also 
cannot be used with a reduced capacity, although in principle it is not forbidden under DOS. To ensure a 
high level of security for your data, you should not use floppy disks any more that once produced an error.



IV. Disk Management
IV.2. Copying Floppy Disks

To copy a floppy disk, click the corresponding drive icon in the taskbar or in the control window with the 
right mouse button and choose 'Disk Copy' from the 'Commands' submenu of the context menu. The 
following disk formats are supported:

3.5 inch floppy disks with

720 KB, 1440 KB or 1680 KB (DMF format)

5.25 inch floppy disks with

360 KB, 1200 KB or 1440 KB

1.) Options and Parameters

- Using a disk image... In the 'Disk Image' edit control, you can enter the path of the disk image which 
can be used as a buffer during the copy process, can be created of the source disk or can be written to 
the target disk. Note: If the disk image serves as a temporary buffer only and is to be removed after the 
copy process, uncheck the 'Maintain disk image' check box. (See also: Disk Images.)

- Choosing a drive... Check the 'Drive A:' or the 'Drive B:' check box to select the corresponding drive in 
order to copy a disk, create or write a disk image.

- Using a memory buffer... Check the 'Use a memory buffer' check box to use a buffer in main memory 
instead of a temporary disk image during the copy process.

- Creating a disk image... Check the 'Create disk image' check box to create a disk image of the source 
disk. (See also: Disk Images.)

- Writing a disk image... Check the 'Write disk image' check box to write a disk image to the target disk. 



(See also: Disk Images.)

- Maintaining the disk image... If a disk image that was used for writing the target disk is not to be 
deleted after the copy process, check the 'Maintain disk image' check box.

- Formatting the target disk... If you want to format the target disk before writing the data, check the 
'Format target disk' check box.

- Verifying... If you want the disk to be verified after writing, check the 'Verify' check box.

- Comparing... If you don't want to copy a disk or write a disk image but you do want to compare the 
source and the target data, check the 'Compare' check box. To compare two floppy disks, also check the 
'Use a memory buffer' check box. To compare the contents of a disk image with the target disk, uncheck 
the 'Create disk image' check box and check both, the 'Maintain disk image' and the 'Write disk image' 
boxes.

- Numbering the disk images... If you want to work on (create or write) several disk images in order and 
the disk images are to be numbered automatically, check the 'Number the disk images' check box.

- Appending the '.TNT' extension... Press the '.TNT' button to append the extension '.TNT' to the 
filename of the disk image.

2.) Please Note the Following Hints

- If 'Less Notifications' is enabled in the settings, the writing of a disk image begins immediately, as soon 
as you press the 'Write' button at the lower left border of the dialog box. At this moment all data on the 
floppy disk in the selected drive is lost.

- If an error occurs while reading or writing a disk, you can choose whether to try to read (or write) the 
current track again or to cancel the whole process. If you choose 'Cancel', T.N.T. tries to determine which 
sector exactly was the cause of the error. Therefore each sector of the current track is read (or written) 
individually. If it is possible to deal with all sectors without any mistakes now, the task continues with the 
next track, although 'Cancel' was chosen.



IV. Disk Management
IV.3. Disk Images

A disk image is an identical reproduction of a floppy disk on another data carrier. You can use disk images
to backup floppy disks that already exist as well as to create templates for disks you want to write in the 
future. Unlike compressed archives, each disk image has a static capacity that corresponds to the format 
of the floppy disk that is represented by the disk image. Within T.N.T., you can access the contents of a 
disk image with all file commands as if it were an additional, virtual disk drive. Disk images with the 
extension '.TNT' or '.VCP' appear in the tree pane of display windows like normal directories. Disk images
are supported for the following formats:

3.5 inch floppy disks with

720 KB, 1440 KB or 1680 KB (DMF format)

5.25 inch floppy disks with

360 KB, 1200 KB or 1440 KB

1.) Creating Disk Images

There are two ways to create a new disk image:

- First: The explicit way... That means you create a disk image as a reproduction of an already existing 
floppy disk already existing. To do so, execute a disk copy command and check the 'Create disk image' 
and the 'Maintain disk image' check boxes in the dialog box in which you can set the parameters for the 
command. Enter the filename of the disk image to be created in the 'Disk image' edit control. (See also: 
Copying Floppy Disks.)

- Second: The implicit way... That means you create and work on a disk image that serves as a 
template for a floppy disk that is to be written in the future. To create the disk image, simply enter the path
of a file with the extension '.TNT' and a colon ':' at the end as the target directory for a file copy command 
or when creating a directory path. (Note: Within T.N.T., the colon ':' at the end of a filename indicates that 
a virtual drive is to be accessed and not a 'normal' directory.) As soon as you execute the command, a 
notification appears asking for the capacity of the disk image. For instance, to copy a number of files into 
a directory named 'DOCUMENTS' that is in a disk image named 'DATA.TNT' on drive 'C:', enter the 
following target directory:

C:\DATA.TNT:\DOCUMENTS

Then a disk image, with a 'DOCUMENTS' directory in it, is created automatically if it does not exist 
already.

2.) Accessing Disk Images with File Commands

Files that have the extension '.TNT' or '.VCP' are automatically regarded as disk images. They appear in 
the directory tree in the tree pane of the display windows and can be used like normal directories with any
file command (copy, delete, etc.). For instance, to delete a directory named 'BACKUP' from a disk image 
named 'OLDDOCS.TNT' on drive 'D:', simply enter the following path as the source directory for the 
delete task:

D:\OLDDOCS.TNT:\BACKUP



Note: If you create disk images that don't have the extension '.TNT' or '.VCP', these file will not appear in 
the tree pane of the display windows. Nevertheless, you can proceed as described above to access the 
contents of the disk image. Simply enter the name of the file with a colon ':' at the end. (Note: Within 
T.N.T., the colon ':' at the end of a filename indicates that a virtual drive is to be accessed and not a 
'normal' directory.) To show the contents of such a disk image, double-click the corresponding file in a 
'display window' with the right mouse button.

3.) Writing the Disk Image to a 'Real' Floppy Disk

To write a disk image to a 'real' disk, execute a disk copy command. Just enter the name of the disk 
image in the 'Disk image' edit control. Check the 'Write disk image' and the 'Maintain disk image' check 
boxes and uncheck the 'Create disk image' box. (See also: Copying Floppy Disks.)

4.) Disk Images that were not Created by T.N.T.

- VCP files... You can access disk images that were created with VGA-COPY directly, as described 
above. (Note: If the disk image is compressed and protected by a password, proceed as follows to enter 
the password: Click the entry of the disk image in the tree pane of a display window once to position the 
cursor of the tree on the file. Then click the free space display at the upper border of the tree pane with 
the right mouse button and choose 'Password' from the context menu. Now you can enter the password. 
Note: Only use capital letters!)

- Disk images of other formats... In general, disk images that were not created by T.N.T. or by VGA-
COPY but by another program cannot be accessed. Warning! Disk images that were created or modified 
by T.N.T. can possibly not be read or used by other programs any more.



V. Archives

Archives are a special kind of files that contain other files or directories in compressed form. If you pack a 
file into an archive, groups of bits and bytes that occur repeatedly are replaced by certain codes 
according to a mathematical algorithm to reduce the space that is needed for the data. In the archive file, 
only the encoded data is saved. During the extraction process the original data, the files and directories, 
are restored. 'The Next Tool' offers integrated support for the following types of archives:

- ZIP... ZIP archives. Default file extension '.ZIP'.
- RAR... RAR archives. Default file extension '.RAR'.
- LHA... LHA archives. Default file extensions '.LHA', '.LZH' and '.LZS'.
- ARJ... ARJ archives. Default file extension '.ARJ'.
- TAR... Uncompressed tape archives. Default file extension '.TAR'.
- GZIP... GNU-ZIP archives. Default file extensions '.GZ'.
- TGZ... Type archives, compressed with the GNU-ZIP method. Default file extension '.TGZ'.

Every file that has one of the file extensions listed above is regarded as an archive and treated as a 
virtual directory automatically. Archives also appear in the directory tree in the tree pane of display 
windows and can be used by all file commands like normal directories. That means you can apply a file 
command to the contents of an archive simply by clicking the desired entries of the archive with the right 
mouse button and choosing the command from the context menu or by using the entries with drag-and-
drop.
The directory path to access the contents of an archive is characterized by a colon ':' at the end of the 
name of the archive. E.g. to delete the directory 'BACKUP' from the ZIP archive 'D:\DATA.ZIP' you would 
have to enter the following source directory for the delete task:

D:\DATA.ZIP:\BACKUP

Note: The colon ':' at the end of a filename serves to identify virtual drives or virtual directories. These can
be archives as well as disk images. In the case of archive files that have one of the file extensions listed 
above, you can also omit the colon ':'. In this case T.N.T. assumes on the basis of the file extension that 
an archive is meant instead of a normal directory. When in doubt, a notification appears automatically.
If you want to use archive files with other extensions, you have to enter the colon ':' at the end of the 
filename anyway to access the archive. If the colon ':' is omitted, the path is assumed to be a directory 
path. To show the contents of an archive file that does not have one of the default extensions, double-
click the file with the right mouse button.

For further information on working on archives with T.N.T., refer to the following chapters:

a) Compressing Files and Directories
b) Extracting Files from Archives
c) Self-Extracting Archives
d) Creating Multi-Volume ZIP Archives
e) Restoring Multi-Volume ZIP Archives

Notes:

- Archives that are provided with a password... Files in ZIP, RAR and ARJ archives can be encoded 
with a password. To extract the files, you have to enter the correct password. (Warning! The encoding of 
the files is not always 100% safe. There are programs, which are easy to obtain, for cracking encoded 
archives. If you want to encode your archives, you should use ZIP archives and long passwords of at 
least 15 characters.)
To enter the password and to choose whether the data is to be encoded when packing the archive, first 
display the contents of the archive in a tree/folder display. Click the free space display at the upper border
of the tree pane with the right mouse button and choose 'Password' from the context menu.



- Features that are not supported... Because of the fact that the archive support is fully integrated in 
T.N.T, you do not need external archive programs for all those features that can be implemented by the 
T.N.T. file commands. However, some features are not available in T.N.T.'s integrated archive support. For
instance:

- Solid RAR archives can only be read but not be modified.
 
- Multi-volume archives (archives that extend over several disks) are only supported in the ZIP format. 
See also: Creating Multi-Volume ZIP Archives and Restoring Multi-Volume ZIP Archives.

- For ZIP archives, it is possible to check whether the contents of the file were modified if a certain string, 
a so-called 'authenticity verification string', had been entered when creating the archive. 'The Next Tool' 
does not support this feature.

- In the case of ARJ archives, it is possible to run the archive in a so-called 'backup mode'. Then a copy of
each file that is overwritten is preserved within the archive. 'The Next Tool' treats backup files within ARJ 
archives as normal files. If several files would consequently have to be displayed with the same filename, 
the files are renamed by means of an internal numbering algorithm. Apart from that, the archive flag is 
ignored. Creating backup files in ARJ archives is not possible with 'The Next Tool'.

- Creating and displaying comments in archives is generally not supported.

- Archives that are not recognized by 'The Next Tool'... If you have an archive which has one of the 
formats listed above that you cannot work on with T.N.T., please check first whether or not it is really a 
correct archive. To do so, extract the contents of the archive by using the original archive program or a 
compatible one. If the archive is correct, feel free to send us the archive if no legal requirements 
(copyrights) are violated by duplicating and spreading the file and its contents. We will try to implement 
the corresponding archive support in a future release of 'The Next Tool'. You will find our mail and e-mail 
addresses in the 'Info about T.N.T.' dialog box.



V. Archives
a) Compressing Files and Directories

There are the following types of archives available for compressing files and directories:

- ZIP... ZIP archives. Default file extension '.ZIP'.
- RAR... RAR archives. Default file extension '.RAR'.
- LHA... LHA archives. Default file extensions '.LHA', '.LZH' and '.LZS'.
- ARJ... ARJ archives. Default file extension '.ARJ'.
- TAR... Uncompressed tape archives. Default file extension '.TAR'.
- TGZ... Tape archives, compressed with the GNU-ZIP method. Default file extension '.TGZ', '.GZ'.

1.) Compressing Files or Directories

In order to compress a file or a directory, click the corresponding entry in a display window with the right 
mouse button and choose 'Compress' from the context menu. To compress a number of files or 
directories, select the desired entries by using the left mouse button and also choose 'Compress' from the
context menu of one of the selected entries.
Then a dialog box for setting the parameters and options of a copy task appears. The path of the selected
entries is preset as the source directory. The same path, with the extension '.ZIP:' appended to it, is 
preset as the target directory. It is determined by means of the extension '.ZIP:' that the selected source 
files are to be packed into an archive instead of being copied to a normal directory.
(Note: To create no ZIP archive, but an archive of another format, press the 'Archive Type' button on the 
lower margin of the dialog box and choose the desired type from the context menu. Then the 
corresponding file extension that determines the type of the archive is inserted at the end of the path.)

For instance: Compressing the directory 'C:\Programs'

If you click the directory 'C:\Programs' in a display window with the right mouse button and choose 
'Compress' from the context menu, the dialog box of the copy task appears, showing the following source 
and target paths:

Source: C:\Programs

Target Directory: C:\Programs.zip:

As soon as the copy task is started, an archive file 'C:\Programs.zip' that will contain all entries of the 'C:\
Programs' directory is created. (Note: To pack the source files into another archive, simply enter the path 
of the desired archive in the 'Target Directory' edit control. All subdirectories or archives that are 
necessary to execute the copy task will be created automatically.) 

2.) Using Archives as Virtual Directories

To compress files or directories or to add them to an already existing archive, you can of course proceed 
as described above. However, you can also use a normal copy command (initiated by drag-and-drop, for 
instance) to compress files and directories. Since archives are treated as virtual directories within T.N.T., 
there is no difference between copying and compressing files as far as the handling of the process is 
concerned. There are the same options and parameters available for both tasks and for each ordinary 
copy process you can also enter an archive that is to be used as the target directory in the 'Target 
Directory' edit control. By the colon ':' at the end of a filename, it is clearly determined that the target of the
copy task is an archive and not a normal directory.



For instance: Adding a file to an archive

To pack the file 'D:\Documents\Invoice.doc' into the directory 'Old Documents' in the archive 'E:\
Backup.arj', you would have to enter the following source and target paths:

Source: D:\Documents\Invoice.doc

Target Directory: E:\Backup.arj:\Old Documents

As soon as you start the copy task, the file is packed into the named directory in the ARJ archive. If the 
archive or the directory do not exist already, they are created automatically.

3.) Additional Remarks

- Packing into self-extracting archives... According to the procedure described above, you can also add
files to a self-extracting archive. Simply name the path of the archive with a colon ':' at the end as the 
target for a copy task. E.g., to add some files to the self-extracting archive 'C:\Mail\Output.exe', enter

C:\Mail\Output.exe:

in the 'Target Directory' edit control. If the archive does not exist already, a notification appears and you 
can choose the format (ZIP, RAR, LHA or ARJ) of the self-extracting archive that is to be created.

- Archives within archives... T.N.T. also supports archives within archives. For instance, if you enter 

C:\DISK1.TNT:\DATA.ZIP:\NEW.ARJ:\Documents

in the 'Target Directory' edit control for a copy task, first a disk image 'DISK1.TNT' is created on drive 'C:'. 
Within this disk image there will be an archive 'DATA.ZIP' that contains an archive 'NEW.ARJ' with a 
directory 'Documents' in it.

- Creating empty archives... To create an empty archive, simply enter the desired archive name with a 
colon ':' at the end when creating the directory path. For instance, to create an empty ZIP archive named 
'Data.zip' in the 'C:\Programs' directory, click any directory in a display window with the right mouse 
button. Choose 'Directory Path' from the 'Create' submenu of the context menu and enter the following 
path:

C:\Programme\Data.zip:

- Creating archive files with arbitrary file extensions... To create an archive file that does not have one
of the default file extensions listed above, simply enter the desired filename with the desired extension 
and a colon ':' at the end. If the archive does not exist already, a notification appears and you can choose 
the desired format.



V. Archives
b) Extracting Files from Archives

The following types of archives are supported directly:

- ZIP... ZIP archives. Default file extension '.ZIP'.
- RAR... RAR archives. Default file extension '.RAR'.
- LHA... LHA archives. Default file extensions '.LHA', '.LZH' and '.LZS'.
- ARJ... ARJ archives. Default file extension '.ARJ'.
- TAR... Uncompressed tape archives. Default file extension '.TAR'.
- GZIP... GNU-ZIP archives. Default file extensions '.GZ'.
- TGZ... Type archives, compressed with the GNU-ZIP method. Default file extension '.TGZ'.

1.) Extracting the whole Archive

To extract the whole contents of an archive, click the archive file in a display window with the right mouse 
button and choose 'Extract' from the context menu. Then a dialog box for setting the parameters and 
options of a copy task appears. The path of the archive, with a colon ':' at the end, is preset as the source 
directory and the same path, yet without the archive's file extension, is preset as the target directory. 
(Note: The colon ':' at the end of the source filename indicates that the contents of the archive that is 
represented by the given filename is to be copied and not the file itself.)

For instance: Extracting the contents of the archive 'D:\Backup.arj'

If you click the file 'D:\Backup.arj' in a display window with the right mouse button and choose 'Extract' 
from the context menu, the dialog box of the copy task appears, showing the following source and target 
paths:

Source: D:\Backup.arj:

Target Directory: D:\Backup

As soon as the copy task is started, the contents of the archive file 'D:\Backup.arj' are copied to the 
directory 'D:\Backup'. (Note: To extract the contents of the archive to another directory, simply enter the 
desired path in the 'Target Directory' edit control. Directories that do not exist already are created 
automatically.)

2.) Extracting Selected Files or Subdirectories from an Archive

Within 'The Next Tool', archives are treated as virtual directories by all file commands. That means you 
can access the contents of an archive in just the same way you can access the contents of a normal 
directory. Archives that have one of the default file extensions listed above appear in the directory tree in 
the tree pane of display windows automatically.
To extract a number of files or directories from an archive, show the contents of the archive in a display 
window. Select the desired entries by using the left mouse button and open a copy command. (E.g. via 
the context menu of the selected entries or by drag-and-drop.)
Since archives are treated as virtual directories within T.N.T., there is no difference between copying and 
extracting files as far as the handling of the process is concerned. There are the same options and 
parameters available for both tasks and for each ordinary copy process you can also enter an archive that
is to be used as the source directory in the 'Source' edit control. By the colon ':' at the end of a filename, it
is clearly determined that the source of the copy task is an archive and not a normal file or directory. For 
instance, to extract the directory 'Documents' from the archive file 'C:\Data.zip', you would have to enter 



the following source for the copy task:

C:\Data.zip:\Documents

3.) Using Archive Files with Arbitrary File Extensions

Archive files that do not have one of the default file extensions listed above will not appear in the tree 
section of display windows. To show the contents of such an archive (e.g. of a self-extracting archive with 
the file extension '.exe'), double-click the file with the right mouse button. In case of a file command (e.g. 
when executing a copy task to extract the contents of the archive), enter the filename with a colon ':' at 
the end as described above, in the 'Source' edit control. Because of the colon ':' the file is treated as an 
archive anyway. The type of the archive is determined automatically.



V. Archives
c) Self-Extracting Archives

A self-extracting archive is an archive that can be started as a normal program and then extracts its 
contents automatically. With 'The Next Tool' you can create self-extracting ZIP, RAR, LHA and ARJ 
archives for Windows® 95 which you can use for your own applications.

1.) Creating a Self-Extracting Archive out of a Normal Archive

To create a self-extracting archive out of a normal ZIP, RAR, LHA or ARJ archive, click the archive file in a
display window with the right mouse button and choose 'Create Self-Extracting Archive' from the context 
menu. Then a dialog box appears in which you can enter the path of the source archive as well as the 
path of the self-extracting archive that is to be created.

2.) Creating a Self-Extracting Archive when Compressing (or Copying) Files

To create a self-extracting archive directly when compressing (or copying) files, enter the desired filename
with the extension '.EXE' and a colon ':' at the end in the 'Target Directory' edit control. The type of the 
archive is asked for automatically, as soon as you start the copy process. (See also Compressing Files 
and Directories.)

3.) Creating an Empty Self-Extracting Archive

To create an empty self-extracting archive, enter the desired filename with the extension '.EXE' and a 
colon ':' at the end when creating a new directory path. For instance, to create an empty self-extracting 
archive 'Update.exe' in the directory 'C:\Output', click any directory in a display window with the right 
mouse button. Choose 'Directory Path' from the 'Create' submenu of the context menu and enter the 
following path:

C:\Output\Update.exe:

The type of the self-extracting archive is asked for automatically.



V. Archives
d) Creating Multi-Volume ZIP Archives

You can create multi-volume ZIP archives to distribute a ZIP archive (that is too large to fit on one disk) 
into several parts on several floppy disks. (Warning! A multi-volume ZIP archive has to be combined again
before you can read or extract its contents. The files that are created when distributing an archive are 
incomplete and cannot be read on their own. See also Restoring Multi-Volume ZIP Archives.)
To create a multi-volume ZIP archive, click the archive that is to be distributed in a display window with 
the right mouse button and choose 'Create Multi-Volume Archive' from the context menu.

When creating multi-volume ZIP archives, there are the following features available:

- The Source Archive for Creating a Multi-Volume ZIP Archive
- The Target Archive for Creating a Multi-Volume ZIP Archive
- The Volume Size
- Numbering the Disk Images
- Setting the Drive Labels

To start the task, press the 'Create' button on the lower margin of the dialog box. While the task is being 
executed, the following events may occur:

- Changing the target archive or the data carrier... Each time when a certain quantity of data, 
according to the desired volume size, has been written, the 'Next Target Volume' dialog box appears and 
you can enter a new target path or change the data carrier.

- Error notifications... If an error occurs while distributing the archive or if the target data carrier is full 
before the chosen quantity of data has been written or if 'Maximum' is selected for the volume size, an 
error notification appears. Warning! Do not remove the data carrier now, as the target file is not closed 
yet. Please confirm the notification first. 
If an error occurs during the write process itself and not because the data carrier is full, the task has to be 
cancelled. Otherwise the 'Next Target Archive' dialog box appears and you can change the target 
directory or the data carrier.

- Aborting the task... Warning! If the distribution of the ZIP archive has been cancelled, the target files 
are unusable anyway and should be deleted.





- The Source Archive for Creating a Multi-Volume ZIP Archive

When setting the options for the creation of a multi-volume ZIP archive, you can enter the full path of the 
ZIP archive that is to be distributed in the 'Source Archive' edit control.



- The Target Archive for Creating a Multi-Volume ZIP Archive

When setting the options for the creation of a multi-volume ZIP archive, you can enter the path of the 
multi-volume ZIP archive that is to be created in the 'Target Archive' edit control. (Note: If you also want to
use other programs than T.N.T. to restore the multi-volume ZIP archive, please note that the target 
archive has to be of a kind that can be worked upon by the alternative program. That means, normally 
you will have to name a file in the root directory of a floppy disk, e.g. 'A:\ARCHIV.ZIP'. If you are sure that 
you always want to use T.N.T. to restore the multi-volume archive you can use any file path.) 



- The Volume Size

There are six check boxes in the dialog box in which you set the options for the creation of a multi-volume
ZIP archive for choosing the capacity of the data carrier that is used for the multi-volume archive. As soon
as the corresponding amount of data has been written or when the data carrier is full, a notification 
appears and you can change the data carrier or enter another target directory. (Note: If you want to write 
the multi-volume archive on empty floppy disks or into disk images that are created during the process, 
choose the capacity of the desired data carrier: 360 Kbytes, 720 Kbytes, 1200 Kbytes, 1440 Kbytes or 
1680 Kbytes (DMF format). If the target data carriers already contain some files and you want to fill the 
data carriers, check the 'Maximum Capacity' check box.)



- Setting the Drive Labels

When setting the options for the creation of a multi-volume ZIP archive, check the 'Set the drive labels' 
check box if the labels of the floppy disks or the disk images that are used for the multi-volume archive 
are to be set and numbered automatically. If you check the 'Check the drive labels' check box when 
restoring the multi-volume ZIP archive, the data carriers are validated by means of their labels and a 
notification appears in the case of a wrong floppy disk or disk image.



V. Archives
e) Restoring Multi-Volume ZIP Archives

Before you can view or extract the contents of a multi-volume ZIP archive with 'The Next Tool', you have 
to restore the original archive by re-combining the parts of the archive that were distributed into several 
parts on several floppy disks or disk images. The individual parts of the archive cannot be used on their 
own. 
To restore a multi-volume ZIP archive, click the first file of the archive in a display window with the right 
mouse button and choose 'Restore Multi-Volume ZIP' from the context menu. Please remember to click 
the ZIP file in the folder pane of the 'display window', not in the tree pane. If you activate a ZIP file in the 
tree pane of a 'display window', T.N.T. tries to show the contents of the archive. As the parts of a multi-
volume ZIP archive are no correct ZIP files on their own, activating such a file will result in an error 
notification.

When restoring a multi-volume ZIP archive, there are the following features available:

- The Source Archives for Restoring a Multi-Volume ZIP Archive
- The Target Archive for Restoring a Multi-Volume ZIP Archive
- Numbering the Disk Images
- Checking the Drive Labels

To start the task, press the 'Restore' button on the lower margin of the dialog box. While the task is being 
executed, the following events may occur:

- Changing the source archive or the data carrier... Each time, when the data from the current volume 
has been read, the 'Next Source Volume' dialog box appears and you can enter a new source path or 
change the data carrier.

- Aborting the task... Warning! If the restore process of the ZIP archive has been cancelled, the partly 
created target file is unusable anyway and should be deleted.



- The Source Archives for Restoring a Multi-Volume ZIP Archive

When setting the options for restoring a multi-volume ZIP archive, you can enter the full path of the ZIP 
archives that are to be re-combined in the 'Source Archive' edit control. (Note: The source archive has to 
be a multi-volume ZIP archive that was either created by 'The Next Tool' (See also: Creating Multi-Volume
ZIP Archives) or by another program that offers the same functionality.



- The Target Archive for Restoring a Multi-Volume ZIP Archive

When setting the options for restoring a multi-volume ZIP archive, you can enter the path of the ZIP 
archive that is to be restored in the 'Target Archive' edit control.



- Checking the Drive Labels

If you check the 'Check the drive labels' check box when setting the options for restoring a multi-volume 
ZIP archive, the label of each floppy disk or each disk image being used for re-combining the ZIP archive 
is validated first. If you enter a wrong disk, a notification appears and the correct disk is asked for. (Note: 
The drive labels must have been set when creating the archive. To do so, check the 'Set the drive labels' 
check box when setting the options for the creation of the multi-volume ZIP archive.)



VI. Tools

VI.1. The Control Window
VI.2. Virtual Desktops
VI.3. The Text Editor
VI.4. The File Viewer
VI.5. The Command Line
VI.6. Registered File Types
VI.7. Creating a Directory Path
VI.8. Executing External Programs or Applications



VI. Tools
VI.1. The Control Window

By means of the control window you can access drives as well as execute all the internal functions of 
T.N.T. and run external commands or applications.

The appearance of the window is variable to a large extent. It can be an ordinary window

as well as an application bar, which is bound to the upper or lower border of the screen,

or it may also be switched off completely.

1.) The Drive Bar

Via the icons of the drive bar you can access the various drives (hard disks, floppy disks, CD-ROM drives 
etc.). By clicking a drive icon with the left mouse button, you open a default display window. By clicking it 
with the right mouse button, you open the context menu of the corresponding drive. The context menu 
contains the favorite directories and the most recently used directories of the drive as well as further drive 
specific commands. For drag-and-drop, you can use drive icons as sources as well as targets.

Notes:

- The drive icon can be enabled or disabled for each drive individually. If not all drives are to be 
shown, you can add a '...' icon to the drive bar to access the rest of the drives. (See also: Settings: 
Drives).

- If you move the mouse pointer over one of the drive icons and leave it there for a moment, a tooltip 
appears, displaying the free memory and the label of the drive. In the case of a SUBST or network drive 
the path from which the drive was derived is shown.

2.) The Command Bar

There are two different types of icons in the command bar: Commands that can be executed directly and 
folders that can contain further commands and folders.
By clicking a command icon with the left mouse button you execute the corresponding command. By 
clicking a folder with the left mouse button, the corresponding folder becomes the current folder of the 
command bar and its contents are shown. (Note: To return from a sub-folder to the parent folder, click the 
first icon, which shows a folder and a red arrow.)
By clicking an icon with the right mouse button you open the context menu to edit, add or remove 



commands or folders. (See also: User-Defined Commands.) For drag-and-drop, you can use the 
command icons and the folder icons as sources as well as targets. (See also: Drag-and-Drop: 
Commands.)

3.) The User-Defined Menu of the Control Window

You can add further drop-down menus or submenus containing additional commands to the menu bar of 
the control window. To open the 'Menus' dialog box for editing the user-defined menus, choose 'Menus' 
from the 'T.N.T.' menu of the control window. For detailed information on editing menus refer to User-
Defined Menus.

Note: The control window only has a menu bar if the window is used as an ordinary window and not as an
application bar bound to the upper or lower border of the screen. (See also: The Control Window: As an 
Ordinary Window.)

4.) Configuring the Appearance of the Control Window

The control window can be an ordinary window as well as an application bar, which is bound to the upper 
or lower border of the screen. As an application bar, the window can always be on top or auto-hidden like 
the Windows® taskbar. Furthermore, you can enable or disable the menu bar, the drive bar and the 
command bar individually.

You can determine all details concerning the appearance of the control window by means of the context 
menu that is opened by clicking anywhere in the background of the window (that is: not on the drive bar or
the command bar) or on the 'Control Window' page of the 'Settings' property sheet. The following options 
are available:

- The Control Window: As an Ordinary Window
- The Control Window: As an Application Bar
- The Control Window: Switched Off
- The Control Window: Always on Top
- The Control Window: Auto-Hide
- The Control Window: Without Menu Bar
- The Control Window: Drive Bar Enabled
- The Control Window: Command Bar Enabled
- The Control Window: A Two-Line Button Bar for Drives and Commands



- The Control Window: As an Ordinary Window

Check the 'As an ordinary window' check box if you don't want to use the control window as an 
application bar, bound to the upper or lower border of the screen, but as an ordinary, moveable window, 
which has a title bar and a menu bar.



- The Control Window: As an Application Bar

If you want to use the control window as an application bar at the upper or lower border of the screen, 
check the 'Application bar on the upper border' check box or the 'Application bar on the lower border' 
check box.

Note: As an application bar, the control window neither has a title bar nor a menu and it is bound to the 
chosen border. By means of the The Control Window: Always on Top option and the The Control Window:
Auto-Hide option, you are able to configure the control window like the Windows® taskbar.



- The Control Window: Switched Off

If you want to control T.N.T. essentially by means of the main menu or the icons and the user-defined 
menu of the taskbar, you can completely switch off the control window. To do so, check the 'Switched off' 
check box.



- The Control Window: Always on Top

If you check the 'Always on top' check box on the 'Control Window' page of the 'Settings' property sheet , 
the control window always remains in the foreground, in front of all other windows. If the window is used 
as an application bar at the same time and the The Control Window: Auto-Hide option is disabled, the 
space available for other applications is reduced by the area of the control window. The control window 
then corresponds to the taskbar as it is after the standard setup of Windows®.

Note: You can enable 'auto-hide' and 'always on top' at the same time. If the control window is not used 
as an application bar but as an ordinary window and 'always on top' is enabled, it is put in order with the 
windows of other applications that are to remain in the foreground as well.



- The Control Window: Auto-Hide

If you check the 'Auto-hide' check box on the 'Control Window' page of the 'Settings' property sheet and 
the control window is used as an application bar, the auto-hide mode is enabled. Then, in general, the 
control window is hidden, except for a strip of two pixels. The window only becomes completely visible if 
you move the mouse pointer to the corresponding border of the screen. If the mouse pointer isn't above 
the control window anymore, the window is hidden again.

By means of the following options you can determine how the control window is faded in:

- Delayed display... The mouse pointer has to stay at the border of the screen for a moment before the 
control window becomes visible.

- Scrolling... The control window is scrolled into the screen.

Note: You can enable 'auto-hide' and 'always on top' at the same time. If the control window is used as an
ordinary window, 'auto-hide' is ignored.



- The Control Window: Without Menu Bar

Check the 'Without menu bar' check box on the 'Control Window' page of the 'Settings' property sheet to 
switch off the menu bar of the control window.

Note: If the control window is used as an application bar, bound to the upper or lower border of the 
screen, the window has no menu bar anyway and the 'Without menu bar' check box is ignored. (See also:
The Control Window: As an Ordinary Window.)



- The Control Window: Drive Bar Enabled

Check the 'Drives' check box on the 'Control Window' page of the 'Settings' property sheet to enable the 
drive bar of the control window.



- The Control Window: Command Bar Enabled

Check the 'Commands' check box on the 'Control Window' page of the 'Settings' property sheet to enable 
the command bar of the control window.

 



- The Control Window: A Two-Line Button Bar for Drives and Commands

Check the 'Two-Line button bar for drives and commands' check box on the 'Control Window' page of the 
'Settings' property sheet if the drive icons and the command icons are to be displayed in separate button 
bars.



VI. Tools
VI.2. Virtual Desktops

The term 'desktop' is used to describe the background of the screen on which the icons and windows of 
programs and applications are displayed. When using T.N.T. you can have several virtual desktops and 
consequently have several 'screens' at your disposal. If you switch from one desktop to another, all 
windows on the current desktop are hidden and the windows of the second desktop are shown again.
For instance, you could have one virtual desktop in the background to keep open the display windows of 
the drives that you need regularly while another application is running on the second desktop and you are
working with your word processor on the third one.
 
T.N.T. provides up to four virtual desktops. You can choose the number of desktops available on the 
'General' page of the 'Settings' property sheet. If more than one desktop is enabled, there is an icon for 
each desktop in the taskbar (a sphere, a pyramid, a cube and a cylinder). 

1.) Switching the Virtual Desktop

By clicking one of the desktop icons with the left mouse button you can switch to the corresponding 
desktop. (Note: By clicking a desktop icon with the right mouse button, you can open the 'Settings' 
property sheet to enable or disable virtual desktops.)

When using the keyboard you can use the following keyboard shortcuts to switch from one desktop to 
another:

- Control + Alt + F5... Activates desktop 1.
- Control + Alt + F6... Activates desktop 2.
- Control + Alt + F7... Activates desktop 3.
- Control + Alt + F8... Activates desktop 4.
- Control + Alt + Tab... Activates the next desktop.
- Control + Shift + Alt + Tab... Activates the previous desktop.

2.) Moving a Window to Another Desktop

In order to move a window or an application to another desktop, click the corresponding desktop icon in 
the taskbar with the right mouse button and keep the button pressed. Then drag the mouse pointer over 
the desired window and release the button to move the window to the corresponding desktop.

When using the keyboard you can use the following keyboard shortcuts to move the window that is 
currently active to a certain desktop:

- Shift + Control + Alt + F5... Moves the active window to desktop 1.
- Shift + Control + Alt + F6... Moves the active window to desktop 2.
- Shift + Control + Alt + F7... Moves the active window to desktop 3.
- Shift + Control + Alt + F8... Moves the active window to desktop 4.

3.) Drag-and-Drop of Items From One Desktop to Another One



To transfer an item (e.g. a file or a directory) from a window on the current desktop to another desktop, 
drag the item over the icon of the target desktop in the taskbar and leave the mouse pointer there for a 
moment. The corresponding desktop is then activated and you can drop the item onto the target window.

Note: In principle, windows 'belong' to the desktop that was active when the window was opened, no 
matter which application opened the window. Exceptions to this rule are the following windows and icons, 
which are regarded as desktop independent items:

- The Windows® Taskbar.
- All application bars.
- All icons on the desktop that are not minimized windows.
- The control window and all windows of T.N.T. that exist only once and somehow serve the configuration 
of the program.



VI. Tools
VI.3. The Text Editor

By means of T.N.T.'s integrated text editor you can edit texts in both the ANSI character set and the 
OEM/ASCII character set.

The text editor provides numerous operations to work on texts, find and replace strings and in addition, an
unlimited undo and redo functionality. For all details concerning the text editor refer to the following 
chapters: 

a) Opening the Editor
b) Opening a File for Editing
c) Saving a Text
d) Editing with the Text Editor
e) Working on a Selected Part of the Text
f) Undo and Redo for the Text Editor
g) Finding and Replacing Text
h) ANSI and OEM, Displaying and Converting
i) Tab Characters and the Text Editor
j) Configuring the Text Editor
k) Keyboard Shortcuts: Text Editor



VI.3. The Text Editor
a) Opening the Editor

When opening the text editor, there are several ways to pass the text to be edited:

1) Opening the Text Editor with a File

Click the entry of the file in a display window with the right mouse button and choose 'Editor' from the file 
context menu. (When using the keyboard, position the cursor of the window on the desired file and press 
'F4'.)

Notes:

- When loading the file, the correct character set, ANSI or OEM, is automatically determined and the 
editor is opened in the corresponding mode.

- If the file contains bytes with the value zero '0', a notification is displayed and you can either open a file 
viewer or cancel the process.

- If the file contains tab characters, the 'Tab Stops' dialog box appears and you can set the distance 
between the tab stop positions. (See also Tab Characters and the Text Editor.)

2.) Opening the Text Editor with an Empty Text

Choose the 'Editor' command from the context menu of the taskbar, from the command bar of the control 
window or from the Command Templates window. When using the keyboard, press 'Shift + F4' (Note: If 
the same file is always supposed to be loaded when executing a certain editor command instead of 
opening the editor with an empty text, you can name this file when configuring the editor command. For 
details on defining commands see: User-Defined Commands.)

3.) Opening the Text Editor with a Selected Text Block 

To open a text editor with the selected text block from a file viewer or from another editor, choose 'Editor' 
from the 'Edit' menu. (When using the keyboard, press 'F4'.)

4.) Opening the Text Editor with the Contents of a Display Window

In order to open a text editor with a list of the entries in the folder pane of a tree/folder display, choose 
'Edit' from the 'Folder Pane' submenu of the 'Edit' menu. To open a text editor with the contents of a folder
display, multi-folder display or search-result display, choose 'Edit' from the 'Edit' menu. (Note: If some 
entries are selected in the folder pane, the editor is opened with a list of the selected entries only, 
otherwise with a list of all entries.)
Alternatively, click one of the status bars of the display window with the right mouse button and choose 
'Editor' from the context menu. Click the upper status bar to edit a list of all entries or the lower status bar 
to create a list of the selected entries only.

5.) Opening the Text Editor with the Representation of a Directory Hierarchy

To open a text editor with the representation of the directory hierarchy that is shown in the tree pane of a 



tree/folder display, choose 'Edit' from the 'Tree Pane' submenu of the 'Edit' menu. To open a text editor 
with the directory hierarchy that is shown in a tree display, choose 'Print' from the 'Edit' menu.



VI.3. The Text Editor
b) Opening a File for Editing

1.) To load a new file replacing the current text, choose 'Open' from the 'File' menu. 

2.) To insert a file at the current position of the cursor, select 'Insert File' from the 'Edit' menu.

The 'Open File' dialog box, or respectively the 'Insert File' dialog box, then appears and you can name the
file to be loaded and set the distance between the tab stop positions for expanding tab characters. (See 
also Tab Characters and the Text Editor.)

Notes:

- When loading (not inserting!) a file, the correct character set, ANSI or OEM, is automatically determined 
and the editor is switched to the corresponding mode.

- If a file contains zero-bytes, a notification is displayed and you can either open a file viewer or cancel the
loading process.



VI.3. The Text Editor
c) Saving a Text

1.) To save the whole text under the current filename, choose 'Save' from the 'File' menu.

2.) To save the whole text under a new filename, choose 'Save as' from the 'File' menu.

3.) To save the selected area of the text, choose 'Save as' from the 'Edit' menu.

In the case of the first option, the text is saved immediately under the current filename. Otherwise the 
'Save as' dialog box, or respectively the 'Save Selection as' dialog box, appears and you can set the 
following parameters:

1.) Path... Enter the filename in the 'Filename' edit control.

2.) Tab characters... Use the 'Tab' scroll bar control to set the distance between the tab stop positions. If 
one of the options 'At the beginning of a line' or 'Always' is checked, consecutive spaces, up to the next 
tab stop position are replaced by a single tab character. If spaces are never to be replaced by tab 
characters, check the 'None' check box.

- Note: Creating backup files when saving a text... You can create a backup file when saving a text in 
case a file with the same name already exists. The old file is then preserved with the same filename but a 
different filename extension. In the 'Backup File' submenu of the 'File' menu, you can select the extension
of the backup file: '.BAK', '.bak' or '~*'. (Note: '~*' means that the old extension is preserved. However, a 
tilde '~' is added at the beginning of the extension. For instance: '.TXT' becomes '.~TXT'.) If you do not 
want to create backup files, check 'Don't Create' in the 'Backup File' submenu. If backup files are not to be
created in archives, check 'Not in Archives'.



VI.3. The Text Editor
d) Editing with the Text Editor

1.) The Display Area

The display area takes up the greater part of the editor window. By means of the scroll bars on the right-
hand and the lower margin of the window, the visible part of the text can be scrolled. (Note: The vertical 
scroll bar is removed automatically if the text is completely visible.)

2.) The Cursor

New characters are inserted at the location of the cursor. You can move the cursor by using the common 
keyboard shortcuts. (See also: Keyboard Shortcuts: Moving the Cursor.) If you try to move the cursor 
across the border of the display area, the visible part of the text is scrolled in the corresponding direction. 
You can position the cursor directly, by clicking somewhere in the display area with the left mouse button. 
To move the cursor to a certain line, choose 'Go to' from the 'Search' menu and enter the desired line 
number. (Note: Line numbers may be entered in decimal as well as in hexadecimal format. Possible 
hexadecimal input formats are: '0xf034', '1a43h' or '$b435'.)

3.) The Status Bar of the Editor

On the lower margin of the editor window there is a status bar, showing the following pieces of 
information:

- The 'Line' and 'Column' numbers show the current position of the cursor.

- 'Modified' is shown if the text has been modified since it was saved.



- The character set currently in use is identified by 'ANSI' or 'OEM'.

4.) Keyboard Shortcuts

- Keyboard Shortcuts: Moving the Cursor
- Keyboard Shortcuts: Editing with the Text Editor



VI.3. The Text Editor
e) Working on a Selected Part of the Text

You can select a part of the text that can be worked upon independently by a number of commands.

1.) Selecting a Part of the Text by Using the Mouse

To select a part of the text, move the mouse pointer to the beginning (or the end) of the desired part and 
press the left mouse button. Keep the button pressed and move the mouse in any direction. The part of 
the text that is crossed with the mouse is then underlain with the color used for selected items (default: 
light blue). If the mouse pointer is moved across the border of the display area, the visible part of the text 
is scrolled in the corresponding direction. Drag the mouse pointer over the last (or the first) character to 
be selected and release the mouse button. (Note: The beginning (the end) of the selection can also be set
by double-clicking a character with the left (right) mouse button. To select the whole text, choose 'Select 
All' from the 'Edit' menu.)

2.) Persistent or Non-Persistent Selection

There are two modes that determine how long the selection of a part of the text is maintained.

- Non-persistent selection... Every movement of the cursor cancels the selection. The input of a new 
character replaces the selection. (This is the default for Windows® applications)

- Persistent selection... The selection is preserved when the cursor is moved or new characters are 
inserted. If the input takes place within the selection, the selection is extended automatically. (Note: The 
selection is also preserved and adjusted to the new size respectively if a new beginning or end for the 
selection is set or the text is modified by loading, copying or moving a part of the text. The selection is 
only cancelled completely if a new text is loaded, the whole text is erased or the beginning of the selection
is set behind its end.)

To switch from non-persistent to persistent selection and vice versa, select 'Persistent Selection' from the 
'File' Menu.

3.) Working on the Selected Part of the Text

You will find the following commands to work on the selected part of the text in the 'Edit' menu or in the 
context menu that is opened by clicking the selection with the right mouse button.

- Cut... Erases the selected part of the text and copies the selection to the clipboard.

- Copy... Copies the selection to the clipboard.

- Paste... Inserts text from the clipboard at the current cursor location (when choosing 'Paste' from the 
'Edit' menu) or at the current location of the mouse pointer (when choosing 'Paste' from the context menu 
of the text).

- Delete... Erases the selected part of the text.

- Save As... Saves the selected part of the text to a file. (See also Saving a Text.)

- Print... Prints the selected part of the text.



- Editor... Opens a new editor with the selected part of the text.

For the corresponding keyboard shortcuts and further information about working on selected parts of the 
text refer to:

- Keyboard Shortcuts: Selecting a Part of a Text or Display Area
- Keyboard Shortcuts: Working on a Selected Part of a Text
- Drag-and-Drop: Text



VI.3. The Text Editor
f) Undo and Redo for the Text Editor

The text editor offers an almost unlimited undo functionality. (Limited only by the available memory.) 
Besides, you are able to redo any undo action. (Note: Changes can only be taken back until the current 
text is returned to the state of the moment when it was loaded. Changes to previous files, which were 
saved in the meantime, cannot be taken back.)

- Undo... To take back the last action, choose 'Undo' from the 'Edit' menu or press 'Alt + Backspace' or 
'Control + Z'.

- Redo... To revoke the last undo action, choose 'Redo' from the 'Edit' menu or press 'Shift + Alt + 
Backspace'.



VI.3. The Text Editor
g) Finding and Replacing Text

1.) Searching for a String

In order to search in the current document for a certain string, choose 'Find' from the 'Find' menu or press 
'Control + Q f', 'Control + F' or 'Alt + F3'. Then the 'Search' dialog box appears and you can enter the 
search string and set the following parameters for the search process.

- Case-sensitive
- Whole words only
- Search backwards

Press the 'OK' button to start the search process at the current cursor location. If the search string is 
found, the corresponding part of the text is shown, the search string is selected and the cursor is 
positioned behind the last character of the selection. To find the next occurrence of the search string, 
choose 'Again' from the 'Find' menu or press 'Control + L', 'Control + N', 'Control + W' , 'Shift + F7' or 'F3'.

2.) Replacing a String

In order to replace one (or several) occurrence(s) of a certain string by another string, choose 'Replace' 
from the 'Find' menu or press 'Control + Q a'. Then the 'Replace' dialog box appears and you can enter 
the search string as well as the replace string and set the following parameters for the replace process. 
(Note: If the search string is to be erased from the text, leave the replace string empty.)

- Replace all
- Confirmation before replacing
- Case-sensitive
- Whole words only
- Search backwards

Press the 'OK' button to start the replace process at the cursor location. If an occurrence of the search 
string is found, it is replaced immediately if Confirmation before replacing is disabled. Otherwise the 
corresponding part of the text is shown, the search string is selected, the cursor is positioned behind the 
selection and a notification appears that enables you to choose whether or not to replace the current 
occurrence of the search string.
If Replace all is enabled, the replace process continues until the end of the text is reached or you cancel 
the process. To restart the replace process at the current cursor location and find the next occurrence of 
the search string, choose 'Again' from the 'Find' menu or press 'Control + L', 'Control + N', 'Control + W' , 
'Shift + F7' or 'F3'.

See also:

- Keyboard Shortcuts: Finding and Replacing Text, Finding Patterns



- Case-Sensitive

Check the 'Case-sensitive' check box when Finding and Replacing Text or Searching for Patterns or 
executing a File Find and Find in Files command if upper case and lower case are to be distinguished.



- Whole Words Only

Check the 'Whole words only' check box when finding and replacing text or searching for patterns or 
executing a File Find and Find in Files command if word fragments that match the search string are not to
be found. For instance: If 'Whole words only' is disabled, the word fragment 'story' is found in 'history'.



- Search Backwards

Check the 'Search backwards' check box when finding and replacing text or searching for patterns if you 
want to search backwards from the current position of the cursor, i.e. towards the beginning of the text. 
Normally the search or replace process runs from the current position of the cursor to the end of the text.



- Replace All

Check the 'Replace all' check box when finding and replacing text if all occurrences of the search string, 
beginning at the current cursor location, are to be replaced. (Note: Depending on whether or not 
Confirmation before replacing is also enabled, either all occurrences of the search string are replaced 
immediately or there is a corresponding notification for each occurrence.)



- Confirmation before replacing

Check the 'Confirmation before replacing' check box when finding and replacing text if you want to 
confirm each replacement of the search string. (Note: If Replace all is also enabled, you can choose from 
the following options as soon as an occurrence of the search string has been found: 1. Replace the 
current occurrence and continue, 2. Don't replace the current occurrence and continue, 3. Replace all 
occurrences immediately, 4. Cancel the process.)



VI.3. The Text Editor
h) ANSI and OEM, Displaying and Converting

ANSI and OEM are two different character sets. ANSI is the one that is used normally under Windows®. 
OEM is the one that is used for ASCII or DOS text files. The difference of the two character sets becomes 
apparent when certain graphical symbols or country-specific characters are used. If a file that was created
with the OEM or ASCII character set is displayed by using the ANSI character set, these characters are 
not displayed correctly. When loading a file T.N.T.'s text editor and the file viewer try to automatically 
identify and use the correct character set.

1.) Switching from ANSI to OEM

In order to switch from using the ANSI character set for the input of characters to using the OEM 
character set and vice versa, choose 'OEM' from the 'File' menu.

2.) Converting a Text from ANSI to OEM and vice versa

In order to convert an existing text from one character set to the other one, it is not sufficient to switch the 
character set, as described above. By switching the character set, only the character set that is currently 
in use is exchanged. The text itself is not modified. 
For instance, there is an ANSI text that contains graphical symbols. Each symbol is represented by a 
certain character code. If the character set is switched to OEM, these graphical symbols are no longer 
displayed correctly, as the character codes are not converted, but another character set is used to display
the same character codes instead. In order to convert a text from the ANSI to the OEM character set and 
vice versa and to maintain the same characters, proceed as follows:

- Load the file and pay attention to the fact that the right character set (ANSI or OEM) is used, so all 
characters are displayed correctly.

- Choose 'Select All' from the 'Edit' menu.

- Choose 'Cut' from the 'Edit' menu. The whole text is in the clipboard now.

- Choose 'OEM' from the 'File' menu to switch the character set.

- Choose 'Paste' from the 'Edit' menu. Note: When inserting the text all characters are converted 
automatically to the current character set.

- Choose 'Save' or 'Save As' from the 'File' menu to save the converted text.



VI.3. The Text Editor
i) Tab Characters and the Text Editor

T.N.T.'s text editor immediately replaces each tab character by the corresponding number of spaces up to 
the next tab stop position, when loading a file as well as when entering tab characters. To set the distance
between the tab stop positions, choose 'Tab Stops' from the 'File' menu.

Note: Changing the distance between the tab stop positions has no influence on tabs that were replaced 
previously. Only when saving the file, consecutive spaces can be replaced by tab characters again.



VI.3. The Text Editor
j) Configuring the Text Editor

In order to use the current configuration of the text editor as the default for future editor windows, choose 
'Current Layout as Default' from the 'File' menu. The layout of the editor includes the size of the window 
as well as the following parameters:

- The tab stop positions... Choose 'Tab Stops' from the 'File' menu to change the distance between the 
tab stop positions. (See also Tab Characters and the Text Editor.) 

- Non-permanent or permanent selection... Choose 'Permanent Selection' from the 'File' menu to 
switch from permanent to non-permanent selection and vice versa. (Note: If permanent selection is 
enabled, the selection of a part of the text is maintained even if the cursor is moved or new characters are
entered. See also: Working on a Selected Part of the Text.)

- Creating backup files when saving a text... You can create a backup file when saving a text in case a 
file with the same name already exists. The old file is then preserved with the same filename but a 
different filename extension. In the 'Backup File' submenu of the 'File' menu, you can select the extension
of the backup file: '.BAK', '.bak' or '~*'. (Note: '~*' means that the old extension is preserved. However, a 
tilde '~' is added at the beginning of the extension. For instance: '.TXT' becomes '.~TXT'.) If you do not 
want to create backup files, check 'Don't Create' in the 'Backup File' submenu. If backup files are not to be
created in archives, check 'Not in Archives'.

k) Keyboard Shortcuts: Text Editor

- Keyboard Shortcuts: Moving the Cursor
- Keyboard Shortcuts: Editing with the Text Editor
- Keyboard Shortcuts: Selecting a Part of a Text or Display Area
- Keyboard Shortcuts: Working on a selected Part of a Text
- Keyboard Shortcuts: Finding and Replacing Text, Finding Patterns



j) Configuring the Text Editor
- Keyboard Shortcuts: Moving the Cursor

Use the following keyboard shortcuts to move the cursor of display windows, of the text editor, of the hex-
view of the file viewer as well as of other list view controls.

- Cursor left... Moves the cursor one column to the left or scrolls the display to the left.

- Cursor right... Moves the cursor one column to the right or scrolls the display to the right.

- Cursor up... Moves the cursor one line upwards.

- Cursor down... Moves the cursor one line downwards.

- Home... For the text editor and the hex-view of the file-viewer: Places the cursor at the beginning of the 
current line. Otherwise: Places the cursor on the first entry of the list.

- End... For the text editor and the hex-view of the file-viewer: Places the cursor at the end of the current 
line. Otherwise: Places the cursor on the last entry of the list.

- Shift + cursor left... For display windows and list view controls: Scrolls the display completely to the 
left. For the text editor: Moves the cursor one column to the left and selects one character.

- Shift + cursor right... For display windows and list view controls: Scrolls the display completely to the 
right. For the text editor: Moves the cursor one column to the right and selects one character.

- PgUp... Scrolls upwards, to the previous page.

- PgDn... Scrolls downwards, to the next page.

- Control + PgUp...
- Control + Home... Places the cursor at the beginning of the text or the list.

- Control + PgDn...
- Control + End... Places the cursor at the end of the text or the list.

- 'a' - 'z'... Places the cursor on the next entry beginning with the corresponding character. Note: Type 
several characters, one shortly after the other, to jump to the next entry that begins with the 
corresponding string. (Not available for text editors and file viewers.)

- 'A' - 'Z'... Places the cursor on the previous entry beginning with the corresponding character. Note: 
Type several characters, one shortly after the other, to jump to the previous entry that begins with the 
corresponding string. (Not available for text editors and file viewers.)

- Other characters or graphic symbols... Places the cursor on the next entry beginning with the 
corresponding character. (Not available for text editors and file viewers.)

- Control + cursor left... Places the cursor at the beginning of the current word. (Text editors only.)

- Control + cursor right... Places the cursor at the beginning of the next word. (Text editors only.)

- Control + G... For display windows: The 'Locating' dialog box appears and you are able to locate a 
certain file or directory. For the text editor and the file viewer: The 'Go To' dialog box appears and you can 
enter the position to which the cursor is to be moved. (Note: In the text editor or in the text-view of the file 



viewer, you can enter a line number. In the hex-view of the file viewer, you can give the offset to the 
beginning of the file. You can use decimal as well as hexadecimal numbers. The following formats are 
supported for hexadecimal numbers: '0xf034', '1a43h' or '$b435'.)



j) Configuring the Text Editor
- Keyboard Shortcuts: Editing with the Text Editor

1.) When entering text

- Delete... Erases the character at the current cursor location. (Note: If 'non permanent selection' is 
enabled and there is a selection, the selected part of the text is removed.)

- Backspace... Erases the character left of the cursor. (Note: If 'non permanent selection' is enabled and 
there is a selection, the whole selected part of the text is removed.)

- Control + Y... Erases the current line. (Note: If 'non permanent selection' is enabled and there is a 
selection, the whole selected part of the text is removed.)

- Enter / return... New line. (Note: If 'non permanent selection' is enabled and there is a selection, the 
whole selected part of the text is removed.)

- Tab... Inserts spaces from the current cursor location up to the next tab stop position. (Note: If 'non 
permanent selection' is enabled and there is a selection, the whole selected part of the text is removed.)

- Control + T... The 'Tab Stops' dialog box appears.

- Control + Q, l... Changes the character at the current cursor location to lower case.

- Control + Q, u... Changes the character at the current cursor location to upper case.

2.) Undo and Redo

- Alt + Backspace...
- Control + Z... Takes back the last action (undo).

- Shift + Alt + Backspace... Revoke the last undo action (redo).

3.) File Handling

- Control + K, l... Opens a new file.

- F2...
- Control + S...
- Control + K, s... Saves the text under the current filename.

- Control + K, x... Saves the text under the current filename and quits the editor.

- Control + P... Prints the text.

- Esc...
- Alt + X...
- Alt + F4...
- Control + K, q... Quits the editor.





- Keyboard Shortcuts: Selecting a Part of a Text or Display Area

By using the following keyboard shortcuts you can select a part of the text in the text editor or a part of the
display area in the hex-view of the file viewer.

- Selecting while moving the cursor... Keep the shift key pressed down while moving the cursor to 
select that part of the text that is crossed over by the cursor. (See also: Keyboard Shortcuts: Moving the 
Cursor.)

- Control + K, b... Sets the beginning of the selection at the current cursor location.

- Control + K, k... Sets the end of the selection at the current cursor location.



j) Configuring the Text Editor
- Keyboard Shortcuts: Working on a selected Part of a Text

- Shift + Delete...
- Control + X... Erases the selected part of the text and copies the selection to the clipboard.

- Control + Insert...
- Control + C... Copies the selection to the clipboard.

- Shift + Insert...
- Control + V... Inserts text from the clipboard at the current cursor location.

- Control + Delete...
- Control + K, y... Erases the selected part of the text.

- Control + K, c... Copies the selected part of the text to the current position of the cursor.

- Control + K, v... Moves the selected part of the text to the current position of the cursor.

- Control + K, i... Indents the selected part of the text. A space is inserted at the beginning of each line.

- Control + K, u... Unindents the selected part of the text. A space is removed at the beginning of each 
line, as long as spaces are available.

- Control + K, r... Inserts a file at the current position of the cursor.

- Control + K, w... Saves the selected part of the text to a file.

- F4... Opens a new editor with the selected part of the text.

- Control + K, p... Prints the selected part of the text.



- Keyboard Shortcuts: Finding and Replacing Text, Finding Patterns

By using the following keyboard shortcuts, you can control the search or the replace process of strings as 
well as the search for patterns

- F7...
- Control + F...
- Control + Q, f...
- Alt + F3... The dialog box for setting the parameters of a search process appears.

- Control + Q, a...
- Control + R... The dialog box for setting the parameters of a replace process appears.

- Control + N...
- Control + L...
- Control + W...
- Shift + F7...
- F3... Restarts the last search or replace process beginning at the current cursor location.



VI. Tools
VI.4. The File Viewer

T.N.T.'s integrated file viewer offers two display modes to show the contents of a file:

1.) A text view, using either the ANSI or OEM character set.

2.) A hex view to show the contents of a file in the form of a hex-dump and to edit the file on the byte level.

Besides, the viewer is able to work as a multi-file viewer on any number of files in both modes and you 
can search the displayed files for byte patterns.

a) Opening the File Viewer
b) The Hex-View of the File Viewer
c) The Text-View of the File Viewer
d) Switching the Files when Using the Multi-File Viewer
e) Editing Files in the Hex-View of the File Viewer
f) Finding Patterns in the File Viewer
g) Working on a Selected Part of the Display in the File Viewer
h) Drag-and-Drop: Text
i) Configuring the File Viewer
j) Keyboard Shortcuts: File Viewer

Warning! If you want to use the file viewer to modify files on the byte level, you are supposed to have 
detailed knowledge of the contents and the structure of the corresponding files. As far as the data carrier 
is concerned, each file consists only of a sequence of numeric values or pieces of information, so-called 
'bytes'. How these bytes are combined to larger entities and how they are to be interpreted depends on 
the file type as well as on the programs that use the file. If you have knowledge of the structure of a file 
type, you can find, analyze and modify certain parts of a file. If you don't have knowledge of a file type, 
never modify a file. Otherwise the file will no longer serve its purpose. A program file that was modified 
incorrectly will no longer execute. A document may become unreadable.





VI.4. The File Viewer
a) Opening the File Viewer

1.) Opening a File Viewer for a Single File

Click the entry of the file in a display window with the right mouse button and choose 'Viewer' from the file 
context menu.

2.) Opening a Multi-File Viewer

Select the desired entries in a display window. Click one of the selected entries with the right mouse 
button and choose 'Viewer' from the directory context menu. A dialog box then appears in which you can 
set further parameters for the multi-file viewer. (Note: If you select or click a directory, all files within the 
directory are displayed automatically.)

Note: Depending on the analysis of the contents of the (first) file, either the hex-view or the text-view of 
the file viewer is activated. (The hex-view is used if the file contains characters or numeric values that can
be displayed neither with the ANSI character set nor with the OEM character set.) Nevertheless you are 
able to switch the view-mode regardless of the file type at any time.



VI.4. The File Viewer
b) The Hex-View of the File Viewer

Note: In order to switch from the text-view to the hex-view, choose 'Hex' from the menu bar.

1.) The Offsets

The first column shows the offset of the first byte of each line to the beginning of the file. To switch from 
the decimal to the hexadecimal display of the offsets and vice versa, choose 'Decimal' from the 'File' 
menu or press 'Control + D'.

2.) The Hex-Display

In the mid-part of the window, the contents of the current file are shown in the form of a hex-dump. 
Depending on the width of the window, each line shows eight or sixteen bytes, arranged to groups of four 
bytes (4 bytes = 1 dword).

3.) The Text-Display

On the right, the contents of the file are shown as a text, displayed either with the ANSI character set or 
with the OEM character set. Numeric values that cannot be displayed by means of the current character 
set are represented by a dot '.'. To switch the character set, ANSI or OEM, choose 'OEM' from the 'File' 
menu. (See also: ANSI and OEM, Displaying and Converting.)

4.) The Status Bar

The status bar on the lower margin of the window shows the following pieces of information:

- P(osition)... The current cursor location, relative to the beginning of the file. To switch from the decimal 
to the hexadecimal display of the offsets and vice versa, choose 'Decimal' from the 'File' menu or press 
'Control + D'.



- B(yte)... The decimal byte value at the current cursor location. To switch from the signed to the unsigned
display and vice versa, choose 'Signed' from the 'File' menu or press 'Control + V'.

- W(ord)... The decimal word value (2 bytes) at the current position of the cursor. To switch from the 
evaluation according to the 'little endian' format (e.g. INTEL®) to the evaluation according to the 'big 
endian' format (e.g. Motorola®) and vice versa, choose 'Motorola' from the 'File' menu or press 'Control + 
M'. (For switching signed / unsigned display, see above.)

- D(word)... The decimal dword value (4 bytes) at the cursor location. (For switching 'little endian' / 'big 
endian' evaluation and signed / unsigned display, see above.)

- ANSI / OEM... Identifies the character set that is currently in use. To switch from the ANSI to the OEM 
character set and vice versa, choose 'OEM' from the 'File' menu or press 'Control + O'.

See also: Keyboard Shortcuts: Hex-View of the File Viewer



VI.4. The File Viewer
c) The Text-View of the File Viewer

Note: To switch from the hex-view to the text-view, choose 'Text' from the menu bar.

The text view of the file viewer shows the contents of a file by using the ANSI or the OEM character set. If 
the file contains numeric values that cannot be displayed by means of the current character set, a space 
is shown. To switch from the ANSI to the OEM character set and vice versa, choose 'OEM' from the 'File' 
menu or press 'Control + O'. (See also: ANSI and OEM, Displaying and Converting.)

1.) Maximum Length of a Line and New Lines

A new line is begun if either a carriage return or a line feed occurs or if the length of the current line 
exceeds the given limit. (Note: If a line feed follows a carriage return or vice versa, there is only one new 
line.)
To change the maximum length of a line, choose 'Maximum Length' from the 'File' menu or press 'Control 
+ M'. (Note: When changing the maximum length, the optimal length, according to the current size of the 
window, is preset.)

2.) Line Numbers

Consecutive line numbers can be displayed at the beginning of each line. To enable (or disable) the line 
numbers, choose 'Line Numbers' from the 'File' menu or press 'Control + Z'.

3.) Tab Characters

Tab characters are replaced by the corresponding number of spaces, up to the next tab stop position. To 
change the distance between the tab stop positions, choose 'Tab Stops' from the 'File' menu or press 
'Control + T'.

4.) The Status Bar



The status bar on the lower margin of the window shows the following pieces of information:

- Tab Characters... The distance between the tab stop positions.

- ANSI / OEM... Identifies the character set that is currently in use. To switch from the ANSI to the OEM 
character set and vice versa, choose 'OEM' from the 'File' menu or press 'Control + O'.

See also: Keyboard Shortcuts: Text-View of the File Viewer



VI.4. The File Viewer
d) Switching the Files when Using the Multi-File Viewer

If the file viewer is used as a multi-file viewer, there are four buttons on the lower margin of the window, 
which can be used to switch from one file to another one. (Note: Files in the same directory are traversed 
in alphabetical order. If there are also files from several directories, the directories are traversed in 
alphabetical order, too.)

- Show the first file or the last one... Choose the 'First' or the 'Last' button to jump to the corresponding 
file.

- Show the previous file or the next one... Choose the 'Previous' or the 'Next' button to show the 
corresponding file.
 



VI.4. The File Viewer
e) Editing Files in the Hex-View of the File Viewer

Note: In the hex-view of the file viewer files can be edited on the byte level. To edit text files, activate the 
text view and choose 'Editor' from the 'File' menu.

Warning! If you want to use the file viewer to modify files on the byte level, you are supposed to have 
detailed knowledge of the contents and the structure of the corresponding files. As far as the data carrier 
is concerned, each file consists only of a sequence of numeric values or pieces of information, so-called 
'bytes'. How these bytes are combined to larger entities and how they are to be interpreted depends on 
the file type as well as on the programs that use the file. If you have knowledge of the structure of a file 
type, you can find, analyze and modify certain parts of a file. If you don't have knowledge of a file type, 
never modify a file. Otherwise the file will no longer serve its purpose. A program file that was modified 
incorrectly will no longer execute. A document may become unreadable.

To enable editing in the hex-view, choose 'Edit' from the 'File' menu or press 'Control + E'.

1.) The Cursor

By clicking somewhere in the display area of the file viewer (the hex-display as well as the text-display) 
with the left mouse button or by means of the 'usual' keyboard shortcuts, you position the cursor. If the 
cursor is moved across the upper or the lower border of the display area, the visible part of the file is 
scrolled in the corresponding direction. (See also: Keyboard Shortcuts: Moving the Cursor.) To switch the 
cursor from the hex-display to the text-display and vice versa, press the 'Tab' key. (Note: When using the 
multi-file viewer, you have to press the 'Tab' key repeatedly as the keyboard focus first will proceed to the 
buttons on the lower margin of the window.)

2.) Modifying the Data in the Hex-Display

If the cursor is within the hex-display, you can only modify one half-byte (so-called 'nibble') at a time, by 
entering a hexadecimal digit, '0' to '9' or 'A' to 'F'. Modified bytes are displayed in the color that is used for 
stressed items (default: carmine).

3.) Modifying whole Bytes, Words or Dwords.

To enter a new value for the whole byte, word (2 bytes) or dword (4 bytes) at the current position of the 
cursor, choose 'Modify Bytes' from the 'Edit' menu or press 'Control + B'. The 'Modify Bytes' dialog box 
then appears and you can select whether to modify a byte, a word or a dword and enter the new value. 
(Note: You can enter decimal as well as hexadecimal numbers, with or without sign.)
Choose 'OK' to modify the bytes. Whether bytes are to be evaluated according to the 'little endian' format 
(e.g. INTEL®) or according to the 'big endian' format (e.g. Motorola®) is considered automatically. (Note: 
To switch 'little endian' / 'big endian', choose 'Motorola' from the 'File' menu or press 'Control + M'.)

4.) Modifying the Data in the Text-Display

If the cursor is within the Text-Display, you can modify the current byte by entering a new character. 
Modified bytes are displayed in the color that is used for stressed items (default: carmine).

5.) Undoing Modifications



To take back the modification of a byte, move the cursor behind the corresponding character and press 
'Backspace' or move the cursor in front of the character and press 'Delete'.

6) Writing the Modified File

Modified bytes or characters are not written to the file immediately, but instead are saved in an internal 
buffer. The size of this buffer is limited to 256 bytes. If this buffer is full, a notification appears and you can
decide whether to write the modifications to the file or not. The same notification appears

- as soon as you switch from the hex-view to the text view.
- when editing is deactivated.
- when another file is to be displayed in the multi-file viewer.
- as soon as you quit the file viewer.

Warning! If you reject writing the file, all modifications are lost. If you allow writing the file, the file is 
modified permanently.

7.) Inserting a File

You can paste any file into the file that is currently displayed. Corresponding to the size of the file to be 
loaded, the data of the displayed file is overwritten. To paste a file, position the cursor on the first byte that
is to be overwritten and choose 'Open' from the 'Edit' menu or press 'Control + K r'.
Warning! When pasting a file, the displayed file is modified immediately. The changes are directly written 
to the file. (Note: The size of the file to be loaded may not be larger than the space remaining from the 
current position of the cursor to the end of the displayed file.)



VI.4. The File Viewer
f) Finding Patterns in the File Viewer

To search the displayed files for a pattern of characters or values, choose 'Find' from the 'Find' menu or 
press 'Control + Q f', 'Control + F' or 'Alt + F3'. The 'Find Pattern' dialog box then appears and you can 
enter the search pattern and set further parameters for the search process.

See also:

- Entering a Search Pattern
- Case-sensitive
- Whole words only
- Search backwards

Press the 'OK' button to start the search process. If the pattern has been found, the corresponding part of 
the file is shown and the matching string is selected. To find the next occurrence of the search pattern, 
choose 'Again' from the 'Find' menu or press 'Control + L', 'Control + N', 'Control + W' , 'Shift + F7' or 'F3'.

Note: When Searching through a Number of Files

If the viewer works as a multi-file viewer on several files, the search process continues with the next file if 
the search pattern does not occur again in the current file. If Search backwards is enabled, the search 
process continues at the end of the previous file, otherwise at the beginning of the next file.



VI.4. The File Viewer
g) Working on a Selected Part of the Display in the File Viewer

Any part of the display of the file viewer can be selected and worked upon by a number of commands.

1.) Selecting a Part of the Display by Using the Mouse

In order to select a part of the display, move the mouse pointer to the beginning (or the end) of the 
desired area and press the left mouse button. Keep the button pressed and move the mouse in any 
direction. The part of the display that is crossed with the mouse, is then underlain with the color used for 
selected items (default: light blue). If the mouse pointer is moved across the border of the display area, 
the visible part of the file is scrolled in the corresponding direction. Drag the mouse pointer over the last 
(or the first) character to be selected and release the mouse button. (Note: The beginning (the end) of the 
selection can also be set by double-clicking a character with the left (right) mouse button. To select the 
whole display of the current file, choose 'Select All' from the 'Edit' menu.)

2.) Working on the Selected Part of the Display

You will find the following commands to work on the selected part of the display in the 'Edit' menu or in the
context menu that is opened by clicking the selection with the right mouse button.

- Copy... Copies the selection to the clipboard.

- Save As... Saves the selection to a file. (Note: In this case, no text copy of the display is created, as it is 
when printing the selection, but a file copy of the byte values. So, if you select the whole file and save the 
selection, you get an identical copy of the file.)

- Print... Prints the selection.

- Editor... Opens a text editor with the selection.

For the corresponding keyboard shortcuts as well as for further information on working on a selected part 
of the display refer to:

- Keyboard Shortcuts: Selecting a Part of a Text or Display Area
- Keyboard Shortcuts: Text-View of the File Viewer
- Keyboard Shortcuts: Hex-View of the File Viewer
- Drag-and-Drop: Text



VI.4. The File Viewer
h) Drag-and-Drop: Text

In order to drag a text item from a window of T.N.T., move the mouse pointer over the source item, press 
the right mouse button and keep it pressed. Then move the mouse pointer over the target and release the
mouse button to drop the text.

1.) Source Items

- The file viewer... Click the selected part of the display area to create a copy of the selection. (Note: 
Click anywhere outside the selection to create a copy of the whole display of the current file.)

- The text editor... Click the selected part of the display area to create a copy of the selection. (Note: 
Click anywhere outside the selection to create a copy of the whole text.)

- The status bars of display windows... Click the upper status bar to create a list of all entries shown in 
the folder pane of the window. Click the lower status bar to create a list of the selected entries only. (See 
also: Drag-and-Drop: Status Bars of Display Windows.)

- Files or directories in a display window... Click any entry of the window to create a string with the 
corresponding filename or directory name. (Note: Whether a filename or a directory name being dragged 
is interpreted as a text item or as a file item depends on the target item of the drag-and-drop process. 
Generally, they are interpreted as a file item.)

2.) Target Items

- 'Print' commands in the control window's command bar or in the Command Templates window... 
A command for Printing files and texts is executed.

- 'Editor' commands in the control window's command bar or in the Command Templates 
window... A new text editor is opened.

- Editor windows... The text is inserted at the current location of the mouse pointer.

- Any other program or application accepting text items via drag-and-drop... The text is passed to 
the application.



VI.4. The File Viewer
i) Configuring the File Viewer

In order to use the current configuration of the file viewer as the default for future viewers, choose 
'Current Layout as Default' from the 'File' menu. The layout of the file viewer includes the size of the 
window as well as the following parameters:

- The tab stop positions... Choose 'Tab Stops' from the 'File' menu in the text-view to change the 
distance between the tab stop positions. (See also Tab Characters and the Text Editor.) 

- The maximum length of a line... To change the maximum length of a line, choose 'Maximum Length' 
from the 'File' menu in the text-view.

- Displaying line numbers... Choose 'Line Numbers' from the 'File' menu in the text-view to enable or 
disable the display of line numbers.

- Signed or unsigned display of values... To switch from the unsigned display to the signed display of 
values in the status bar and vice versa, choose 'Signed' from the 'File' menu in the hex-view.

- Evaluation of hex-values according to the 'little endian' or the 'big endian' format... To switch from 
the evaluation according to the 'little endian' format (e.g. INTEL®) to the evaluation according to the 'big 
endian' format (e.g. Motorola®) and vice versa, choose 'Motorola' from the 'File' menu in the hex-view.

- Decimal or hexadecimal display of offsets... Choose 'Decimal' from the 'File' menu in the hex-view to 
switch from the decimal display of the offsets to the hexadecimal display and vice versa.



VI.4. The File Viewer
j) Keyboard Shortcuts: File Viewer

- Keyboard Shortcuts: Moving the Cursor
- Keyboard Shortcuts: Scrolling the Text-View of the File Viewer
- Keyboard Shortcuts: Selecting a Part of a Text or Display Area
- Keyboard Shortcuts: Text-View of the File Viewer
- Keyboard Shortcuts: Hex-View of the File Viewer
- Keyboard Shortcuts: Finding and Replacing Text, Finding Patterns



- Keyboard Shortcuts: Scrolling the Text-View of the File Viewer

- Cursor left... Scrolls one column to the left.

- Cursor right... Scrolls one column to the right.

- Cursor up... Scrolls one line upwards.

- Cursor down... Scrolls one line downwards.

- Home...
- Shift + Home... Scrolls completely to the left.

- End...
- Shift + End... Scrolls completely to the right.

- PgUp... Scrolls upwards, to the previous page.

- PgDn... Scrolls downwards, to the next page.

- Control + PgUp...
- Control + Home... Jumps to the beginning of the file.

- Control + PgDn...
- Control + End... Jumps to the end of the file.

- Control + G... The 'Go To' dialog box appears and you can enter the line number of the first line to be 
displayed. (Note: You can enter decimal as well as hexadecimal numbers. Accepted hexadecimal formats 
are: '0xf034', '1a43h' or '$b435'.)



j) Keyboard Shortcuts: File Viewer
- Keyboard Shortcuts: Text-View of the File Viewer

- Control + E... Opens a text editor with the currently displayed file. (Not available if the file contains 
characters that cannot be displayed.)

- Control + P... Prints the whole display of the file.

- Control + T... The 'Tab Stops' dialog box appears.

- Control + M... The 'Maximal Length' dialog box appears and you can set the maximal length of a line. If 
this length is exceeded, the line is split and a new line is begun.

- Control + O... Switches from the ANSI character set to the OEM character set and vice versa. (See also
ANSI and OEM, Displaying and Converting.)

- Control + Z... Enables or disables line the display of numbers.

- Control + C... Copies the selected part of the display to the clipboard.

- Control + K w... Saves the selected part of the display to a file. (Note: In this case, no text copy of the 
display is created as it is when printing the selection, but instead a file copy of the byte values. Thus, if 
you select the whole file and save the selection, you get an identical copy of the file.)

- Control + K p... Prints the selected part of the display.

- F4... Opens a text editor with the selected part of the display.

- Esc...
- Alt + F4...
- Alt + X... Quits the file viewer.



j) Keyboard Shortcuts: File Viewer
- Keyboard Shortcuts: Hex-View of the File Viewer

- Control + P... Prints the whole display of the file.

- Control + O... Switches from the ANSI character set to the OEM character set and vice versa. (See also
ANSI and OEM, Displaying and Converting.)

- Control + M... Switches from the evaluation of hex-values according to the 'little endian' format (e.g. 
INTEL®) to the evaluation according to the 'big endian' format (e.g. Motorola®) and vice versa.

- Control + V... Switches from the unsigned display to the signed display of values in the status bar and 
vice versa.

- Control + D... Switches from the decimal display of offsets to the hexadecimal display and vice versa.

- Control + C... Copies the selected part of the display to the clipboard.

- Control + K w... Saves the selected part of the display to a file. (Note: In this case, no text copy of the 
display is created as it is when printing the selection, but instead a file copy of the byte values. Thus, if 
you select the whole file and save the selection, you get an identical copy of the file.)

- Control + K p... Prints the selected part of the display.

- Control + E... Enables editing the file.

- Control + B (when editing is enabled only)... The 'Modify Bytes' dialog box appears and you can 
select whether to modify a byte, a word or a dword at the current location of the cursor and enter the new 
value.

- Control + K r (when editing is enabled only)... Pastes a file at the current position of the cursor. 
Warning! When pasting a file, the displayed file is modified immediately. The changes are directly written 
to the file.

- Delete (when editing is enabled only)... Takes back the modification of the byte at the current position 
of the cursor.

- Backspace (when editing is enabled only)... Takes back the modification of the byte left to the cursor.
 
- Esc...
- Alt + F4...
- Alt + X... Quits the file viewer.



VI. Tools
VI.5. The Command Line

By means of the T.N.T. command line, you can start external applications, DOS and Windows® programs,
quickly and directly.

Top open the command line from an any Window® application, press 'Control + Alt + F9'. (Note: To use 
the Windows key instead of 'Control + Alt' for calling global shortcuts, check the corresponding check box 
on the 'General' page of the 'Settings' property sheet.) To open the command line from a display window, 
press 'Alt + F9'. (Note: In this case, the current directory of the window becomes the current directory of 
the command line.)

On the left of the command line window, the current directory is displayed. In the edit control to the right of
the path, you can enter commands to navigate through the directory hierarchy and to start applications. In
principle, you can use the command line in exactly the same way that you use the DOS prompt. Changing
the current directory and running programs is done by means of the usual keyboard shortcuts. In addition 
to that, the following special keyboard shortcuts and functions are available:

- Changing the current directory... You can change the current directory simply by entering the name of
the (sub-) directory and pressing Return/Enter. Besides, the commands 'cd', 'cdd' and 'chdir' are accepted
equally. However, it is not necessary to enter one of them. (Note: If you enter 'cd <drive letter>:', in 
contrast to the DOS prompt, not only the current directory of the drive is changed, but the current path of 
the command line is switched to the corresponding drive.)

- Executable files... All files having one of the following filename extensions are considered to be 
executable: '.EXE', '.COM', '.BAT', '.BTM', '.LNK', '.PIF' and (for Windows® NT4.0 only) '.CMD'.

- Going through the entries of the current directory... By using the keyboard shortcuts 'Tab' and 'Shift 
+ Tab' you can go through the entries of the current directory in alphabetical order. By default, the 
subdirectories are displayed first, then the executable files are displayed. Note: If you want to see only 
files of a certain type or files that match a certain filename pattern, enter the desired pattern (e.g. '*.bmp' 
to go through bitmap files) and press 'Tab'. To return to the default mode (subdirectories and executable 
files are displayed), clear the edit control completely and press the 'Tab' key again.

- Most recently used commands (history)... By pressing 'Alt + F8', you can open a context menu that 
contains the most recently used commands. Choose one of the options to execute the corresponding 
command again.

- Executing the internal T.N.T. file commands... By clicking the current directory to the left of the 
command line with the right mouse button, you can open the context menu of the directory. If you choose 
an option from the menu, the corresponding command is started and the current directory is passed to the
command. Besides, in the command line, the same keyboard shortcuts are available as in the tree pane 
of a display window to start file commands. For a list of the keyboard shortcuts refer to Keyboard 
Shortcuts: Executing Commands.

- Re-Opening the command line after the execution of a command... If the 'Re-Open after execution' 
check box on the 'Commands' page of the 'Settings' property sheet is checked, the command line re-
opens automatically as soon as the program that was started via the command line is finished. To invert 
the setting of this option once, start the program by pressing 'Alt + Enter/Return'.



- Close DOS boxes automatically... If the 'Close DOS boxes automatically' check box on the 
'Commands' page of the 'Settings' property sheet is checked, a DOS box that was opened via the 
command line is closed automatically as soon as the program terminates. To invert the setting of this 
option once, start the program by pressing 'Shift + Enter/Return'.



VI. Tools
VI.6. Registered File Types

Under Windows®, the type of a file is determined by the extension of the filename. If a file type is 
registered, corresponding files can be opened or executed directly, e.g. by clicking the file with the left 
mouse button. Then the application for which the file type was registered is run automatically and the 
filename is passed as a parameter. If you open the context menu of a file within T.N.T., the first option of 
the context menu shows the name of the application if the type of the file is registered.

To open the dialog box for editing the registered file types, click the button or the icon of 'The Next Tool' in 
the taskbar with the right mouse button and choose 'Registered File Types' from the 'Configuration' 
submenu of the main menu. (Note: If you create or modify registered file types by using 'The Next Tool', 
these modifications also affect other applications and Windows® itself. For instance, you can open files 
whose type was registered with T.N.T. by double-clicking the file on the desktop or in the Windows® 
Explorer, as well.)

In the upper part of the dialog box, you see a list of all file types currently registered. For each type, the 
following pieces of information are shown: the corresponding icon, the file extension that defines the type,
the description of the file type and the command that starts the application for which the file type was 
registered. To register a new type or modify an existing one, proceed as follows:

- Registering a file type... Enter the filename extension that defines the type in the 'Extension' edit 
control. Enter the path of the application for which the file type is to be registered and, if necessary, 
additional parameters in the 'Command' edit control. In the 'Description' edit control, you can enter a short
description of the file type that will, for instance, appear in the context menu of corresponding files. To 
register the file type, press the 'Create' button.

- Modifying a registered file type... To modify a registered file type, click the corresponding entry in the 
list of file types with the left mouse button or drag a file of the corresponding type out of a display window 
and drop it onto the 'Extension' edit control. Thereupon, the data of the file type are shown in the 



'Command' and the 'Description' edit controls. As soon as you have modified the data as desired, press 
the 'Create' button to register the new data.

- Deleting a registered file type... To cancel the registration of a file type, click the corresponding entry in
the list of file types with the right mouse button and choose 'Delete' from the context menu or move the 
cursor of the list onto the corresponding entry by using the cursor keys and press the 'Delete' key.

Warning! If you want to modify or delete file types that were registered by other applications or by 
Windows® itself, make sure that the registration of the type is not necessary for Windows® or for other 
applications to execute correctly.



VI. Tools
VI.7. Creating a Directory Path

To create a directory, an empty archive or an empty disk image, click the directory in which the new (sub-)
directory is to be created in a display window with the right mouse button and choose 'Directory' from the 
'Create' submenu of the context menu. Thereupon a dialog box appears in which you can enter the 
desired directory path. To create the path, press the 'Create' button.

Note: To create an empty archive or an empty disk image, enter the desired filename with a colon ':' at the
end. If you enter a filename with one of the default extensions ('.ZIP', '.RAR', '.LHA', '.LZH', '.LZS', '.ARJ', 
'.TAR', '.GZ', or '.TGZ' for archives or '.TNT' and '.VCP' for disk images), the archive is automatically 
created with the corresponding format. Otherwise, a notification appears and you can choose the type of 
the archive (normal archive, self-extracting archive or disk image). See also: 'Archives' and Disk Images



VI. Tools
VI.8. Executing External Programs or Applications

By using 'The Next Tool's execute function you can run external programs or applications. When 
executing the program, any type of parameter (e.g. filenames or directory names that were passed via 
drag-and-drop) can be forwarded.

There are six edit controls in the 'Execute' dialog box in which you can enter the path of the program that 
is to be executed, the directory that is to be current when the program is executed and four arbitrary 
strings that are passed to the program as parameters.
Behind each of the edit controls, there is a check box. If you check these boxes, a parameter that is 
passed when the program is executed is transferred to the corresponding edit control and evaluated 
according the type of the edit control. (i.e. the parameter is considered to be the program, the directory or 
a parameter.) For instance, you can pass a file or a directory via drag-and-drop or by choosing the 
desired 'Execute' command from the context menu of the corresponding entry in a display window. (See 
also: User-Defined Menus.)

For example: If a file named 'C:\Info.txt' is passed to the command that is shown above, 'D:\Database' is 
the current directory for the start of the program 'DataManager.exe' and the following command is 
executed:

C:\Program Files\DataManager.exe /macro:Diag -F +P /file:C:\Info.txt

Note: In certain situations, 'Execute' commands are created automatically or run implicitly. In these cases,
the dialog box that is shown above does not appear at all. The 'Immediately' check box is automatically 
activated and the dialog box remains hidden because the options and parameters can be derived from 
the context in which the command is executed. Some examples for such situations are:

1.) If you open a file directly by double-clicking the filename in a display window with the left mouse 
button, an 'Execute' command is run implicitly and executed immediately.

2.) If you create a command for opening a file in a user-defined menu or in the command bar of the 
control window by using drag-and-drop, an 'Execute' command is created automatically. (See also: 
Importing Commands.) To modify the options or the parameters for the execution of the command, click 
the command with the right mouse button and choose 'Redefine' from the context menu.



For further information about executing external programs, refer to the following chapters:

- Naming the File that is to be Executed
- Naming the Current Directory for the Execution of External Programs
- Entering Parameters for the Execution of External Programs
- Options for the Execution of External Programs
- Redefining a Command for the Execution of External Programs



VI.8. Executing External Programs or Applications
- Naming the File that is to be Executed

When setting the options for executing external programs or applications, you can enter the path and, if 
necessary, the path of the file that is to be executed or opened in the 'Program' edit control. The set of 
files, which is considered for execution, can be divided in two groups:

1.) If the file itself is executable (i.e. it is a file with one of the following filename extensions: '.BAT', '.COM',
'.EXE' or '.PIF'), the file is executed directly.

2.) If the file itself is not executable, but it is a registered file type, the application for which the file type 
was registered is executed and the path of the file is passed to the application. (See also Registered File 
Types.)

Note: The file that is to be executed can be in an archive or in a disk image. In this case the file is 
automatically extracted to a temporary directory, executed and (if possible) automatically removed when 
quitting T.N.T. or at the next start of Windows®. However, please note that only the file itself is extracted 
automatically. If further files are necessary to execute the file, extract the whole archive to any 
(temporary) directory and execute the application afterwards.



- Naming the Current Directory for the Execution of External Programs

When setting the options for executing external programs or applications, you can enter the path of the 
directory that is to be the current directory when the external program is executed in the 'Directory' edit 
control. (Note: This does not have to be the same directory as the directory of the program itself.)



VI.8. Executing External Programs or Applications
- Entering Parameters for the Execution of External Programs

When setting the options for executing external programs or applications, there are four 'Parameter' edit 
controls. In these edit controls, you can enter arbitrary strings that are passed to the application that is 
executed. (Note: Please note that T.N.T. cannot check whether or not these parameters are correct as 
they can be completely arbitrary. The way the parameters are evaluated only depends on the executed 
program. If you pass faulty or undefined parameters to an application, unwanted effects may be the 
result.)

If the check box to the right of one of the 'Parameter' edit controls is checked, a filename or a directory 
name that is passed when executing the command is transferred to the corresponding edit control. In this 
case, the preset contents of the edit control are overwritten. (See also: Redefining a Command for the 
Execution of External Programs.) Passing a file or a directory to a command can be done, for instance, 
via drag-and-drop or by choosing the command from the context menu of an entry in a display window.



VI.8. Executing External Programs or Applications
- Options for the Execution of External Programs

When setting the options for executing external programs or applications you can influence the way in 
which the program is executed by means of the following check boxes:

- Running the application minimized... Check the 'Minimized' check box if the external program is to be 
started minimized. (Note: It depends on the external program whether or not it will follow the parameter.)

- Running the application maximized...Check the 'Maximized' check box if the external program is to be
started maximized or in the full-screen state. (Note: It depends on the external program whether or not it 
will follow the parameter.)

- Immediately executing the program... Check the 'Immediately' check box if the external program is to 
be started immediately and directly when the 'Execute' command is executed. In this case, the dialog box 
for setting the options and parameters does not appear any more.

Note: Enabling or disabling the 'Immediately' feature only has an effect if it is done while redefining the 
command. (See also: Redefining a Command for the Execution of External Programs.) In the case of 
'Execute' commands that are created implicitly (e.g., if you open a file directly by double-clicking the 
filename in a display window with the left mouse button or create a command for opening a file in a user-
defined menu or in the command bar of the control window), immediate execution is enabled 
automatically as all necessary parameters can be determined from the context. 



VI.8. Executing External Programs or Applications
- Redefining a Command for the Execution of External Programs

If you use drag-and-drop to create a new command (for starting an external program or for opening a file) 
in a user-defined menu or in the command bar of the control window, a command for executing external 
programs or applications is created automatically. (See also Importing Commands.)
To modify the options that are available for the execution of the external program or the parameters that 
are passed to the application, click the command with the right mouse button and choose 'Redefine' from 
the context menu. Thereupon the dialog box appears in which you can set the options and parameters for
the 'Execute' command. (Note: If the 'Execute: Immediately' check box is checked, you do not see this 
dialog box when executing the command.) Set the options and enter the parameters just the way they are
to be used for the execution of the external program in the future. Press the 'OK' button to accept the 
configuration of the command.

See also:

- User-Defined Commands
- User-Defined Menus



VII. Searching

'The Next Tool' offers the following features to search and find certain files and directories in various 
situations:

VII.1. File Find and Find in Files... To    search through any number of directories for files that match a 
certain file pattern or contain a certain string. The files that are found during the search process are 
displayed in a search-result window where they can be worked upon further.

VII.2. Locating Files and Directories... By means of the 'Locate' dialog box, you can quickly find files and 
directories which may be somewhere in the directory hierarchy, on the basis of a part of their name in 
order to switch the current directory of a display window or to locate a source or a target for a file 
command if its exact path is unknown.

VII.3. Browsing through the Directory Hierarchy... By using the browse dialog box you can search through
the directory hierarchy to select a file or a directory, whenever a source or a target directory or a file is 
asked for.



VII. Searching
VII.1. File Find and Find in Files

By means of a file find and find in files command you can search through any number of directories for 
files that match a certain file pattern or contain a certain string. The files that are found during the search 
process are displayed in a search-result window where they can be worked upon further.
To search through a single file or a single directory, choose 'Search' from the context menu of the 
corresponding entry in a display window. If you want to search through a number of files or directories, 
select the desired entries with the left mouse button and choose 'Search' from the context menu of one of 
the selected entries.

The following features are available for file find and find in files commands:

- The Source Files and Directories for a Search Task
- Entering the File Find Criteria
- Entering a Search Pattern
- Case-sensitive
- Whole words only
- Entering the Search Pattern by Using the ANSI or the OEM Character Set
- Searching through Archives also
- Apply the File Pattern
- Ignore Subdirectories
- Use the Contents Instead of the Directory

To start the search process, press the 'Search' button on the lower margin of the dialog box. The search 
process is divided into several phases. If you enter more than one source directory, the directories are 
worked on separately. For each source directory a search-result window is opened which contains the 
files that were found in the corresponding directory or in one of its subdirectories. Searching through a 
directory is done in two steps:



1.) File find... During this phase, the files that match the filename pattern as well as the file pattern are 
determined. If no patterns are named, all files will match. If no search pattern or string is named, the 
search-result window appears, containing all the files that were found.

2.) Find in files... If a search pattern or string is named, the files that were found during the first phase are 
searched through in the second phase of the search process. Meanwhile the progress of the task as well 
as the path of the current file is shown in a progress dialog box. Finally, the search-result window is 
opened, showing the files that contain the pattern.



- The Source Files and Directories for a Search Task

You can enter more than one source directory for a file find and find in files task if you want to search 
through a number of directories or drives in one run. Simply enter the desired paths in the 'Source' edit 
control and separate them by a pipe symbol '|'. For instance, if you want to search through drive 'C:', the 
directory 'D:\DATA\DOCUMENTS' and the directory 'BACKUP' in the archive 'E:\DOCS.ZIP', enter the 
following paths:

C: | D:\DATA\DOCUMENTS | E:\DOCS.ZIP:\BACKUP

To name a number of drives directly, click the drive icon right to the 'Source' edit control. Then a dialog 
box appears in which you can select the desired drives.



- Entering the File Find Criteria

If you are only looking for files of a single type during a file find and find in files process, you can enter a 
single filename pattern in the 'Filename pattern' edit control. (Note: To choose a pattern from the 
collection of patterns, click the small icon right to the edit control with the left mouse button.)
If you are not just looking for file of a single type, but for all files that match a number of filename patterns 
and/or a certain time range and/or a pattern of attributes, check the 'Use the file pattern' check box and 
enter the corresponding data in the File Pattern property sheet.



VII.1. File Find and Find in Files
- Entering a Search Pattern

By means of the 'Text' and the 'Hex' edit controls you can enter a search string or a search pattern in the 
file viewer or for a file find and find in files task. The term that is looked for can contain ordinary characters
(letters, digits and symbols) as well as numeric values between 0 and 255 that have to be entered as 
hexadecimal numbers. By using wildcards that represent one or several arbitrary characters you can form
search patterns.

Note: The picture above shows the dialog box for entering a search pattern in the file viewer. In the case 
of a file find and find in files task, the 'Text' and the 'Hex' edit controls are in the same dialog box in which 
you set up the other options and parameters for the search process, too.

- Wildcards that represent exactly X arbitrary characters '?X'... A wildcard of the form '?X' (X can be a
number from 1 to 10) represents exactly X arbitrary characters or bytes. The wildcard '?3', for instance, 
replaces exactly three characters. To enter a '?X' wildcard, press the 'Control' key together with one of the
function keys: 'F1' to 'F9'. According to the function key, a wildcard, '?1' to '?9', is inserted in the 'Hex' edit 
control. In the 'Text' edit control, the wildcard is displayed by a question mark '?' in the color that is used 
for stressed items.

- Wildcards that represent 0 to X arbitrary characters '*X'... A wildcard of the form '*X' replaces 0 to X 
arbitrary characters. Consequently, the wildcard '*2' replaces none, one or two characters or bytes. To 
enter a '*X' wildcard, press the 'Shift' key together with one of the function keys: 'F1' to 'F9'. According to 
the function key, a wildcard, '*1' to '*9', is inserted in the 'Hex' edit control. In the 'Text' edit control, the 
wildcard is displayed by an asterisk '*' in the color that is used for stressed items.

- Entering the search pattern as a string... In the 'Text' edit control, you can enter the pattern that is 
looked for as an ordinary string. (Note: If you enter a question mark '?' or an asterisk '*', they are not 
considered to be wildcards (see above). In contrast to filenames, where question mark '?' and asterisk '*' 
are wildcards anyway, as they cannot be used to form legal filenames, these characters can appear in a 
search pattern on their own.)

- Entering the search pattern by using hexadecimal numbers... In the 'Hex' edit control, you can enter
the byte values that form the search pattern by means of hexadecimal numbers. As soon as you activate 
the edit control with the left mouse button, a cursor appears and you can enter the desired values by 
using the keys '0' to '9' and 'A' to 'F'. (Note: In the case of values that can be displayed by means of the 
current character set, the corresponding character appears in the 'Text' edit control. Otherwise a dot '.' is 
shown.) If you enter a question mark '?' or an asterisk '*', a wildcard '?1', which replaces exactly one 
character, or a wildcard '*1', which replaces none or one character, is inserted. To enter a wildcard that 
replaces a number of characters, enter '?' or '*' followed by the number of characters.



For instance, to find the strings 'Smith' and 'Smyth', enter the following pattern:

Text: Sm<1?>th

Hex: 53 6D ?1 74 68



- Entering the Search Pattern by Using the ANSI or the OEM Character Set

If you check the 'OEM' check box when setting the options for a file find and find in files task, the 
character codes of the characters that are entered in the 'Text' edit control are considered to be values 
from the OEM character set. Furthermore, the transformation of capital letters and small letters is done 
according to the OEM character set as well, if case sensitive search is disabled. Otherwise every input is 
evaluated using the ANSI character set.



- Searching through Archives also

If you check the 'Also search through archives' check box when setting the options for a file find and find 
in files, archives and disk images are not searched through like normal files but treated as directories. 
That means, that the files and directories that are contained in the archive are searched through as well.



VII. Searching
VII.2. Locating Files and Directories

By means of the 'Locate' dialog box, you can quickly find files and directories, which may be somewhere 
in the directory hierarchy, on the basis of a part of their name in order to switch the current directory of a 
display window or to locate a source or a target for a file command if its exact path is unknown.

To switch the current directory of a display window, choose 'Locate' from the 'Edit' menu or press 'Alt + 
F10'. If you have to enter a directory or a filename in an edit control (e.g. the source or the target of a file 
command), click the small icon right to the edit control with the right mouse button or activate the edit 
control and also press 'Alt + F10', too.

When the 'Locate' dialog box opens, first all entries in the directory hierarchy are displayed, beginning 
with the directory the dialog box was opened with. By using the features described below, you can reduce
the displayed entries step by step until you can see the file or the directory you are looking for. After that, 
position the cursor of the list on the desired entry by using the left mouse button or the cursor keys and 
select the file or the directory by pressing 'Enter/Return'. (Note: Archives are displayed twice, i.e. you will 
find two entries with the name of the archive in the list. An entry with a colon ':' at the end of the filename 
that represents the archive as a virtual directory and an entry without a colon ':' that stands for the archive
as an ordinary file.) 

- Locating entries on the basis of a fragment of their name... While you type the beginning of the 
name of the file or the directory you are looking for in the 'Name' edit control, the entries in the list below 
are reduced step by step. Only those entries (both, files and directories) that begin with the string that has
been entered so far are shown. Complete the name until you can see the desired entry (entries).

- Locating entries on the basis of a filename pattern... If you enter a 'filename pattern' in the 'Name' 
edit control, the list of entries is reduced to those entries that match the pattern. Complete the pattern until
you can see the desired entry (entries).

- Restricting the list of files by a set of filename patterns... You can enter a list of 'filename patterns' in
the 'Pattern' or in the 'Name' edit control to restrict the list of files to those files that match at least one of 



the patterns. (Note: For the patterns to take effect, you have to confirm the input by pressing 
'Enter/Return'.) The patterns have to be separated by a pipe symbol '|'. For instance, enter

*.DOC|*.TXT|*.HLP

to only locate files that have one of these extensions. (Note: To select filename patterns from the internal 
collection of patterns, click the small icon right to the edit control with the left mouse button.)

- Changing the root directory... Enter a complete directory path or the name of a drive in the 'Path' or in 
the 'Name' edit control and press 'Enter/Return' to change the root directory of the 'Locate' dialog box. 
Only entries that are in the root directory itself or in one of its subdirectories are displayed. (Note: To 
change the drive, you can also click the drive icon right to the 'Path' edit control with the left mouse button
and select the desired drive from the drive list.)

- Locating directories and archives only... If you want to locate directories and archives only and files 
are to be left out of account, check the 'Directories only' check box. 

For example:

You know there has to be a file 'Invoice.doc' somewhere on drive 'C:'. But you cannot remember the 
subdirectory and you do not know whether or not there are several copies of the file. To quickly find the 
desired file(s), open the locate dialog box with the root directory 'C:'.
First, you see a list that contains all the files on drive 'C:'. Type '*.doc' in the 'Name' edit control and press 
'Enter/Return' to restrict the list of files to the documents. After that, you can enter the beginning of the 
filename you are looking for to reduce the number of files step by step. Only those files that begin with the
string that has been entered so far are shown.
As soon as you have entered 'in', for instance, you see all files that begin with 'in'. Now, you can possibly 
see that there is no file with the desired name or you already see the file you are looking for. Otherwise 
complete the filename until you get the desired result.



VII. Searching
VII.3. Browsing through the Directory Hierarchy

Whenever you have to name a source or a target directory for a file command or a file is to be loaded or 
saved, you can use the browse dialog box to search through the directory hierarchy and select a file or a 
directory.

By clicking the small icon to the right of an edit control with the left mouse button or by pressing 'Control +
Enter/Return' or 'Control + S' you open the browse dialog box to search the directory hierarchy for a 
certain directory or filename. The entry you finally select is then entered in the edit control.

If, on the basis of the current situation, the target of the search process can be a directory as well as a 
file, the browse dialog box contains a directory pane on the left and a file pane on the right. If only a 
directory is asked for, the file pane is omitted.

- Browsing for directories and archives... In the directory pane of the dialog box, the directory 
hierarchy (including archives and disk images) is displayed, beginning with the root directory of the 
current drive. By clicking an entry with the left mouse button, you can change the current directory, 
expand the hierarchy and show further subdirectories. If you can see the desired directory, click the 
corresponding entry with the left mouse button to copy its path to the 'Path' edit control. Close the dialog 
box by pressing the 'OK' button.

- Browsing for files... In the file pane, all the files of the directory that is currently selected in the directory
pane are displayed. If you can see the desired file, click the corresponding entry with the left mouse 
button to copy its path to the 'Path' edit control. Close the dialog box by pressing the 'OK' button.

- Restricting the list of files by a set of filename patterns... You can enter a set of 'filename patterns' in
the 'Pattern' edit control to restrict the number of files that are shown in the file pane. If you want to name 
more than one pattern, the patterns have to be separated by a pipe symbol '|'. For instance, enter

*.TXT|*.DOC



in the 'Pattern' edit control, if only files that have one of these extensions are to be displayed. (Note: To 
select filename patterns from the internal collection of patterns, click the small icon right to the edit control
with the left mouse button.)

Keyboard shortcuts to expand or fold away the directory hierarchy:

- Plus '+'...
- Asterisk '*'...
- Control + Cursor right... Expands the current directory and displays its subdirectories.

- Minus '-'...
- Control + Cursor left... Jumps one level upwards in the directory hierarchy.



VIII. Configuring 'The Next Tool'

You can configure T.N.T. in many ways and adjust the program to your personal needs. The configuration 
of the program includes the following aspects:

1.) All options that can be set by means of the 'Settings' property sheet and affect the program in general.

2.) The presets and default parameters for the file commands, the text editor and the file viewer.

3.) Any commands for the execution of external applications.

4.) The user-defined menus and the configuration of the control window's command bar.

5.) The fonts used by T.N.T. as well as the colors for stressed or selected items and for the cursor.

6.) The state (size and position) of display windows, text editors and file viewers that are open when 
quitting the program. (Note: All these windows are re-opened when running T.N.T. again.)

The current state of the program can be saved to a configuration file when quitting T.N.T. and then be 
restored when running the program the next time. (Note: Normally the files named 'TNTWIN.INI' and 
'TNTWIN.ICS' in the program directory are used for saving the configuration. You can specify different 
filenames on the 'General' page of the 'Settings' property sheet. See also: Configuration Files and User 
Profiles. If there is no configuration file or T.N.T. is started with the 'NOINI' parameter, internal setting are 
used.)



VIII. Configuring 'The Next Tool'
VIII.1. The Settings

By means of the 'Settings' property sheet you can specify all parameters that affect not only single 
commands or single windows but also the use of T.N.T. in general. To open the 'Settings' dialog box, click 
the 'The Next Tool' button in the taskbar with the right mouse button. Then choose 'Settings' from the 
'Configuration' submenu of the main menu.

The 'Settings' property sheet is composed of the following pages:

a) Settings: Commands
b) Settings: Control Window
c) Settings: General
d) Settings: Windows
e) Settings: Drives
f) Settings: Directories
g) Settings: Appearance

To apply any modification of the settings, press the 'OK' button. When quitting T.N.T. there will be an 
automatic notification whether or not the changes are to be saved to the configuration file.



VIII.1. The Settings
a) Settings: Commands

On the 'Commands' page of the 'Settings' property sheet there are the following options concerning the 
execution of commands:

- File Commands: Less Notifications
- File Commands: Minimized while Executing
- Copy: Delete Faulty Target Files
- Copy: No -Extracting Instead of Copying- Notification
- Deleting: Use Recycle Bin
- Delete: No -Recycle Bin Does Not Work in Archives- Notification
- Confirmation Before Deleting
- Command Line: Re-Open after Execution
- Command Line: Close DOS Boxes Automatically
- Global Keyboard Shortcuts: Using the Windows Key instead of Control+Alt



- File Commands: Less Notifications

If the 'Less notifications' check box is checked, file commands (copy, delete...) are executed    as soon as 
you push the corresponding button to start the command. If 'Less notifications' is disabled, the number of 
files and directories affected by the command is displayed first and another confirmation is waited for.



- File Commands: Minimized while Executing

If the window that shows the progress of a file command (copy, delete...) is to be minimized automatically 
as soon as the task is executed, check the 'Minimized while executing' check box.



- Copy: Delete Faulty Target Files

If faulty or incomplete target files of a copy task are to be deleted automatically, check the 'Delete faulty 
target files' check box. Otherwise there will be a notification for each file allowing you to keep each file 
individually.



- Copy: No -Extracting Instead of Copying- Notification

If you specify a number of archives as source files for a copy task, there will be a notification asking 
whether you want to copy the archives or extract their contents. To disable this notification, check the 'No 
-Extracting instead of Copying- Notification' check box. Archives are then always treated as files.



- Deleting: Use Recycle Bin

If you want to be able to undo the deletion of files via the Windows® recycle bin, check the 'Use recycle 
bin' check box. (Note: The undo functionality is available only if the recycle bin is generally enabled under 
Windows®.)

Note: When deleting files, you can activate or deactivate the recycle bin for each task individually. In this 
case the corresponding check box on the 'Commands' page of the 'Settings' dialog box is used as a 
preset only.

Warning! The undo functionality is available for 'normal' drives only. You will not be able to restore files 
that were deleted in archives. The undo functionality is also not available for drives that are not supported 
by the Windows® recycle bin. 



- Delete: No -Recycle Bin Does Not Work in Archives- Notification

When deleting files inside an archive, a warning appears to notify that deletions inside archives cannot be
undone by means of the Windows® recycle bin. You can disable future appearances of this notification by
checking the corresponding check box in the    notification itself. To enable the notification again, uncheck 
the 'No -Recycle bin does not work in archives- warning' check box on the 'Commands' page of the 
'Settings' property sheet.



- Confirmation Before Deleting

If a certain number of Kbytes, files or directories is affected by a delete task, an additional confirmation is 
asked for. No matter whether the 'Less notifications' check box is checked or not. You can enter the lower 
limit for this notification in the edit controls named 'Kb', 'Files' and 'Directories' on the 'Commands' page of
the 'Settings' property sheet.



- Command Line: Re-Open After Execution

If you want the command line to re-open as soon as the programs that you start return, check the 'Re-
Open after execution' check box. (Note: To invert this option for a single task, start the program by 
pressing 'Alt + Enter/Return'.)



- Command Line: Close DOS Boxes Automatically

If you want the window of a DOS application that was started via T.N.T.'s command line to close 
automatically as soon as the program has terminated, check the 'Close DOS Boxes Automatically' check 
box. (Note: To invert the setting of this option for a single task, start the program by pressing 'Shift + 
Enter/Return'.)



- Global Keyboard Shortcuts: Using the Windows Key instead of 
Control+Alt

If you want to use the 'Windows' key instead of 'Control+Alt' for global keyboard shortcuts, check the 'Use 
Windows key instead of Ctrl+Alt for global shortcuts' check box on the 'Commands' page of the 'Settings' 
property sheet.



VIII.1. The Settings
b) Settings: Control Window

On the 'Commands' page of the 'Settings' property sheet, there are the following options concerning the 
appearance of the control window:

- The Control Window: As an Ordinary Window
- The Control Window: As an Application Bar
- The Control Window: Switched Off
- The Control Window: Always on Top
- The Control Window: Auto-Hide
- The Control Window: Without Menu Bar
- The Control Window: Drive Bar Enabled
- The Control Window: Command Bar Enabled
- The Control Window: Separate Bars for Drives and Commands



VIII.1. The Settings
c) Settings: General

On the 'General' page of the 'Settings' property sheet, you will find the following options that concern the 
operation of T.N.T. in general:

- Load T.N.T. with Windows
- Disable the Tip of the Day
- Disable Tooltips
- Virtual Desktops
- Only a Small Icon for T.N.T. in the Taskbar
- Explorer Compatibility of the Left Mouse Button
- Enable Double-Clicks for Arrow Buttons
- Configuration Files and User Profiles



- Load T.N.T. with Windows

If you want to load 'The Next Tool' automatically when booting Windows®, check the 'Load T.N.T. with 
Windows' check box.



- Disable the Tip of the Day

If you don't want a tip of the day to be displayed when starting T.N.T., check the 'Disable the tip of the Day'
check box.



- Disable Tooltips

If you want to disable the tooltips that explain the functionality of certain buttons or controls, check the 
'Disable tooltips' check box. (Note: Such tooltips are displayed if you position the mouse pointer above the
status bar of a display window, for instance. This setting does not affect tooltips showing the free space of
drives or similar pieces of actual information.)



- Only a Small Icon for T.N.T. in the Taskbar

Normally, a button showing the name and the symbol of the application appears in the taskbar for each 
program currently running. By clicking this button with the left mouse button you activate the application. 
By clicking it with the right mouse button you open the application's system menu.

If you check the 'Only a small icon for T.N.T. in the taskbar' check box, there is no button in the taskbar, 
but instead only a small icon (the T.N.T. star).



c) Settings: General
- Explorer Compatibility of the Left Mouse Button

Preliminary remark: By default, inside 'The Next Tool' only selecting entries is done by means of the left 
mouse button and the selection is persistent. That means that selected entries remain selected if another 
entry is clicked with the left mouse button. By dragging the mouse with the left button pressed, you can 
continuously select entries. Drag-and-drop is done by means of the right mouse button.

To activate selection and drag-and-drop with the left mouse button for display windows, check the 'Left 
mouse button Explorer compatible' check box on the 'General' page of the 'Settings' property sheet or 
choose 'Left mouse button Explorer compatible' from the 'Configuration\Mode' submenu of the T.N.T. main
menu. (Note: To open the main menu, click the button or the icon of 'The Next Tool' in the taskbar with the
right mouse button.)

Activating the 'Left mouse button Explorer compatible' feature has the following consequences:

- The selection of entries (files and directories) is no longer persistent. If you click an entry with the left 
mouse button, all entries that were selected previously are deselected. To select a number of entries, 
keep the 'Control' key pressed while clicking on further entries. To select a number of successive entries, 
keep the 'Shift' key pressed.

- Drag-and-drop of entries (files and directories) can also be done by means of the left mouse button. The
continuous selection of entries by dragging the mouse with the left mouse button pressed is no longer 
possible.

- Working on tree structures (i.e. expanding or folding up branches) is done by means of the left mouse 
button according to the Explorer. Completely expanding or folding up a branch by dragging the mouse 
with the left mouse button pressed is no longer possible. (Note: For a detailed description of the T.N.T. like
handling of tree structures refer to the 'Expanding and Folding Up the Branches of Tree Structures' 
section of the online manual.)



- Enable Double-Clicks for Arrow Buttons

If you check the 'Enable double-clicks' check box on the 'General' page of the 'Settings' property sheet, 
you can double-click the arrow buttons of scroll bar controls or of the command bar and the drive bar of 
the control window to jump to the first or to the last entry of a list of items.



c) Settings: General
- Configuration Files and User Profiles

The current state of the program can be saved to a configuration file when quitting T.N.T. and then be 
restored when running the program the next time. Normally, the files named 'TNTWIN.INI' and 
'TNTWIN.ICS' in the program directory are used for saving the configuration. If you want to use several 
configuration files, eventually combined with different user profiles, proceed as follows:

1.) Creating new Configuration Files

On the 'General' page of the 'Settings' property sheet you can specify the name of the configuration file. If 
you enter a new filename and close the property sheet by pressing the 'OK' button, the new configuration 
is created automatically in case it does not exist already. (Note: There are always two configuration files, 
e.g. 'TNTWIN.INI' and 'TNTWIN.ICS'. You only have to enter the name of the '.INI' file. The corresponding 
'.ICS' file is created automatically.)

2.) Choosing an Alternative Configuration

If you enter the name of an already existing configuration file and close the property sheet by pressing the
'OK' button, a notification appears and you can choose whether you want to quit T.N.T. immediately and 
restart the program with the new configuration. Warning! When quitting T.N.T., there will be another 
notification and you can choose whether to overwrite the specified configuration with the current settings. 
In this case press the 'NO' button.

3.) Overwriting an Alternative Configuration

If you want to overwrite an already existing configuration, enter the name of the configuration file and 
close the 'Settings' property sheet by pressing the 'OK' button. A notification appears, asking whether you 
want to quit T.N.T. immediately. Press the 'Yes' button. Then T.N.T. quits and another notification appears 
which you have to confirm to overwrite the existing configuration with the current settings.

4.) Creating Configurations for different Users under Windows®

If you use several user profiles under Windows®, you can also create an own configuration for each user 
with T.N.T. also. The filename of the configuration currently in use is stored in the actual user profile. Each
user just has to specify an own filename for the configuration once. When starting T.N.T. the next time, the
corresponding configuration will be used automatically.

5.) Always Saving the Configuration

If you always want to save the configuration when quitting T.N.T., check the 'Always saving the 
configuration' check box. (Note: If you have modified any setting, a user-defined menu, the command bar 
of the control window, the preset of a command or a predefined scheme, there is a notification when 
quitting T.N.T. anyway and you are able to save the configuration. Enable 'Always saving the 
configuration' only if display windows, text editors and file viewers that are open when quitting T.N.T. are 
always to be reopened when running the program the next time.)



VIII.1. The Settings
d) Settings: Windows

On the 'Windows' page of the 'Settings' property sheet you can specify how display windows will be 
arranged when they open, which type of 'display window' you want to use as the default and which T.N.T. 
windows are to appear in the taskbar.

- Automatic Arrangement of Display Windows
- Choosing the Default Display Window Type
- T.N.T. as a 'Commander' Compatible File Manager
- Placement of T.N.T. Windows in the Taskbar



d) Settings: Windows
- Automatic Arrangement of Display Windows

On the 'Windows' page of the 'Settings' property sheet you can specify how display windows will be 
arranged when they open. The following options are available:

1.) Automatic

The display window that is opened first is centered below the mouse pointer. Further windows are 
automatically placed in such a way that the overlap is minimized.

2.) Rotating

The display windows are placed by the border of the screen at a random position. The border on which 
the next window appears rotates clockwise.

3.) 2, side by side

The screen is divided vertically in two parts. The first display window appears on the left, the second one 
on the right. The next window replaces the least recently used one if the positions of the two windows 
would match exactly. If you move or resize one of the windows, the corresponding part of the screen is 
considered free and the new window opens without replacing an older one. (Note: You can use the 
'Distance' edit control to specify the distance between the two 'display windows' on the one hand and 
between the 'display windows' and the border of the screen on the other hand. Thus windows in the 
background will not be overlapped completely.)

Note: This mode, in combination with the usual keyboard shortcuts, is most suitable if you want to use 
T.N.T. as a classical, 'Commander' like file manager. (See also: T.N.T. as a 'Commander' Compatible File 
Manager.)

4.) User-Defined

You can also define specific positions for each type of display window on your own. When new 'display 
windows' open, the predefined positions are used one after the other. As soon as all positions that were 
defined for a certain type of 'display window' are occupied, the next window replaces the least recently 
used one if the positions of the two windows would match exactly. If there is no predefined position for a 
certain type of 'display window', such windows open below the mouse pointer.

To specify certain positions for the display windows proceed as follows:

Open all those display windows (tree/folder displays, folder displays, multi-folder displays and tree 
displays) you want to define positions for. Adjust the desired size and move the windows to the desired 
positions. Then press the 'Snapshot' button on the 'Windows' page of the 'Settings' property sheet and 
close the property sheet by pressing the 'OK' button.



- Choosing the Default Display Window Type

'The Next Tool' provides four different types of display windows:

- Tree/folder displays
- Folder displays
- Multi-folder displays
- Tree displays

On the 'Windows' page of the 'Settings' property sheet, you can choose the default display window type. 
Windows of this type are opened when clicking a T.N.T. drive icon with the left mouse button or when 
choosing a drive from the main menu. (Note: You can open a 'display window' of any type by double-
clicking a directory in a 'display window' or by using the 'Commands' submenu of the drive's context 
menu. To open the context menu of a drive, click the drive's icon with the right mouse button.)



- T.N.T. as a 'Commander' Compatible File Manager

You can also use 'The Next Tool' as a classical, 'Commander' like file manager. That is: With two display 
windows, side by side, and with the usual keyboard shortcuts. To do so, click the 'The Next Tool' button in 
the taskbar with the right mouse button to open the main menu. Choose 'Commander compatible' from 
the 'Configuration\Window Mode' submenu.

Note: By enabling the 'Commander' compatible window mode, you only set the '2, side by side' option on 
the 'Windows' page of the 'Settings' property sheet and choose folder displays as the default display 
window type. To disable or adjust the window mode, simply modify the settings.

See also:

- Automatic Arrangement of Display Windows
- Choosing the Default Display Window Type



- Placement of T.N.T. Windows in the Taskbar

On the 'Windows' page of the 'Settings' property sheet there are four check boxes to specify which 
windows of T.N.T. appear in the taskbar with an own button.

1.) None of the windows... None of the T.N.T. windows appears in the taskbar. Minimized windows are 
placed on the lower margin of the screen.

2.) Minimized windows... Only minimized windows appear in the taskbar.

3.) Windows that can be minimized... All windows that can be minimized appear in the taskbar. 
Regardless of whether they are minimized or not.

4.) All windows... Every T.N.T. window appears in the taskbar.



VIII.1. The Settings
e) Settings: Drives

On the 'Drives' page of the 'Settings' property sheet, you can specify for each drive whether it is to be 
shown in the Windows® taskbar, in the drive bar of the control window, in the drive registers of the display
windows and in the T.N.T. main menu.

1.) Configuring the Drive Lists

There are four drive lists, one each for the taskbar, the main menu, the control window and the drive 
register. All available drives are listed. You can select (deselect) the drives (not) to be shown by clicking 
the corresponding entries with the left mouse button. 

2.) Accessing the 'Further' Drives

If some drives are excluded from being displayed in the taskbar, in the control window or in the main 
menu, a further icon, which shows three dots '...', can also be added to enable access to these drives. For
this purpose, select the '... further' entry at the end of the corresponding drive list. By clicking the '...' icon 
with the left mouse button you can open the context menu containing these 'further' drives. Choose one of
the drives from the menu to open a display window that shows the contents of the corresponding drive.
By clicking the '...' icon with the right mouse button you open a context menu containing several 
submenus. Each of these submenus represents the drive specific context menu for one drive. By means 
of the context menu you can access the favorite directories and the most recently used directories of the 
drive (See also: Favorite Directories), open a display window of any type and execute certain drive 
specific commands (e.g. 'Format' in the case of a disk drive).

Note: If the drive register of a display window does not show a page for each single drive, a '...' page is 
added anyway. As this may also happen because the window is too small to show all the drives, the '...' 
page cannot be disabled for the drive register.

3.) Further Options for the Access to Drive Icons

- Showing the root directory or the most recently used directory... If the 'Show the most recently 
used directory' check box is checked, the most recently used directory of a drive is shown again if a new 
display window is opened by means of a drive icon. Otherwise the root directory of the drive is shown.

- Showing graphic icons in the taskbar... If you don't want the graphic icons but instead only the drive 
letters to be displayed in the taskbar, check the 'No graphic icons' check box.

- Disabling the drive register... To switch off the display of the drive register in display window, check 
the 'Drive registers: disabled for display windows' check box.



VIII.1. The Settings
f) Settings: Directories

On the 'Directories' page of the 'Settings' property sheet you can set several options that concern T.N.T.'s 
handling and use of directories.

- Temporary Files
- Directories not Remembered
- Determination of Subdirectories
- Determine Compression Rate for Archives Only
- Favorite Directories



- Temporary Files

If you work on archives, temporary files have to be created when compressing or extracting files. On the 
'Directories' page of the 'Settings' property sheet you can enter the drive letter of the drive on which these 
temporary files are to be created.

Warning! There has to be enough space on the drive you choose. If you work on archives that contain 
very large files, several Mbytes may be necessary. Normally, drive 'C:' is used.



f) Settings: Directories
- Directories not Remembered

Directories once read normally are kept in the memory, even without being visible in any window. So the 
selection of entries is preserved after a display window has been closed and the directories don't have to 
be re-read when a new 'display window' is opened. You can disable this functionality for the following 
groups of drives individually:

- Disk drives and CD-ROM drives
- Hard disks and RAM drives
- Network drives

If you check one of the 'Directories not remembered' check boxes on the 'Directories page' of the 
'Settings' property sheet, all information about directories that is not visible or not needed anymore for a 
file command is cancelled automatically for the corresponding drives.

Note: If you uncheck the 'Directories not remembered' check box for disk drives, please take care to 
update the corresponding drive after changing the data carrier. To do so, you can choose 'Update' from 
the 'View' menu of a display window. If updating the drive is omitted, the data of the old data carrier is still 
used, even if a new 'display window' is opened.



f) Settings: Directories
- Determination of Subdirectories

Preliminary remark: In the T.N.T. display windows, the [+] symbols, which serve to identify those folders 
that contain subfolders, are determined in the background. The tree structure itself appears instantly and 
you can operate on it immediately. Therefore (dependent on the speed of the drive) the [+] symbols 
appear with a short delay.

On the 'Directory' page of the 'Settings' property sheet, there are three check boxes by means of which 
you can enable/disable the determination of the [+] symbols for the following groups of drives:

- Floppy disks and CD-ROMs
- Hard disks and RAMDrives
- Net drives

If you want to avoid the background activity that is caused by the determination of the subdirectories, 
check the respective check box for the corresponding drive type.

Note: For archive files (files that have the filename extension '.ZIP', '.RAR', '.LHA', '.LZH', '.LZS', '.ARJ', 
'.TAR', '.GZ', '.TGZ', '.TNT' and '.VCP' are automatically treated as archives) it is determined likewise 
whether they contain subdirectories and [+] symbols are displayed if necessary. A [!] symbol in front of an 
archive indicates that the type of the archive could not be determined. (The archive may be in use by 
another program at the moment or the file may indeed have an unknown format.)



- Determine Compression Rate for Archives Only

If displaying the compression rate in display windows is enabled, the compression rate can be determined
for compressed files in archives as well as for files that are compressed by means of DriveSpace or a 
similar tool. If there are a lot of files within a single directory, there may be a significant delay when 
displaying directories of compressed drives. To avoid the delay, check the 'Determine compression rate 
for archives only' check box on the 'Directories' page of the 'Settings' property sheet.



f) Settings: Directories
- Favorite Directories

You can define up to 10 so-called 'favorite directories' for each drive. These favorites appear in the 
context menu of the drive that is opened by clicking the drive register of a display window or a drive icon 
with the right mouse button. By means of the favorite directories you have direct access to your most 
frequently used directories. You can define the favorites on the 'Directories' page of the 'Settings' property
sheet. In the 'Favorites' section you will find a drop-down list box for choosing the current drive and next 
to it the list of the favorite directories belonging to the drive. To edit the favorites of a drive, proceed as 
follows:

- Choosing the drive... Click the drop-down list box with the left mouse button to unfold the list of the 
drives and select the desired drive. 

- Adding new favorites... Drag the desired directory from a display window and drop it onto the desired 
position of the list of favorites. (See also: Drag-and-Drop: Files and Directories.) Alternatively you can 
click the list of favorites with the right mouse button, choose 'Add' from the context menu and enter the 
path of the directory.

- Removing a favorite... Click the corresponding entry of the list of favorites with the right mouse button 
and choose 'Remove' from the context menu. When using the keyboard: Position the cursor of the list on 
the desired entry and press 'Delete'.

Notes:

- The sequence of the favorites is the same in the drive context menus as in the list of favorites in the 
'Settings' property sheet. To change the order of the favorites, move the corresponding entries by 
dragging them with the right mouse button.
 
- If less than 10 favorites are defined for a certain drive, the remaining entries of the drive context menu 
will be filled with the most recently used directories of the drive.



VIII.1. The Settings
g) Settings: Appearance

On the 'Appearance' page of the 'Settings' property sheet you can modify certain colors and the fonts 
used by 'The Next Tool'.

- User-Defined Colors
- Choosing the proportional font and the fixed font
- Menus without Images



g) Settings: Appearance
- User-Defined Colors

On the 'Appearance' page of the 'Settings' property sheet you can modify the colors used for the following
display items:

- Selection... The color used for selected files, the selected part of a text etc. (default: light blue).
- Cursor... The cursor of display windows and other list controls (default: yellow).
- Cursor on selection... The cursor when on selected entries (default: green).
- Stressed items... Barred files, stressed entries etc. (default: carmine).

To modify a color setting, click the corresponding button with the left mouse button. Then the standard 
Windows® dialog box for the selection of colors is opened and you can choose the desired color. Note: If 
you close the dialog box by pressing the 'OK' button, the current setting for the solid color is used. Non-
primary colors that consist of dot patterns (pattern brushes) cannot be used in T.N.T..

Note: The colors used for all other display items correspond to the colors used for such items in general. 
These colors can be modified by means of the 'Display Properties' dialog box of Windows®.



- Choosing the proportional font and the fixed font

'The Next Tool' uses two different fonts: A fixed font for the text editor and the file viewer and a 
proportional font for all the other strings and texts. On the 'Appearance' page of the 'Settings' property 
sheet you can modify these fonts.

- Choosing the fonts... Press the 'Proportional font' or the 'Fixed font' button to open the standard 
Windows® dialog box for the selection of fonts. There you can choose the desired font and its size within 
reasonable bounds. (Note: Italic fonts cannot be used in T.N.T..)

- Using the internal fonts... If you want to use the predefined fonts ('Arial' as the proportional font and 
'Courier New' as the fixed font), check the 'Internal fonts' check box. (Note: If the internal fonts are used, 
the size of the font is always adjusted to the current resolution automatically.)



- Menus without Images

In almost any menu, T.N.T. shows small colored images in front of the options. If you want to disable 
these images, check the 'Menus without images' check box.



VIII. Configuring 'The Next Tool'
VIII.2. File Patterns

By means of a 'file pattern', a set of files can be described more closely, be restricted or selected in the 
following situations:

1.) To restrict the set of files handled by a file command (copy, delete, find...), check the Apply the file 
pattern check box when setting the parameters for the command.

2.) To restrict the set of files shown in a display window, choose 'File Pattern' or one of the predefined 'file 
pattern' schemes from the 'View' menu. (See also Configuring the View of a Display Window.)

3.) To select (or deselect) files in a display window according to a certain 'file pattern', choose 'File 
Pattern' or one of the predefined 'file pattern' schemes from the 'Edit' menu. (See also Selecting Entries in
Display Windows.)

A 'file pattern' can be composed of the following components:

- The selection of filename patterns... consists of two lists of 'filename patterns', including and 
excluding ones, and describes the set of valid filenames. A file matches the selection if it matches at least 
one of the including and none of the excluding patterns. (Note: If no including patterns are named, every 
file matches the selection, as long as it does not match one of the excluding patterns.)

- The time ranges... consist of three pairs of date information and describe valid file dates. The three file 



dates are: the date of the creation, last modification and last access. A file matches the time ranges if its 
dates are within the given bounds. If a whole date, an upper or lower bound or a time is omitted, the file 
date is arbitrary in this respect.

- The pattern of attributes... consists of presets for the four file attributes: the read-only, the hidden, the 
system and the archive attribute. For each attribute, it can be determined, whether or not it has to be set 
or is to be ignored. Furthermore it can be determined whether a file has to fulfill the presets for all four 
attributes or just for a single one in order to match the pattern.

- The range of size... consists of a lower and an upper limit to the file size. A file matches the range if its 
size is within the given limits. If the upper or lower bound is omitted, the file size is arbitrary in this respect.

For details concerning editing the various components of the 'file pattern', refer to the following sections:

a) Filename Patterns
b) The Selection of Filename Patterns
c) The Collection of Patterns
d) File Dates and Time Ranges
e) File Attributes and Patterns of Attributes
f) Ranges of Sizes

Using 'File Pattern' Schemes:

Once a 'file pattern' has been created, it can be saved as a scheme and be re-used in any situation. The 
title of the scheme currently in use is shown in the 'Scheme' combo box on the upper margin of the 'File 
Pattern' property sheet.

To use a predefined scheme, click the combo box with the left mouse button. The list of the schemes 
available unfolds and the desired scheme can be selected. To save the current 'file pattern' as a scheme, 
choose the 'Save as' button and name the scheme. To delete the current scheme, choose the 'Delete' 
button.



VIII.2. File Patterns
a) Filename Patterns

A 'filename pattern' describes a certain set of filenames. Besides all the characters already usable for 
filenames, a 'filename pattern' can contain the wildcards '?' and '*'. The question mark '?' replaces any 
single character. The asterisk '*' replaces any set of characters.

Here are some examples for 'filename patterns':

- 'A*'... All files that begin with an 'A'. For instance: 'Archives.doc', 'Alabama.txt', 'ASCII.SYS'.

- '*.DOC'... All files that have the extension '.DOC'. For instance: 'README.DOC', 'Replacement.doc', 
'Archives.doc'.

- 'D*.?BK'... Files that begin with a 'D' and have an extension of exactly three characters, the first one 
being arbitrary. For instance: 'DATA.DBK', 'Document.1bk'.

- 'E*E'... All files that begin and end with an 'E'. For instance: 'EMM386.EXE', 'Editor.exe'.

- '?????.*'... All files that have an extension and a filename (without extension) of exactly five characters. 
For instance: 'ABCDE.Extension', 'FILES.EXE'

- '*.*'... All files that have an extension.

- '*'... Any file.

Note: If the 'filename pattern' contains the wildcard '.*' as a replacement for any extension, matching files 
in fact must have an extension ('.something').



VIII.2. File Patterns
b) The Selection of Filename Patterns

On the 'Filenames' page of the File Pattern property sheet, there are two lists of filename patterns, 
including and excluding ones,. These 'filename patterns' describe the set of valid filenames of the 'file 
pattern'. A file matches the selection if it matches at least one of the including and none of the excluding 
patterns. (Note: If no including patterns are named, each file matches the selection, as long as it does not 
match one of the excluding patterns.)

Editing the Lists of Filename Patterns:

- Adding a new filename pattern... To add a new 'filename pattern', enter the new pattern in the edit 
control below the list in question and press 'enter / return'.

- Selecting patterns from the collection of patterns... The collection of patterns contains a number of 
usual filename patterns. To select one or several patterns from the collection, click the 'Select' button 
below the list in question. The 'Collection of Patterns' dialog box appears and the desired patterns can be 
selected.

- Deleting a single filename pattern... In order to delete a 'filename pattern', click the corresponding 
entry with the right mouse button and choose 'Delete' from the context menu. (When using the keyboard: 
Move the cursor of the list onto the desired pattern by using the cursor keys and press the 'Delete' key.)

- Emptying the whole list... Choose the 'Empty' button below the list to delete all entries.



- Drag-and-drop filenames on a list of patterns... You can drag a number of filenames from a display 
window, from another application or from the desktop and drop them onto a filename list to add the 
filenames. (See also: Drag-and-Drop: Files and Directories.)

- Inserting filenames from the clipboard... If there is one (or several) filename(s) in the clipboard, click 
the list with the right mouse button and choose 'Insert' from the context menu to add the filename(s).



VIII.2. File Patterns
c) The Collection of Patterns

The collection of patterns contains a number of common filename patterns. These patterns can be 
selected from the collection in the following situations:

1.) When putting together a file pattern you can use the collection of patterns to select from already 
available patterns.

2.) When renaming or copying files a filename pattern can be used as a preset for the automatic 
renaming.

3.) In the case of a file find and find in files command, you specify a filename pattern if you are only 
looking for or searching through files of a certain type.

Selecting the Filename Pattern(s):

Depending on the situation in which the collection of patterns is used, a single filename pattern or a set of 
patterns can be selected:

1.) If several patterns can be selected on the basis of the actual context (e.g. when putting together a file 
pattern), select the desired patterns with the left mouse button and choose the 'OK' button to adopt the 
selected patterns. (Note: A pattern in the edit control below the list is adopted automatically, too).

2.) If only one pattern can be selected on the basis of the actual context (e.g. as a preset for the 
automatic renaming of files), click the desired pattern with the left mouse button and choose the 'OK' 
button or adopt the desired pattern directly by double-clicking it with the left mouse button.

Editing the Collection of Patterns:

- Entering a new filename pattern... If several 'filename patterns' can be selected, enter new patterns in 
the edit control below the list and press 'enter / return' or choose the 'Add' button. The new pattern is then 



added to the collection of patterns and selected automatically.
If only a single filename pattern is asked for, enter the new pattern in the edit control below the list and 
press 'enter / return' only if the new pattern is just to be used in the current situation and is not to be 
added to the collection of patterns. In order to add the new pattern to the collection permanently, choose 
the 'Add' button.

- Deleting a filename pattern... To delete a 'filename pattern' from the collection, click the corresponding 
entry with the right mouse button and choose 'Delete' from the context menu. (When using the keyboard: 
Move the cursor of the list onto the pattern in question by using the cursor keys and press the 'Delete' 
key.)

Note: The collection of patterns is saved automatically together with the configuration of the program in 
general. If adding or deleting patterns has changed the collection, a notification of the change of the 
configuration is shown when quitting 'The Next Tool'. If the change is to be cancelled, quit T.N.T. without 
saving the configuration.



VIII.2. File Patterns
d) File Dates and Time Ranges

For each file and each directory there are three file dates:

1.) The date of the creation.
2.) The date of the last modification.
3.) The date of the last access.

Each file date consists of a calendar date and a clock time.

File dates are displayed in the folder pane of a display window, within the columns named 'Created', 
'Changed' and 'Accessed'. (Note: Not all dates necessarily exist for each file and each directory. Certain 
file systems possibly support only one single file date for each entry.)

In addition, date information is used in the following situations:

1.) When changing the date and the time of files, you determine those file dates and times that are to be 
modified.

2.) When putting together a file pattern, you can give a time range to restrict the set of files matching the 
pattern. (Note: A time range always consists of three pairs of date information and describes permissible 
time ranges for all three file dates. Each pair of date information consists of an upper and a lower bound. 
A file matches the time range if its dates are within the given limits. If a whole date, an upper or lower 
bound or a time is omitted, the file date is arbitrary in this respect.)

The input of date information takes place in special edit controls. The order in which the date and the time
are named, is of no importance. Both pieces of information just have to be separated by a space.

The input of a calendar date has the following format:

MM/DD/YY(YY) 
Month/Day/Year

The input of a clock time has the following format:

HH:MM:SS
Hours:Minutes:Seconds

Here are some examples of date information:

12/24/1994 20:12:48
or

3/14/90



VIII.2. File Patterns
e) File Attributes and Patterns of Attributes

File attributes characterize certain features of files (and, if necessary, also directories):

1.) The system attribute 'S' is usually used for (operating-) system files only.

2.) The hidden attribute 'H', which is often used together with the system attribute, characterizes files that 
are supposed to remain hidden for the 'usual' user.

3.) The read-only attribute 'R' is set in case these files are only supposed to be able to be read not 
modified.

4.) The archive attribute 'A' identifies files that were changed 'recently' and therefore have to be saved 
during the next backup.

The state of the attributes of a file or a directory is displayed in the folder pane of a display window within 
the column named 'Attr.'.

Furthermore, patterns of attributes are used in the following situations:

1.) When changing the attributes of files and directories the pattern of attributes determines how the 
attributes of the files and directories are to be changed.

2.) When copying and moving files and directories you can determine how to set the attributes of the 
target files if the attributes of the source files are not to be kept.

3.) When putting together a file pattern you can give a pattern of attributes to restrict the set of files 
matching the pattern. (Note: By means of the check boxes 'Link attributes with AND' and 'Link attributes 
with OR' you can also determine whether a file has to fulfill the presets for all four attributes or if the 
fulfillment of one preset is enough.)

Setting a pattern of attributes is done by means of four buttons. Behind the name of each single attribute 
you see

whether the attribute has to be set: the first letter of the attribute.

whether the attribute must not be set: a minus character '-'.

whether the attribute is to be ignored: a question mark '?'.

To change the state of an attribute, click the corresponding button with the right mouse button and choose
one of the options, 'Ignored', 'Deleted' or 'Set', from the context menu or click the attribute with the left 
mouse button repeatedly to see the different states one after the other.



VIII.2. File Patterns
f) Ranges of Sizes

A range of sizes consists of an upper and a lower limit to the file size. A file matches the range if its size is
within the given limits. If either the upper or the lower bound is omitted, the file size is arbitrary in this 
respect.
When putting together a file pattern you can give a range of sizes to restrict the set of files matching the 
pattern. Enter the limits into the edit controls named 'from' and 'to'. (Note: You can enter decimal as well 
as hexadecimal (e.g. '0xf0', '$a0' or '3fh') numbers.)



VIII. Configuring 'The Next Tool'
VIII.3. User-Defined Menus

There are 6 types of menus that you can adjust to your personal needs:

1.) The main menu that is opened by clicking the 'The Next Tool' button in the taskbar with the right 
mouse button. (Note: The following options are in the main menu by default and cannot be edited: 
'Restore', 'Minimize' and 'Close' as well as the 'Configuration' submenu. For details about adding or 
removing drive icons in the main menu, refer to Settings: Drives.)

2.) The directory context menu that is opened by clicking a directory name with the right mouse button. 
(Note: The menu may contain certain options by default, e.g. 'Properties', that cannot be edited.)

3.) The file context menu that is opened by clicking a filename with the right mouse button. (Note: The 
menu may contain certain options by default, e.g. 'Open', 'Quick View' or 'Properties' that cannot be 
edited.)



4.) The command icons and folders shown in the task-bar that you can activate by clicking them with the 
left mouse button. (Note: For details about adding or removing desktop and drive icons in the taskbar 
refer to Virtual Desktops and Settings: Drives.)

5.) The menu bar of the control window. (Note: The control window only has a menu bar if it is used as a 
'normal' window and not as a toolbar that is attached to the upper or lower border of the screen.)

6.) The menu that is available by clicking the free space display in a display window with the left mouse 
button. (Note: Normally, this menu contains only a single command for updating the window that is 
executed immediately by clicking with the left mouse button. Thus, the menu itself does not become 
visible as long as no further commands are added to it.)

In addition to these 6 menus you can define so-called 'file groups' by means of filename patterns. All the 
commands that are assigned to a certain file group appear in the context menu of those files that match 
the corresponding 'filename patterns'.

To open the 'Menus' dialog box for editing the menus, click the 'The Next Tool' button in the taskbar with 
the right mouse button. Then T.N.T.'s main menu appears and you can choose 'Menus' from the 
'Configuration' submenu. To edit the menus proceed as follows.

Note: If the menus have been edited and you quit the 'Menus' dialog box by pressing the 'OK' button, the 
modifications are applied. When you quit T.N.T., a notification will appear asking whether or not you want 
to save the configuration. In order to keep the modified menus you have to save the configuration.

1.) Selecting a Menu or a File Group for Editing

On the left of the 'Menus' dialog box there is the list of already available menus and file groups. The 
default menu types are shown with the color used for stressed items (default: carmine). The file groups 
are shown with the color used for normal text (default: black). To select a menu or a file group for editing, 
press the corresponding entry with the left mouse button or position the cursor of the list on the entry by 
using the cursor keys. Then the corresponding menu hierarchy or command tree is shown on the right of 
the dialog box, below the keyword 'Commands'. If the selected entry is a file group, the list of filename 
patterns defining the group is shown in the middle, below the keyword 'Filename pattern'.
To create a new file group, enter the name for the group in the edit control below the 'Menus / Groups' list 



and press 'Enter / Return'. To delete a file group, press the corresponding entry with the right mouse 
button and choose 'Delete' from the context menu. To change the name of a file group, choose 'Rename' 
from the context menu.

2.) The Filename Patterns that Define a File Group

If a file group is selected for editing, you see the list of filename patterns that define the group in the 
middle of the 'Menus' dialog box, below the keyword 'Filename patterns'. (Note: In the case of the default 
menu types, the list is always empty and has no function at all.) By means of the following operations you 
can edit the list of 'filename patterns':

- Adding a new pattern... Enter the pattern into the edit control below the list and press 'Enter / Return'.

- Choosing a filename pattern from the collection of patterns... Click the 'filename patterns' list with 
the right mouse button and choose 'Choose' from the context menu. T.N.T.'s collection of 'filename 
patterns' then appears and you can select the desired pattern(s) to be added to the list.

- Deleting a single filename pattern... Click the pattern with the right mouse button and choose 'Delete' 
from the context menu. When using the keyboard, position the cursor of the list on the desired entry by 
means of the cursor keys and press 'Delete'.

- Emptying the whole list... Click the filename patterns list with the right mouse button and choose 
'Delete All' from the context menu.

3.) Editing the Command Tree

To the right of the 'Menus' dialog box, the hierarchy of the submenus and the commands of the menu 
currently selected for editing are shown in the form of a tree structure. (See also: Expanding and Folding 
Up the Branches of Tree Structures.) Each branch of the tree (displayed with a folder icon) represents a 
submenu. The menu options are represented by the command entries. The following operations are 
available for editing the command tree:

- Re-defining a command... Click the desired command with the left mouse button or choose 'Redefine' 
from the context menu that is opened by clicking the entry with the right mouse button. A dialog box then 
appears in which you can set the configuration (i.e. the parameters and presets) of the command. (Note: 
For certain types of commands, e.g. 'Creating a directory path' or 'Creating a self-extracting archive', 
there are no predefined parameters available. For details concerning the redefinition of commands refer 
to User-Defined Commands.)

- Adding new commands... Click the command tree with the right mouse button and choose 'New 
Command' from the context menu. (When using the keyboard press 'Insert'). Then the 'Command 
Templates' dialog box appears. This dialog box contains templates for all types of commands that are 
supported by 'The Next Tool'. To add a new command to a menu drag the corresponding template from 
the 'Command Templates' dialog box and drop it onto the command tree at the desired position by using 
the right mouse button. (Note: You can also create new commands for the execution of external 
applications or the display of certain directories by dragging the file or the directory from a display window
or from any other application and dropping it onto the command tree. See also: Importing Commands. 
Besides, you can also insert commands and folders from the command bar of the control window via 
drag-and-drop. See also: Drag-and-Drop: Commands.)

- Changing the icon and the name of a command... Click the desired command with the right mouse 
button and choose 'Icon and Name' from the context menu to open the dialog box for entering the name 
of the command and selecting an icon. (See also: Changing the Icon and the Name of a Command.)



- Opening a command... Click the command with the right mouse button and choose 'Open' from the 
context menu.

- Creating a new submenu... Click on the desired position of the command tree with the right mouse 
button and choose 'New Submenu' from the context menu.

- Renaming a submenu... Click the submenu with the right mouse button and choose 'Rename' from the 
context menu.

- Dissolving a submenu... Click the entry of the submenu with the right mouse button and choose 
'Dissolve' from the context menu. The submenu is then removed and all its entries are inserted in the 
superordinated menu.

- Cutting an entry and copying it to the clipboard... Click the desired entry with the right mouse button 
and choose 'Cut' from the context menu. When using the keyboard, position the cursor of the tree on the 
entry by using the cursor keys and press 'Control + X'.

- Copying an entry to the clipboard... Click the desired entry with the right mouse button and choose 
'Copy' from the context menu. When using the keyboard, position the cursor of the tree on the entry by 
using the cursor keys and press 'Control + C'.

- Inserting commands from the clipboard... Click on the desired position of the command tree with the 
right mouse button and choose 'Insert' from the context menu. When using the keyboard, move the cursor
of the tree to the desired position and press 'Control + V'.

- Deleting an entry... Click the entry with the right mouse button and choose 'Delete' from the context 
menu. When using the keyboard, position the cursor of the tree on the desired entry and press 'Delete'.

- Rearranging the order of the commands and submenus... Use the right mouse button to drag the 
entry to the desired position and release the button to move it. (Note: If you drop the entry onto an 
expanded branch of the command tree (i.e. on an open folder icon), it is inserted at the end of the 
corresponding submenu. If you drop the entry onto a command or a branch that is folded up, it is inserted 
in front of this entry.)



VIII. Configuring 'The Next Tool'
VIII.4. User-Defined Commands

Within T.N.T. you can redefine almost any command and adjust it to your personal needs. Both the 
internal commands for the file and disk management as well as commands for the execution of external 
applications can be edited.

1.) Places, where user-defined commands are available

- User-defined menus and the command icons in the taskbar... To redefine a command in a menu, 
click the corresponding entry of the menu's command tree in the 'Menus' dialog box with the left mouse 
button. (Note: To open the 'Menus' dialog box, click the 'The Next Tool' button in the taskbar with the right 
mouse button. The main menu opens and you can choose 'Menus' from the 'Configuration' submenu. See
also: User-Defined Menus.)

- Command icons in the command bar of the control window... To redefine a command, click the 
corresponding command icon with the right mouse button and choose 'Redefine' from the context menu.

- Commands in the 'Command Templates' window... To redefine a command template, click the 
corresponding entry in the 'Command Templates' window with the left mouse button. (See also: 
Command Templates and Drag-and-Drop: Commands.)

2.) Parameters that can be redefined or preset

The configuration of a command includes all options and parameters that can be set or be passed when a
command is executed. If you have chosen a command for redefining, as described above, a dialog box 
appears in which you can set all parameters that are available for the command. Depending on the type 
of the command, the following cases have to be distinguished:

- In the case of a command that serves the file or disk management... the same dialog box appears 
that is also used when the command is opened. In this dialog box you can set all options and parameters 
directly in the way they are to be used in the future.

- In the case of a command for the execution of an external application... a dialog box is opened in 
which you can enter the parameters that are passed to the external application and determine the way the
application is started. (See also: Executing External Programs or Applications and Importing Commands.)

- For text editor commands... you can enter the name of the file that is to be loaded by default when the 
editor opens. (Note: If a different filename is passed directly when executing the command, this file 
overwrites the preset.)

- In the case of a command that opens a display window... a dialog box appears in which you can 
enter the path of the directory that is to be displayed by default, choose the 'display window' type that is to
be used and select a display scheme for the configuration of the view of the window.

- In the case of a command that updates a directory... you can enter the path of the directory that is to 
be read. (Note: If a different directory name is passed directly when executing the command, this file 
overwrites the preset.)

- In the case of a 'Quit T.N.T.' command... you can determine whether the configuration is to be saved 
anyway on quitting the program or if a notification should appear if the configuration was modified.



Note: The following commands cannot be redefined or be equipped with preset parameters: 'Command 
Line', 'Create Self-Extracting Archive', 'Create Shortcut(s)', 'Create Directory Path', 'Settings', 'Menus', 
'Info about T.N.T.', 'Registered File Types' and 'Help'.

For further details that concern the creation and the configuration of user-defined commands refer to the 
following sections:

a) Command Templates
b) Changing the Icon and the Name of a Command
c) Importing Commands
d) Drag-and-Drop: Commands



VIII.4. User-Defined Commands
a) Command Templates

The 'Command Templates' window contains a list of all available commands. You can use these 
templates to create new commands in user-defined menus or in the command bar of the control window. 
To open the 'Command Templates' window, click the command tree in the 'Menus' dialog box or the 
command bar of the control window with the right mouse button and choose 'New Command' from the 
context menu. (See also: User-Defined Menus.and The Control Window.)

1.) Creating New Commands by means of the Command Templates

To create a new command in the command tree of a user-defined menu or in the command bar of the 
control window, click the corresponding template in 'Command Templates' window with the right mouse 
button and keep the button pressed. Drag the template to the desired position of the command tree or the
command bar and release the mouse button. (Note: Alternatively, you can copy the command via the 
clipboard. To do so, click the desired template with the right mouse button and choose 'Copy' from the 
context menu. Then click the command tree in the 'Menus' dialog box or the command bar of the control 
window with the right mouse button and choose 'Insert' from the context menu.)
After that, a new command is created at the chosen position. The new command and the template are 
identical regarding the presets of all options and parameters as well as regarding the icon and the name. 
If you want to provide an own configuration for the new command, click the command with the left mouse 
button to open the corresponding dialog box. In order to change the icon or the name of the command, 
click the command with the right mouse button and choose 'Icon and Name' from the context menu.

2.) Redefining a Command Template

To modify the configuration of a command template, click the corresponding entry in the 'Command 
Templates' window with the left mouse button. A command type specific dialog box then appears in which 
you can set the default options and parameters.
To change the icon or the name of a command template, click the corresponding entry with the right 
mouse button and choose 'Icon and Name' from the context menu. (See also: Changing the Icon and the 
Name of a Command.)



Warning! The configuration of a command template has an effect on all commands of the same type that 
are not redefined on their own. For instance, if you drag a copy command from the 'Command Templates' 
window onto the command bar of the control window, the configuration of the template is used for the new
command automatically. If you modify the command template of the copy command, these modifications 
also have an effect on the new copy command in the command bar. Only if (or as soon as) you directly 
redefine the command in the command bar, modifications of the template have no effect on this command
any more.



VIII.4. User-Defined Commands
b) Changing the Icon and the Name of a Command

To change the icon or the name of a user-defined command, click the corresponding command entry in 
the 'Menus' dialog box or the command icon in the command bar of the control window with the right 
mouse button and choose 'Icon and Name' from the context menu. (See also: User-Defined Menus.) 
Then the 'Icon and Name' dialog box appears. (Note: This dialog box also opens automatically if you 
import a command for the execution of an external application via drag-and-drop. See also: Importing 
Commands.)

To change the name of the command, simply type the new name in the edit control 'Name'. To choose a 
new icon, click the desired entry in the icon bar with the left mouse button. The following sources are 
available for the selection of a icon:

- Any file... Enter the name of the file in the 'Source' edit control and check the 'Source' check box. All 
icons in the file will appear in the icon bar.

- The internal icon collection... If you check the 'Internal collection' check box, all icons that are 
currently used within T.N.T. are shown in the icon bar.

- The 'SHELL32.DLL' file... Check the 'SHELL32.DLL' check box to see all icons in the 'SHELL32.DLL' 
file in the Windows® system directory.

- The 'PROGMAN.EXE' file... Check the 'PROGRMAN.EXE' check box to see all icons in the 
'PROGMAN.EXE' file in the Windows® directory.

- The 'MORICONS.DLL' file... Check the 'MORICONS.DLL' check box to see all icons in the 
'MORICONS.DLL' file in the Windows® directory.



VIII.4. User-Defined Commands
c) Importing Commands

You can create new commands for the execution of external applications simply by importing them via 
drag-and-drop. Drag the file for which you want to create an execute or open command from a display 
window, the desktop or from any other application. Drop the file onto a folder icon in the command bar of 
the control window or onto a menu entry in the 'Menus' dialog box to create a new execute command. 
Depending on the file type the following cases have to be distinguished:

1.) Executable Files

If you import an executable file (i.e. a file having the extension '.BAT', '.COM', '.EXE', '.LNK' or '.PIF'), a 
command that directly executes the file is created and the 'Icon and Name' dialog box appears in which 
you can choose the icon for the command and change the name, if desired. (Note: In case a shortcut is 
imported, the icon and the name of the shortcut are used automatically.)

2.) Document Files

If you import a file that cannot be executed on its own but is of a registered file type, a command is 
created for opening the file with the application that is registered for the corresponding file type. (Note: 
Under Windows®, the type of a file is determined by the extension of the filename. See also: Registered 
File Types.) The 'Icon and Name' dialog box appears showing the icon(s) of the registered application and
you can choose the icon for the command and change the name, if desired.

3.) Other Files

If the imported file cannot be executed on its own and is not of a registered file type, a notification appears
and you can choose whether you want to register the file type first or immediately create a command for 
opening the file. (Note: A file whose file type is not registered cannot be opened directly. If you create a 
command for opening a file whose type is not registered now, you have to register the file type later 
before executing the command. See also: Registered File Types.) The 'Icon and Name' dialog box 
appears and you can choose the icon for the command and change the name.



VIII.4. User-Defined Commands
d) Drag-and-Drop: Commands

In order to drag a command, folder or menu respectively, that contains commands, move the mouse 
pointer over the source item, press the right mouse button and keep the button pressed. Then move the 
mouse pointer over the target and release the mouse button to drop the command(s).

1.) Source Items

- The commands in the 'Command Templates' window.

- Command icons or folders in the command bar of the control window.

- Menu items or submenus in the command tree in the 'Menus' dialog box.

- Command icons or folders in the right section of the taskbar.

2.) Target Items

- Display windows (for commands only, not for folders or menus)... The command is executed and 
the file or directory on which the command was dropped is passed to the command as a parameter.

- Drive icons in the control window or in the taskbar (for commands only, not for folders or 
menus)... The command is executed and the corresponding drive letter is passed to the command as a 
parameter.

- The command tree in the 'Menus' dialog box... Commands are inserted into the current menu as a 
menu item. Folders are inserted as submenus. See also: User-Defined Menus. (Note: If you drop the item
on an expanded branch of the command tree (i.e. on an open folder icon), it is inserted at the end of the 
corresponding submenu. If you drop the item on a command or a branch that is folded up, it is inserted in 
front of this entry.)

- Command icons in the control window... The command or menu (or folder respectively) is inserted at 
the corresponding position of the command bar. (Note: If you drop the item onto the first icon, on the very 
left of the command bar, it is inserted at the end.)



IX. Keyboard Shortcuts

- Keyboard Shortcuts: Global Keyboard Shortcuts
- Keyboard Shortcuts: Switching Windows and Desktops
- Keyboard Shortcuts: Executing Commands
- Keyboard Shortcuts: Selecting Entries from a List
- Keyboard Shortcuts: Moving the Cursor
- Keyboard Shortcuts: Editing with the Text Editor
- Keyboard Shortcuts: Selecting a Part of a Text or Display Area
- Keyboard Shortcuts: Working on a selected Part of a Text
- Keyboard Shortcuts: Finding and Replacing Text, Finding Patterns
- Keyboard Shortcuts: Scrolling the Text-View of the File Viewer
- Keyboard Shortcuts: Text-View of the File Viewer
- Keyboard Shortcuts: Hex-View of the File Viewer



IX. Keyboard Shortcuts
- Keyboard Shortcuts: Global Keyboard Shortcuts

Note: If you want to use the 'Windows®' key instead of 'Control + Alt' for global keyboard shortcuts, check 
the corresponding check box on the 'Commands' page of the 'Settings' property sheet.

The following T.N.T. keyboard shortcuts are global under Windows® and can be used in any situation:

- Control + Alt + F3... Opens the T.N.T. main menu.

- Control + Alt + F9... Opens the T.N.T. command line.

- Control + Alt + F12... Opens/closes the first CD-ROM drive.

- Switching the current drive of the T.N.T. display windows...

- Control + Alt + F1... Opens the ancestors/drives menu of the first (the left) display window. (Note: If the 
window does not exist already, it can be opened from this menu.)

- Control + Alt + F2... Opens the ancestors/drives menu of the second (the right) display window. (Note: 
If the window does not exist already, it can be opened from this menu).

- Switching virtual desktops... If virtual desktops are enabled in the settings, you can use the following 
keyboard shortcuts to switch the current desktop.

- Control + Alt + F5... Activates desktop 1.
- Control + Alt + F6... Activates desktop 2.
- Control + Alt + F7... Activates desktop 3.
- Control + Alt + F8... Activates desktop 4.
- Control + Alt + Tab... Activates the next desktop.
- Control + Shift + Alt + Tab... Activates the previous desktop.

- Moving a window or an application to another desktop... If virtual desktops are enabled in the 
settings, you can use the following keyboard shortcuts to move the current window of T.N.T. or another 
application that is currently active under Windows® to another desktop.

- Shift + Control + Alt + F5... Moves the window/the application to desktop 1.
- Shift + Control + Alt + F6... Moves the window/the application to desktop 2.
- Shift + Control + Alt + F7... Moves the window/the application to desktop 3.
- Shift + Control + Alt + F8... Moves the window/the application to desktop 4.



IX. Keyboard Shortcuts
- Keyboard Shortcuts: Switching Windows and Desktops

- Switching between windows of T.N.T....

- Control + Tab... Activates the next window of T.N.T.

- Control + Shift + Tab... Activates the previous window of T.N.T.

- Switching the current display window (except tree/folder displays, see below)...

- Tab... Activates the next display window.

- Shift + Tab... Activates the previous display window.

Note: If the active window is a tree/folder display, you can use 'Tab' and 'Shift +Tab' to switch from the tree
pane of the window to the folder pane and vice versa.

- Going through the pages of a property sheet...

- Alt + Cursor right... Goes through the pages clockwise.

- Alt + Cursor left... Goes through the pages anti-clockwise.

- Changing the current drive of the (first two) display windows from any T.N.T. window...

- Alt + F1... Opens the ancestors/drives menu of the first (the left) display window. (Note: If the window 
does not exist already, it can be opened from this menu.)

- Alt + F2... Opens the ancestors/drives menu of the second (the right) display window. (Note: If the 
window does not exist already, it can be opened from this menu.)

- Changing the current drive of the (first two) display windows from any application...

- Control + Alt + F1... Opens the ancestors/drives menu of the first (the left) display window. (Note: If the 
window does not exist already, it can be opened from this menu.)

- Control + Alt + F2... Opens the ancestors/drives menu of the second (the right) display window. (Note: 
If the window does not exist already, it can be opened from this menu.)

- Switching virtual desktops... If virtual desktops are enabled in the settings, you can use the following 
keyboard shortcuts to switch the current desktop.

- Control + Alt + F5... Activates desktop 1.
- Control + Alt + F6... Activates desktop 2.
- Control + Alt + F7... Activates desktop 3.
- Control + Alt + F8... Activates desktop 4.
- Control + Alt + Tab... Activates the next desktop.



- Control + Shift + Alt + Tab... Activates the previous desktop.

- Moving a window or an application to another desktop... If virtual desktops are enabled in the 
settings, you can use the following keyboard shortcuts to move the current window of T.N.T. or another 
application that is currently active under Windows® to another desktop.

- Shift + Control + Alt + F5... Moves the window/the application to desktop 1.
- Shift + Control + Alt + F6... Moves the window/the application to desktop 2.
- Shift + Control + Alt + F7... Moves the window/the application to desktop 3.
- Shift + Control + Alt + F8... Moves the window/the application to desktop 4.

- Control + Alt + F4... Quits 'The Next Tool'.



IX. Keyboard Shortcuts
- Keyboard Shortcuts: Executing Commands

Note: The following keyboard shortcuts are available in the display windows of T.N.T.. If certain 
circumstances are necessary to execute the command, the corresponding conditions are mentioned.

- Keyboard shortcuts to navigate through the directory hierarchy

- Alt + '.'...
- Backspace... Jumps to the parent directory.

- '\' (Backslash)...
- 'Alt + Backspace'... Jumps to the root directory of the drive.

- Alt + F10...
- Control + G... Opens the dialog box for locating files and directories.

- Alt + F11... Shows the contents of the directory or the archive over which the cursor is located in the 
current window.

- Control + '-' (Minus)... Opens the second display window as a copy of the current window.

- Control + Enter/Return... Opens a new display window, the type of which can be chosen from a 
context menu, with the contents of the directory or the archive over which the cursor is located.

- Control + R... Updates the current directory.

- F12... Opens/closes the first CD-ROM drive.

- Keyboard shortcuts for modifying general settings and configurations...

 - F2... Opens the 'Menus' dialog box in which you can modify the user-defined menus.

- F9... Opens the 'Settings' property sheet for modifying the settings of 'The Next Tool'.

- Keyboard Shortcuts for Modifying the Configuration of the View

- '/' (Slash)... Opens the Collection of Patterns dialog box to limit the number of files that are displayed 
using a filename pattern. (Not available for tree displays.)

- Alt + '/' (Slash) (on the numeric key pad)... Open the File Pattern dialog box to limit the number of files
that are displayed using a 'file pattern'. (Not available for tree displays.)

- Control + F3... The entries are sorted primarily according to their name. If the name is already the 
primary criterion for sorting, the direction in which the entries are sorted is inverted.

- Control + F4... The entries are sorted primarily according to their filename extension. If the extension is 
already the primary criterion for sorting, the direction in which the entries are sorted is inverted.

- Control + F5... The entries are sorted primarily according to their date of last modification. If the date of 
last modification is already the primary criterion for sorting, the direction in which the entries are sorted is 



inverted.

- Control + F6... The files are sorted primarily according to their size. If the size is already the primary 
criterion for sorting, the direction in which the entries are sorted is inverted.

- Control + F7... The entries are sorted primarily according to their attributes. If the attributes are already 
the primary criterion for sorting, the direction in which the entries are sorted is inverted.

- Control + F8... The entries are sorted primarily according to their directory path. If the path is already 
the primary criterion for sorting, the direction in which the entries are sorted is inverted. (Available only for 
multi-folder displays and search-result displays.)

- Keyboard Shortcuts for Executing File Commands...

You can start file commands in the tree pane of a display window as well as in the folder pane by using 
the keyboard. Depending on the type of the window, the following situations can be distinguished:

1.) Folder displays, multi-folder displays and search-result displays: By default, the cursor of the folder 
pane is not visible by default. By pressing any key, the cursor is switched on. If there are no selected 
entries and a command is started via the keyboard, the entry over which the cursor is located, is passed 
to the command. If there are selected entries, the current directory of the window is passed to the 
command and the number of files that are worked on is limited to the selected entries. (Note: For some 
commands, e.g. in the case of the file viewer or the text editor, passing the parameters is done according 
to certain rules. For a detailed explanation refer to the corresponding commands below.)

2.) Tree/folder displays: The part of the window, the tree pane or the folder pane that was recently 
activated with the mouse is the active element of the window in the first place if you press a key. By using 
the 'Tab' key, you can switch from one pane to the other. The cursor of the tree pane is always visible 
anyway and identifies the current directory of the tree. If the tree pane is the active element of the window
and a command is started via the keyboard, the current directory is passed to the command. If the folder 
pane is the active element of the window, the remarks for folder displays that are mentioned above are 
valid.

3.) Tree displays: The cursor of the tree identifies the current directory. If a command is started via the 
keyboard then the current directory is passed to the command.

- F8...
- Delete...
- Control + L...
- Control + X... Opens a dialog box to set the options and parameters for deleting files and directories.

- Alt + F3...
- Control + V...
- Control + Z... If the cursor is on a file and there are no selected entries, a file viewer showing the 
contents of the file is opened. Otherwise, a multi-file viewer is opened for the selected entries or the 
directory over which the cursor is located.

- F3... Opens a file viewer with the file over which the cursor is located, even if there are selected entries. 
Otherwise the same as Alt + F3.

- F4... Open a text editor with the file on which the cursor is. Otherwise, a file can be loaded from the 
current directory.

- Shift + F4... Opens a text editor with an empty text.



- Control + E... If the cursor is currently on a file, a text editor is opened with the file. Otherwise, the 
command is ignored.

- F5...
- Control + C...
- Control + K... Opens a dialog box to set the options and parameters for copying and moving files and 
directories.

Note: If you use the keyboard to start a copy command, the current directory of the second display 
window is pre-selected as the target directory. If more than two 'display windows' are open, the next 
window in the window queue is used. The same is valid for the following commands: moving, 
compressing and extracting.

- F6...
- Control + M... Opens a dialog box to set the options and parameters for copying and moving files and 
directories. The 'Move' button is pre-selected.

- F11... Opens a dialog box to set the options and parameters for copying and moving files and 
directories. The source, the target and the options of the copy task are pre-selected for compressing or 
extracting an archive. (Extracting is assumed if the cursor is on a file with one of the following extensions: 
'.ZIP', '.RAR', '.ARJ', '.LHA', '.LZH', '.LZS', '.VCP' or '.TNT'. Otherwise, compressing is assumed.)

- F7...
- Control + N... Opens a dialog box for creating a directory path.

- Alt + F9... Opens the T.N.T. command line.

- Alt + F12... Opens a dialog box for creating a self-extracting archive.

- Control + F9...
- Control + P... Opens a dialog box to set the options and parameters for printing files and texts.

- Control + A...
- Control + T... Opens a dialog box to set the options and parameters for modifying the attributes of files 
and directories.

- Alt + F7...
- Control + F...
- Control + S... Opens a dialog box to set the options and parameters for a file find and find in files 
command.

- Alt + F5... Opens a dialog box to set the options and parameters for comparing files and directories.

- Control + D... Opens a dialog box to set the options and parameters for modifying the date and the time
of files.

- Control + U... Opens a dialog box to set the options and parameters for renaming files and directories.

- 'Alt + Enter/Return'... Opens the 'Properties' dialog box.




